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Overview

Introduction

CallPilot Part 5: 702t Server Maintenance and Diagnostics provides 
information and instructions for maintaining a CallPilot server, as well as 
troubleshooting tips for potential problems.

Who should read this guide

This guide is for planners, administrators, technicians, and engineers respon
for maintaining a CallPilot server. 

It includes information for installing, repairing, replacing, and upgrading 
hardware and software components. The guide assumes that the reader:

� has basic computing skills

� is familiar with necessary safety procedures

� has the hardware documentation provided by the manufacturer availab
a reference

� is maintaining or troubleshooting an existing CallPilot server.

Glossary and Related Guides

Part 1 of this binder contains a glossary and a list of related guides.
14 CallPilot
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Skills you need

Introduction

This section describes the skills and knowledge you need to use this guide
effectively.

PC experience or knowledge

Knowledge of, or experience with, the following PC products will be of 
assistance when administering the CallPilot server:

� Microsoft Windows 95 or Windows NT

� client/server architecture

� Internet Protocol (IP)

Other experience or knowledge

Other types of experience or knowledge that can be of use include:

� database management

� programming
Part 5: 702t Server Maintenance and Diagnostics 15
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Structure of this guide

Introduction

CallPilot Part 5: 702t Server Maintenance and Diagnostics defines the 
hardware and software diagnostic and recovery activities that a support 
technician should perform. 

The first five chapters of this guide describe the tools that are available for 
identifying, diagnosing, and fixing hardware problems. If a problem is 
discovered, Chapter 6 provides procedures for removing the malfunctioning
hardware component and upgrading or installing a new component. 

If the problem is software-related, Chapters 7 and 8 describe the procedure
installing the server software in a recovery situation. 

Regular server maintenance procedures are described in Chapters 9 and 1

If required, the procedures for uninstalling and reinstalling the server softwa
are described in Chapters 11 and 12. 

The last chapter provides procedures for recovering from a hard drive failur
16 CallPilot



May  2000 About this guide 
Symbols and conventions

Introduction

This section describes the symbols and conventions used in this guide.

Symbols

You might encounter the following symbols in this manual.

. 

DANGER

Risk of electric shock
Warns you of an immediate electrical hazard that, if not 
avoided, will result in shock, serious injury, or death.

. 

WARNING

Risk of personal injury
Warns you of a situation in which you can be injured if 
instructions are not followed exactly as stated.
Part 5: 702t Server Maintenance and Diagnostics 17
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Note: Describes the secondary results of procedures or commands, or spec
conditions under which a procedure or command must be used.

. 

CAUTION

Risk of equipment damage
Alerts you to situations where data can be lost or damage
equipment can be damaged, actions can result in service
interruption, and productive time can be lost.

ATTENTION Provides information essential to the completion of a 
task.
18 CallPilot



May  2000 About this guide 

ver 
es, 

 

Preparing for maintenance activities

Introduction

Perform maintenance activities to ensure the proper functioning of your ser
or to fix any problems that occur. Before you begin any maintenance activiti
collect the tools you need and follow recommended safety precautions.

This section discusses the tools and equipment required for performing 
maintenance procedures in the field. Recommended safety precautions for
electrostatic discharge, handling cards, and handling your server are also 
included.
Part 5: 702t Server Maintenance and Diagnostics 19
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Required tools and safety precautions

Introduction

If you need to replace or upgrade any system parts, follow Nortel Networks t
and safety guidelines to prevent personal injury and damage to the server o
replacement parts.

Maintenance tools and materials checklist

Use this checklist for the tools and materials you need to perform maintena
and diagnostics tasks.  

. 

WARNING

Risk of personal injury and equipment damage
Field maintenance must always be performed by fully 
qualified, trained personnel.

Check Description

Phillips cross-head screwdriver 

Standard slot-head screwdriver (1/4" and 1/2")

Sidecutters

Jumper removal tool or needle nose pliers

Tape measure for determining cable lengths

Tweezers

Antistatic ESD wrist strap (recommended)

Pen or pencil for writing notes, cable lengths, and cable 
identifications

Flashlight for examining interior of chassis

Cable tie wraps
20 CallPilot
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Approved replacement parts

Before replacing any parts on your server, contact your Nortel Networks 
customer support representative for a list of approved add-in boards and 
peripheral devices. The use of non-approved replacement parts can cause s
system problems or void your Nortel Networks warranty.

Pen or pencil for noting cable lengths and labeling cables

Head-cleaning tape kit

Cable identification labels

Equipment log. This is used to record the model and serial
number of the system, all installed options, and other 
information.

Windows NT emergency disk. This contains the configuratio
data for Windows NT.

Windows NT 4.0 Setup disks. The three disks are used for 
reinstalling the operating system.

Microsoft DOS 6.20 disks. These three disks are used for 
reinstalling the operating system for maintenance and 
diagnostics.

A package of blank disks.

Intel Ethernet LAN Adapter Driver disk

Keycode data. This governs what software features you wi
be installing.

pcANYWHERE32 software. This will be used to allow 
remote access by Nortel Networks service. It is on the MAS
2.0 Operating System CD-ROM.

RAID driver disk and configuration disk (optional)

Check Description
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General safety

Nortel Networks recommends that you observe these safety guidelines as y
work on your server:

� Plug the computer and peripheral devices into properly grounded powe
sources to prevent electric shock.

� Use a surge protector or uninterruptible power supply to protect your 
system from sudden increases and decreases in electrical power.

� Ensure that nothing rests on your server’s cables and that cables cann
tripped over or stepped on.

� Do not handle food or liquid around the server.

� Do not push any objects into the openings of your server.

Safety precautions for working with your server

Observe these safety guidelines before removing the top cover of your serv

1. Turn off all peripheral devices connected to the server.

2. Turn off the system by using the push-button on/off power switch. Unpl
the AC power cord from the system or wall outlet.

3. Label and disconnect all peripheral cables and all telecommunication l
connected to the I/O connectors or ports on the back of the system.

4. Provide electrostatic discharge (ESD) protection by wearing an antista
wrist strap attached to the chassis ground of the system when handling
components. Attach your wrist strap to any unpainted metal surface.

Cooling and airflow

For proper cooling and airflow, always install the chassis top cover before 
turning on the system. You risk damaging system parts if you operate the sy
without the cover in place.
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Avoiding electrostatic discharge

Introduction

Electrostatic discharge (ESD) can seriously damage component parts such
disk drives, boards, and other parts. Nortel Networks recommends that you
perform the maintenance procedures described in this section at an ESD 
workstation.

Antistatic wrist strap

If an ESD workstation is not available, provide some ESD protection by wea
an antistatic wrist strap. Ground the ESD wrist strap by attaching it to any 
unpainted surface on your system chassis.

While you work

As you work inside the server, periodically touch an unpainted surface to 
discharge any static your body might have accumulated.

Conductive foam padded in-boards

Expansion cards are extremely sensitive to ESD. After removing a card from
protective wrapper or from the system, place it component-side up on a 
conductive foam pad. If possible, use antistatic floor pads and workbench p
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Handling cards

Introduction

Electronic components are sensitive to the environment and to electrostatic
discharge. To protect equipment and prolong the useful life of components,
Nortel Networks recommends that you follow the precautions described bel

Avoiding electrostatic discharge

Electrostatic discharge (ESD) affects the performance and decreases the u
life of system components. Use caution when handling Error Code Correcti
(ECC) memory modules, SBC cards, and add-in boards to prevent damage
Wear an ESD wrist strap when handling system parts.

Precautions for handling cards

Take these precautions with any procedure that includes an add-in board:

� After removing a board from its protective wrapper or from the server, 
place it component-side up on a grounded, static-free surface.

� Do not slide a board over any surface.

� Do not touch board components or gold-edge connectors on the board

� Hold a board by the top edge, or by the side edges.

Installing boards

When installing boards on the server, remember the following details:

� The backplane is flexible and supported with stand-offs.

� Board slots resist connector insertion.

� Firm, steady force seats a board in its slot properly.

� Boards seat with friction followed by a solid stop.

� External connector plates, attached to add-in boards, are seated in the
panel and secured with a screw.
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Handling hard disks

Introduction

Hard disks are extremely sensitive to vibration and physical shock. To prote
equipment and prolong the life of hard drives, Nortel Networks recommends
following precautions.

Avoid vibration or physical shock

Hard disks are susceptible to even slight vibrations. A hard disk can be dam
if it is placed on a table that is accidently knocked or moved. Use caution w
handling hard disks to prevent damage.

Precautions for handling hard disks

After removing a hard disk from its protective wrapper, or from the server, pl
it on an antistatic, padded workbench or workstation to avoid movement or 
jarring.

Shipping damage

If your hard disk is shipped independently for either an upgrade or a 
replacement, note any dents or damage on the padded container and pack
Keep the container to prove that the part was damaged during shipping and
handling.

Remove hard drives

The drives are hot-swappable and can be removed without a system shutdo

Store hard drives

If you purchase extra hard disks, store these hard disks in the original padd
container. Store the disks away from places where they might be moved or
jarred.
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Handling CD-ROM disks

Introduction

When removing a CD-ROM disk from its protective case or loading a disk to
drive, hold it by its center hole and outer edge. Avoid touching the disk’s da
surface (the non-labeled side).

To protect a disk against scratches and dirt when not in use, keep it in its 
protective case.

To load a CD-ROM disk

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Place the disk on the tray with its labeled side facing up.

3 Press the eject button or gently press the front of the disk tray to retract the 
tray back into the drive.

To eject a CD-ROM disk

1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Remove the disk from the tray and put it in its protective case.

3 Press the eject button or gently press the front of the disk tray to retract the 
tray back into the drive.
26 CallPilot



C h a p t e r  2  

Starting up and shutting down the 
server

In this chapter 
 Overview 28

 Starting up the server 29

 Shutting down the server 30
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Overview

Introduction

This chapter provides procedures for

� turning on the peripheral devices and the server, and verifying proper 
startup. See “Starting up the server” on page 29.

� shutting down the server if you need to install, reinstall, or replace hardw
components. See “Shutting down the server” on page 30.
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Starting up the server

To turn on the system

1 Ensure the modem power switch is on.

2 Turn the monitor power switch on.

3 Press the server power switch on.

4 Observe the Power-On Self-Test (POST) and initialization messages as the 
server starts.

 Startup sequence

The following is the sequence for the server startup:

To interpret the POST beep codes that your CallPilot emits, refer to “POST b
codes” on page 36.

Stage Description

1 POST messages appear.

2 SCSI (or RAID) initialization messages appear. 

3 Allow selection of Windows NT/WINDOWS NT (VGA Mode).

5 Server boots to Windows NT and displays the logon screen.

6 Press Ctrl + Alt + Delete.

7 Log on as the administrator with the appropriate password
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Shutting down the server

Introduction

When you need to power down the server, follow the procedure in this secti

To shutdown the server

1 Press the Ctrl, Alt, and Delete keys simultaneously.

Result: The Windows NT Security dialog box appears.

2 Select Shutdown.

Result: The Shutdown Computer dialog box appears.

3 Select Shutdown.

4 Click OK.

Result: The Shutdown Computer window displays the message, It is 
now safe to turn off your computer .

a. You might be informed that an SQLAnywhere service is running with 
connections, and asked if you want to end it.

b. Click Yes or End Task. 

Result: You might also be asked if you want to save ACD proxy 
changes.

c. Click No.
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Diagnostics

In this chapter
 Overview 32

Section A: Performing startup diagnostics 33

 Overview 34

 Power-On Self-Test (POST) diagnostics 35

 Interpreting POST diagnostics 36

 Interpreting startup diagnostics from SCSI BIOS 38

Section B: Performing Windows NT online diagnostics 39

 Overview 40

 Checking hardware using Windows NT 4.0 diagnostics 41

 Invoking the chkdsk utility 45

 Invoking and interpreting TCP/IP diagnostics 47

 Invoking and interpreting Token Ring card diagnostics 59

Section C: Invoking and interpreting serial port diagnostics 61
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 Shutting down services 63

 Conducting TSTSERIO tests 65

 Conducting TSTSERIO tests with the loopback plug 69

 Restarting services 70
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Overview

Introduction

This chapter includes the following information:

� Section A: “Performing startup diagnostics” on page 33 for help in 
interpreting the startup diagnostics on the 1001rp server

� Section B: “Performing Windows NT online diagnostics” on page 39 to 
help you use the run-time diagnostics provided by the Windows NT ser
software

� Section C: “Invoking and interpreting serial port diagnostics” on page 6
for running serial port diagnostics using the TSTERIO command
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Section A: Performing startup 
diagnostics

In this section
 Overview 34

 Power-On Self-Test (POST) diagnostics 35

 Interpreting POST diagnostics 36

 Interpreting startup diagnostics from SCSI BIOS 38
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Overview

Introduction

This section contains procedures for interpreting the startup diagnostics on
1001rp server. These diagnostics are available automatically when you res
the server. They are also available when you boot to DOS or when you first
install a system.

Startup diagnostic classes

Three classes of startup diagnostics are available on the 1001rp server:

� Power-On Self-Test (POST) diagnostics

� SCSI controller diagnostics
or

� RAID controller diagnostics

These diagnostics are available at initial system startup, or after any 1001rp
server reset.
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Power-On Self-Test (POST) diagnostics

Definition

The Power On Self Test (POST) is a system diagnostic program (stored in 
BIOS) that runs every time the 1001rp server is started. POST’s function is 
test system components, then display status messages.

POST message formats

POST reports on the system status using POST beep codes.
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Interpreting POST diagnostics

Introduction

This section explains POST diagnostic codes.

POST beep codes

If an error occurs before video initialization, POST emits beep codes that 
indicate errors in hardware, software, or firmware. 

A beep code is a series of separate tones, each equal in length. Write down
beep codes before calling your Nortel Networks customer support 
representative. 

ATTENTION
Some POST beep codes are critical and require that y
replace your motherboard. See the following table for 
more information about beep codes.

Number of 
beeps Error message and conditions

1 Refresh failure

2 Parity cannot be reset

3 First 4 kbytes memory failure

4 Timer not operational

5 Processor failure

6 Keyboard controller gate A20 is off (v_mode)

7 Exception interrupt error

8 Display memory read/write error
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9 ROM checksum error

10 Shutdown register read/write error

Number of 
beeps Error message and conditions
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Interpreting startup diagnostics from SCSI 
BIOS

Introduction

The results from the SCSI controller diagnostics appear after the POST res

Applicable cards

Results of the startup diagnostics appear only if you have the following ada
card installed on your system:

� Symbios Logic SCSI controller

This controller is integrated into the system and, therefore, is always 
present.
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Section B: Performing Windows NT 
online diagnostics

In this section
 Overview 40

 Checking hardware using Windows NT 4.0 diagnostics 41

 Invoking the chkdsk utility 45

 Invoking and interpreting TCP/IP diagnostics 47

 Invoking and interpreting Token Ring card diagnostics 59
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Overview

Introduction

This section outlines how to access the run-time online diagnostics provide
the Windows NT server software.
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Checking hardware using Windows NT 4.0 
diagnostics

Introduction

The Windows NT 4.0 system provides tools that can be used to diagnose a
debug system problems, including

� Windows NT Diagnostics screen

� Event Viewer

Windows NT Diagnostics window

The Windows NT 4.0 Diagnostics window allows you to view details 
concerning the system and network components. 

You can open the following tabs on the Diagnostics window to display spec
information: 

� Version 
� System
� Display
� Drives
� Memory
� Services
� Resources
� Environment
� Network
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 Windows NT Diagnostics main window

To access Windows NT 4.0 diagnostic tools

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Windows NT 
Diagnostics to access the Windows NT Diagnostics window.

3 Select the appropriate tab on the Diagnostics main window to view 
information concerning the system and network. Details available on each 
tab are supplied in the following table:
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Select To display details about

Version Version
Registration

System System identifier
HAL
BIOS information
Processors

Display BIOS information
Adapter
Driver

Drives Drives by type or letter

To view specific details, select a drive, and then press 
Properties to view details for the drive, including size, 
labels, and so on.

Memory Memory, including totals, physical and kernel 
memory, commit charge, kernel

Services Service and state for both services and devices

To view specific details, select a service, and then 
press Properties to view details, including pathname, 
dependencies, service flags, and so on.

Resources Select one of the following buttons to display 
information about the resources available on the 
system:

IRQ

I/O Port

DMA

Memory 

Devices

To view specific details, select a resource, and then 
press Properties.
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Event Viewer

Windows NT 4.0 provides an Event Viewer that is used to view event logs to
assist in diagnosing and debugging system problems.

Three types of event logs are available from the Event Viewer, as follows:

To access the Event Viewer

1 Log on to Windows.

2 Select Start > Programs > Administrative Tools (Common) > Event Viewer.

3 Select the appropriate tab to view the associated event logs.

Environment Variable and value for both system and local user

Network Select one of the following buttons to display 
information about the network and components:

General 

Transports 

Settings 

Statistics 

System Logs events by Windows NT 4.0 components, 
including RAS or other WinNT services.

Security Logs security events, such as logons, logoffs, 
illegal access, and so on. This option is available
only to users with Administrative access.

Applications Logs events by application, such as database fil
errors, and so on.

Select To display details about
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Invoking the chkdsk utility

Introduction

The chkdsk utility checks a specified disk on the server and displays a statu
report. Use this utility on drive C or D.

Note: A version of this utility, called autocheck, automatically runs at Window
NT boot-time. Output from this utility appears on the start-up blue screen.

Chkdsk utility syntax

The chkdsk utility uses the following syntax:

chkdsk [drive:][path]filename] [/F] [/V] [/R]

To run the chkdsk utility from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type chkdsk <drive letter:>  (for example, chkdsk 
c:).

Parameters Description

[drive:] The drive letter of the drive you want to check.

filename The names of files to check for fragmentation.

/F Add this switch to fix errors on the disk.

/V Add this switch to display the full pathname of 
every file on the disk.

/R Add this switch to locate bad sectors and to 
recover readable information.
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3 Press Enter.

Result: The system runs the chkdsk utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting TCP/IP diagnostics

Introduction

This section outlines the following TCP/IP diagnostic tools available for the 
Ethernet card. The first three tools are the most useful:

� ipconfig

� ping

� tracert

� arp

� nbtstat

� netstat

The ipconfig command

The ipconfig command displays IP configuration information. 

Ipconfig default
Running the command without flags displays the IP address, subnet mask,
default gateway for each adapter bound to TCP/IP.

Ipconfig command syntax
ipconfig /[]

The following flags are available for the ipconfig command:

Flag Description

/? Displays Help information.

/all Displays full configuration information.

/release Releases the IP address for the specified 
adapter.
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To run the ipconfig command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ipconfig <with appropriate parameters:>  
(for example, ipconfig /all).

3 Press Enter.

Result: The system runs the ipconfig utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

/renew Renews the IP address for the specified 
adapter.

Flag Description
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The ping command

The ping command sends an echo request to a specified host.

Ping command syntax
The ping command uses the following syntax:

ping [-t] [-a] [-n count] [-l size] [-f] [-i TTL] [-v TOS]

        [-r count] [-s count] [[-j host-list] | [-k host-list]]

        [-w timeout] destination-list

Parameters Description

-t Pings the specified host until interrupted.

-a Resolves addresses to host names.

-n count Specifies the number of echo requests to send.

-l size Sends buffer size.

-f Set Don’t Fragment flag in packet.

-i TTL Time To Live.

-v TOS Type Of Service.

-r count Record route for count hops.

-s count Time stamp for count hops.

-j host-list Loose source route along host list.

-k host-list Strict source route along host list.

-w timeout Timeout in milliseconds to wait for each reply.
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To run the ping command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type ping <destination IP address:>  (for 
example, ping 47.286.32.0:).

3 Press Enter.

Result: The system indicates a successful ping.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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The tracert command

This utility determines the route taken to a destination.

How tracert works
The tracert utility follows several steps to complete its task:

� Tracert sends Internet Control Message Protocol (ICMP) echo packets 
varying Time-To-Live (TTL) values to the destination.

� Each router along the path must decrement the TTL on a packet by at 
1 before forwarding it, so the TTL is effectively a hop count. 

� When the TTL on a packet reaches 0, the router sends back an ICMP 
Exceeded message to the source system.

� Tracert determines the route by sending the first echo packet with a TT
1 and incrementing the TTL by 1 on each subsequent transmission unt
target responds, or the maximum TTL is reached. 

� Tracert then examines the ICMP Time Exceeded messages sent back 
intermediate routers.

Tracert syntax
tracert [-d] [-h maximum_hops] [-j host_list] [-w timeout] [target_name]

Tracert parameters
The tracert command uses the following parameters:

Parameter Description

-d Specifies not to resolve addresses to 
hostnames.

-h maximum_hops Specifies the maximum number of hops to 
search for target.

-j host-list Specifies a loose source route along the 
host list.

-w timeout Waits the number of milliseconds 
specified by the timeout for each reply.
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To run the tracert command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type

tracert [-d] [-h maximum_hops] [j host_list] [-w timeout] [target name]  

(for example, tracert 47.286.0.32 210 47.236.0.04)

3 Press Enter.

Result: The system runs the tracert utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

target_name The name of the target host.

Parameter Description
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The arp command

The arp command displays and modifies the IP-to-physical address transla
tables used by Address Resolution Protocol (arp).

Arp command syntax
The arp command uses the following syntax:

arp -s inet_addr eth_addr [if_addr]

arp -d inet_addr [if_addr]

arp -a [inet_addr] [-N if_addr] 

Parameter Description

-a Displays current arp entries by interrogating 
the current protocol data. If inet_addr is 
specified, the IP and physical addresses for 
only the specified computer appear. If more 
than one network interface uses arp, entries for 
each arp table appear.

-g Same as -a.

inet_addr Specifies an Internet address.

if_addr Specifies the Internet address of the interface 
whose address translation table should be 
modified. If not present, the first applicable 
interface is used.

eth_addr Specifies a physical address.

-N if_addr Displays the arp entries for the network 
interface specified by if_addr.

-d Deletes the host specified by inet_addr.
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To run the arp command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type arp with the required parameters (for 
example, arp -g 47.286.0.32).

3 Press Enter.

Result: The system runs the arp command.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Adds the host and associates the Internet 
address inet_addr with the Physical address 
eth_addr. The physical address is given as six 
hexadecimal bytes separated by hyphens. The 
entry is permanent.
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The nbtstat command

The nbtstat command displays protocol statistics and current TCP/IP 
connections using NBT. This command is available only if the TCP/IP proto
is installed.

Nbtstat command syntax
The nbtstat command uses the following syntax:

nbtstat [-a remotename] [-A IP address] [-c] [-n] [-R] [-S] [-s] [interval]

Parameter Description

-a remotename Lists the remote computer’s name table using 
its name.

-A IP address Lists the remote computer’s name table using 
its IP address.

-c Lists the contents of the NetBIOS name cache 
giving the IP address of each name.

-n Lists local NetBIOS names. Registered 
indicates that the name is registered by 
broadcast (Bnode) or WINS (other node 
types).

-R Reloads the LMHOSTS file after purging all 
names from the NetBIOS name cache.

-r Lists name resolution statistics for Windows 
networking name resolution. On a Windows 
NT computer configured to use WINS, this 
option returns the number of names resolved 
and registered through broadcast or through 
WINS.

-S Displays both client and server sessions, 
listing the remote hosts by IP address only.
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To run the nbtstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type nbtstat with the required parameters.

3 Press Enter.

Result: The system runs the nbtstat utility.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

-s Displays both client and server sessions, and 
attempts to convert the remote host IP address 
to a name using the HOSTS file.

interval Displays selected statistics, pausing interval 
seconds between each display. Press CTRL+C 
to stop displaying statistics. Without this 
parameter, nbtstat prints the current 
configuration information once.
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The netstat command

The netstat command displays current TCP/IP network connections and pro
statistics.

Netstat command syntax
The netstat command uses the following syntax:

netstat [-a] [-e] [-n] [-s] [-p proto] [-r] [interval]

To run the netstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type netstat with the required parameters.

3 Press Enter.

Result: The system runs the netstat utility.

Parameter Description

-a Displays all connections and listening ports.

-e Displays Ethernet statistics. This can be 
combined with the -s option.

-n Displays addresses and port numbers in 
numerical form.

-s Displays per-protocol statistics. 

-p proto Shows connections for the protocol specified 
by proto. Proto can be tcp or udp. If used with 
the -s option, proto can be tcp, udp, or ip.

-r Displays the contents of the routing table.

interval Redisplays selected statistics, pausing 
between each display. Press CTRL+C to stop 
redisplaying.
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4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting Token Ring card 
diagnostics

Introduction

If TCP/IP protocol is installed, you can diagnose faults on the Token Ring c
by using the ping command under Windows NT.

Using the ping command

Instructions for using the ping command are in the procedure “To run the ping 
command from Windows NT 4.0” on page 50.
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Section C: Invoking and interpreting 
serial port diagnostics

In this section
 Overview 62

 Shutting down services 63

 Conducting TSTSERIO tests 65

 Conducting TSTSERIO tests with the loopback plug 69

 Restarting services 70
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Overview

Introduction

Run serial port diagnostics on the 1001rp server using the TSTSERIO 
command. Direct the TSTSERIO command to serial ports on the server aft
services on these ports have been shut down manually.
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Shutting down services

Introduction

This section details how to shut down a service using a specific serial port. 
the procedures below before invoking the TSTSERIO local loopback tests.

Services to stop for COM 1 testing
� Remote Access Server

Services to stop for COM 2 testing
� CallPilot SLEE

� MAS EMCI

� MAS Notification Service

� Remote Access Server

Net Stop command

Use the Net Stop command to stop a specified service on a serial port.

. 

CAUTION

Risk of communications loss
By stopping the services on COM 1 or COM 2, you lose th
support access feature.

. 

CAUTION

Risk of stopping call processing
By stopping the services on COM 2, you stop call 
processing on CallPilot.
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NET STOP command syntax
The Net Stop command uses the following syntax:

net stop “[service-name]” 

To invoke the Net Stop command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type net stop “[service name]”. For example, type 
net stop “Remote Access Server.”

3 Press Enter.

Result: The system runs the net stop command utility.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.

ATTENTION
You must restart the services that you shut down throu
the Net Start command after running the diagnostic. F
details, see “Restarting services” on page 70.
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Conducting TSTSERIO tests

Introduction

The TSTSERIO command performs local loopback tests of the serial 
communications ports from the 1001rp server run-time environment.

Note: Before conducting these tests, shut down services using the NET ST
command detailed on page 63.

TSTSERIO command syntax

The syntax for the TSTSERIO command is as follows:

TSTSERIO [/?] /P:comport [/S:subtstname [/L:loops]

. 

CAUTION

Risk of communications loss
By stopping the services on COM 1 or COM 2, you lose th
support access feature.

. 

CAUTION

Risk of stopping call processing
By stopping the services on COM 2, you stop call 
processing on CallPilot.

Flag Requirement Description

[?] n/a Displays Help.

/P:comport Required Specifies the symbolic port 
name assigned to the port you 
want to test.
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TSTSERIO internal loopback diagnostic subtests

The following internal loopback subtests are available for the TSTSERIO 
command. For each of these tests, the communications resource must be 
available:

[/
S:subtstname]

Optional Specifies a TSTSERIO 
subtest. See the table below 
for a description of the 
available subtests.

[/L:loops] Optional Specifies the number of times 
(up to a maximum of 65 535) 
to execute the requested test. 
The default number of tests is 
1. A value of 0 infinitely 
loops until you enter 
CTRL+C.

Subtest 
name Description

idata Internal data bus loopback

imsr Internal modem status register

baud Internal data bus loopback at various baud 
rates

word Test 5-, 6-, 7-, and 8-bit data lengths

stop Test 1, 1.5, and 2 stop bits

pari Test odd/even parity

fifo Test that device can operate in fifo mode

Flag Requirement Description
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To invoke the TSTSERIO /P command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type tstserio with the required parameters. For 
example, type TSTSERIO /P com1  or TSTSERIO /P com 2 .

3 Press Enter.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
Part 5: 702t Server Maintenance and Diagnostics 67



Diagnostics  Standard 1.0

 used. 
n 
TSTSERIO external loopback plug subtests

The following external loopback subtests are available for the TSTSERIO 
command. For each of these tests, an external loopback connector must be
For more information, “Conducting TSTSERIO tests with the loopback plug” o
page 69.

To invoke the TSTSERIO /S command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type tstserio with the required parameters. For 
example, type TSTSERIO /P com1 /S extr . 

3 Press Enter.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.

Subtest 
name Description

edata External data bus loopback. This test requires 
an external loopback connector.

emsr External modem status register. This test 
requires an external loopback connector.

eint Test ability of device to generate interrupts. 
This test requires an external loopback 
connector.
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Conducting TSTSERIO tests with the loopback 
plug

Introduction

The TSTSERIO command requires an external loopback connector plug fo
edata, emsr, and eint subtests.

9-pin connector plug

The standard serial loopback connector is a female 9-pin D-sub connector.
connector has the following pins wired together:

� CTS (pin 8) wired to (pin 7) RTS

� SIN (pin 2) wired to (pin 3) SOUT

� DTR (pin 4) wired to (pin 6) DSR

Once the plug is installed on the serial port, TSTSERIO can be invoked 
according to the procedure outlined in the previous section.
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Restarting services

Introduction

This section details how to restart the services for COM 1 or COM 2 after 
invoking the TSTSERIO local loopback tests.

Services to restart after COM 1 testing
� Remote Access Server

Services to restart after COM 2 testing
� CallPilot SLEE

� MAS EMCI

� MAS Notification Service

� Remote Access Server

Net Start command

Use the NET START command to restart a specified service on a serial por

NET START command syntax
The NET START command uses this syntax; net start “[service-name]”

To invoke the Net Start command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS 
command prompt window. 

Result: The MS-DOS Command Prompt window appears.

2 At the MS-DOS prompt, type net start “[service name]”. For example, type 
net start “Remote Access Server”. 

3 Press Enter.

4 Type Exit  to exit MS-DOS and return to Windows NT 4.0.
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Using the Administrative PC to 
diagnose the server

In this chapter
 Overview 72

Section A: Detecting, isolating, and fixing hardware problems 73

 Overview 74

 Detecting hardware problems 75

 Viewing events and isolating problems 76

 Checking channel status 79

Section B: Working with the Maintenance window 83

 Overview 84

 Introducing the Maintenance window 85

 Obtaining general information about components 93

 Viewing component states 95

 Starting and stopping components 98

 Running integrated diagnostics 102

 Viewing last diagnostic results 105

 Obtaining replacement part numbers 108
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Overview

Introduction

This chapter provides information on how to detect, isolate, and fix hardwar
problems on the CallPilot server using the CallPilot Administration Client 
software on the administrative PC.

� The section “Detecting, isolating, and fixing hardware problems” on pag
73 provides details on how to detect, isolate, and fix hardware problem

� The section “Working with the Maintenance window” on page 83 describes 
how to use the Maintenance window as you detect, isolate, and fix 
hardware problems.

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system. References to the SCbus, Master Timeswitch, and MPB ar
applicable to the 200i server.
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Section A: Detecting, isolating, and 
fixing hardware problems

In this section
 Overview 74

 Detecting hardware problems 75

 Viewing events and isolating problems 76

 Checking channel status 79
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Overview

Introduction

This section provides guidelines on how to detect, isolate, and fix potential 
real hardware problems. 

� “Detecting hardware problems” on page 75 provides information on the 
different ways in which you typically become aware of hardware proble

� “Viewing events and isolating problems” on page 76 describes how to work 
with the Alarm Monitor, Event Browser and Maintenance screen. These
tools are used to isolate the cause of problems and plan a strategy to f
hardware problems.

� “Checking channel status” on page 79 describes how to view channel statu
in the Channel Monitor and Multimedia Monitor.

Component dependencies

The status of some components depend on the operational status of other 
components. If a component fails or is stopped, the dependent components
out of service. 

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components might not appear on your system. 

Component Dependent components 

SCbus all MPBs, MPCs, and all Multimedia and Call channe

Master Timeswitch all MPBs, MPCs, and all Multimedia and Call channe

Timeswitch all Multimedia and Call channels connected to the sa
MPB as the timeswitch

MPC all multimedia channels on the MPC-8 card

DS30x all Call channels associated with that DS30x link cabl
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Detecting hardware problems

Introduction

Typically, you first become aware of a hardware problem when an alarm is 
raised. All hardware faults produce an alarm (or series of alarms, dependin
the problem) in the Alarm Monitor. 

Note: By default, the Alarm Monitor appears on the screen as soon as an a
is raised. It does not appear if Alerting Off has been set in the CallPilot syst
window. For more information on setting or resetting the alerting feature, re
to the Monitoring and Security for the Administrator guide.

Other indications of a hardware problem

Other indications of a hardware problem include the following:

� user complaints

� call processing difficulties, such as busy signals, static, dropped calls, 
trouble connecting, and cross talk (hearing other conversations)

� system administrator log on difficulties

� alert icons on the Maintenance window
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Viewing events and isolating problems

Introduction

Use one of the following methods to isolate and plan a strategy to fix a hard
problem:

� Go to the Alarm Monitor to investigate one or more raised alarms.

� Use the Event Browser to investigate a series of events that occurred ar
the time an alarm was raised.

� Go to the Maintenance window to get status information for any suspec
components. For some components, you can use the Diagnostic tab o
Maintenance window to run a diagnostic test.

Note: For detailed information on how to use the Alarm Monitor and Event 
Browser (for example, how to set preferences), refer to the Monitoring and 
Security for the Administrator guide.

Using the Alarm Monitor

Each alarm in the Alarm Monitor has Help text that often provides a solution
the problem. If the solution is not apparent, use the Event Browser or the 
Maintenance screen to further investigate the problem.
76 CallPilot



May  2000 Using the Administrative PC to diagnose the server 

ver 

ject 
To investigate using the Alarm Monitor

1 If the Alarm Monitor is not already visible, then in the CallPilot system 
window, go to System Administration > Alarms and Events > Alarm Monitor.

2 Double-click the first critical or major alarm.

Result: The Help window appears. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more alarms.

5 If the solution to the problem is not apparent, obtain the return code of the 
first event and continue the investigation by using the Event Browser (go to 
“Using the Event Browser” on page 77).

Using the Event Browser

The Event Browser lets you view events that have been recorded in the ser
log. The event listing can help you better determine the root cause of the 
problem. Use the Event Browser to view the time the event occurred, the ob
that generated the event, and the cause of the event.
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To investigate using the Event Browser

1 In the CallPilot system window, go to System Administration > Alarms and 
Events > Event Browser.

2 Double-click an event that appears to be related to the problem, or an event 
that occurred near the time the alarm was raised. 

3 View the description and recovery action.

4 Repeat steps 2 and 3 for a few more events.

5 If the solution to the problem is not apparent, contact your distributor.

Using the Maintenance window

If you suspect or discover a problem with an MPC-8 card or the timeswitch,
the Diagnostic tab of the Maintenance window. You can view the results of t
last diagnostic test run against the component. This produces a list of 
components that might be causing the problem. A probability percentage is
listed with each component that reflects how probable it is that replacing the
component will fix the problem. 

For information on using the Maintenance window to view the results of the 
diagnostic test, see “Viewing last diagnostic results” on page 105.

For information on all aspects of the Maintenance window, see Section B: 
“Working with the Maintenance window,” on page 83.
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Checking channel status

Introduction

The Channel Monitor shows the status of call channels (the connection betw
the server and the switch that carries the call signal to CallPilot). 

The Multimedia Monitor shows the status of multimedia channels (the DSP
ports that process the call— these are the voice, fax, and speech recognitio
channels). 

The Channel Monitor and Multimedia Monitor also enable you to start, stop
courtesy stop channels. To run diagnostics on a channel, use the Maintena
window.

Note: For detailed information on how to use the Channel Monitor and 
Multimedia Monitor, refer to the online Help in the CallPilot system window, 
refer to the Monitoring and Security for the Administrator guide.
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To view call channel states

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Channel Monitor.

2 Double-click Channel Monitor.

Result: The Channel Monitor window appears, showing the state of all call 
channels on the system. For an explanation of the channel states, refer to 
the online Help. 
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To view multimedia channels

1 In the CallPilot system window, go to System Administration > Maintenance 
Administration > Multimedia Monitor.

2 Double-click Multimedia Monitor.

Result: The Multimedia Monitor window appears, showing the state of all 
multimedia channels. For an explanation of the channel states, refer to the 
online Help. 
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Section B: Working with the 
Maintenance window

In this section
 Overview 84

 Introducing the Maintenance window 85

 Obtaining general information about components 93

 Viewing component states 95

 Starting and stopping components 98

 Running integrated diagnostics 102

 Viewing last diagnostic results 105

 Obtaining replacement part numbers 108
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Overview

Introduction

Use the Maintenance window to do the following:

� Obtain general information about components.

� View component states.

� Start and stop components.

� Run integrated diagnostic tests.

� View the results of the last diagnostic test run against a component.
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Introducing the Maintenance window

Introduction

All physical and logical hardware components are listed in the Maintenance
window tree. This tree shows how components relate to each other. For exa
eight multimedia channels exist as subcomponents for each MPC-8 card.

When you select a component in the Maintenance window, at least one of t
following tabs appear:
. 

Note: The components in the Maintenance window vary based on the type 
switch connected to CallPilot and the server type. The dialog box examples
this chapter are for illustration purposes and might not appear exactly the s
on your system. References to the SCbus, Master Timeswitch, and MPB ar
applicable to the 200i server.

Tab Description

General This page shows general technical 
information about the selected 
component. 

Maintenance This page shows the state of the selected 
component. You can also take some 
components out of service from this page. 

Diagnostics This page enables you to run component-
specific diagnostics.

Replacement This page shows replacement part 
numbers for selected components. This 
option is not available for all platforms. 
Contact your distributor for latest part 
number information.
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The General tab

Use the General tab to view general information about components.

 

Box Description

Attribute Shows component-specific general technical information

Value Shows additional details, such as the speed of a selecte
device.
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The Maintenance tab

Use the Maintenance tab to view the state of the highlighted component an
start and stop a component before running a diagnostic test.
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Box Description

State Specifies the state of the highlighted component.

Administrative This is a Desktop Management Interface (DMI) summar
state. You do not need this state.

Availability This is a DMI summary state. You do not need this state

Operational This is a DMI summary state. You do not need this state

Usage This is a DMI summary state. You do not need this state

Stop Use this button to take the selected device out of servic
immediately. All calls in progress are disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.
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Courtesy stop Use this button to take the selected device out of servic
after all calls are finished. This prevents any calls from 
being disconnected.

Caution:
For CallPilot servers connected to a Lucent, Mitel, or 
Rolm switch, if you stop an individual call channel, the 
corresponding port on the switch side is not automatica
disabled. As a result, calls can continue to land on the 
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two 
options:

� Busy-out the port on the switch side. This must be do
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the 
system.

This caution does not apply to stopping DSP ports.

Start Use this button to put the selected device in service.

Power Up Use this button to power up an MPC-8 card that had be
powered down. You can only use this button for MPC-8 
cards on a 200i server.

Power Down Use this button to power off an MPC-8 card prior to 
replacing it. You can only use this button for MPC-8 card
on a 200i server. 

Box Description
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The Diagnostics tab

Use the Diagnostics tab to run a diagnostic test or to view the results of the
diagnostic test run on a component.

Box Description

List of Diagnostics for 
Selected Device

Shows the diagnostic tests that are available for the 
highlighted component.

Run Use this button to run the selected diagnostics. For the 
Timeswitch and MPC components, go to the Maintenan
tab to courtesy stop the component before you run 
diagnostics.

Stop Use this button to stop the selected diagnostics
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Last Result Use this button to view the results of the last diagnostic 
test.

The results include a list of Field Replaceable Units 
(FRU), which, if replaced, might fix the problem. Each 
FRU is shown with a percentage that shows how probab
it is that the component caused the hardware problem.

Description Shows a comment or description for a selected diagnos
test.

Instructions Shows the instructions for the user to run the diagnostic
test.

Box Description
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The Replacement tab

The Replacement tab shows component part number information. This tab i
available for all platforms. To be certain you have the latest component 
information, contact your distributor.

Box Description

Description Shows the name of the highlighted component.

Manufacturer Shows the manufacturer of the component.

Model Revision Shows the revision number for the component.

Part Numbe r Shows the part number for the component.

Technical Support URL Shows a web site address where you can get technical 
support.
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Obtaining general information about 
components

Introduction

Find general technical information for each hardware component listed in th
tree using the General tab of the Maintenance window.

For a description of the General tab, see “The General tab” on page 86.

Type of technical information

Technical information about hardware components typically includes details
such as the following:

� the name, class, type, series, or version of a component

� various capabilities of a component (for example, the speed of a CPU)

� the available disk space
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Getting there   CallPilot system > System Administration > Maintenance 
Administration > Maintenance

To view component details

1 From the left pane of the Maintenance window, select the hardware 
component about which you want to obtain information.

Result: The General page appears with general information shown.
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Viewing component states

Introduction

View a component’s state to determine the general condition of the compon
including whether the component is disabled or off duty. You can view the s
of components that are listed in the Maintenance tab of the Maintenance 
window.

For a description of the Maintenance tab, see “The Maintenance tab” on page 
87.

Component states

The state of a hardware component changes depending on the following fa

� whether the component is currently involved in processing a call

� whether a diagnostic test is being run on the component 

� whether the component is out of service 

You can determine the state of a component by looking at the State field in 
Maintenance tab. 

State Description

Active The component is working and currently involved in 
processing a call. 

Idle The component is working but not currently involved in 
processing a call.

Uninstalled The component is not installed or properly configured. Th
usually happens only when the system is being configure
or if the database is corrupted.

Shutting Down The component is in the process of stopping. 

This state occurs quickly and is immediately followed by O
Duty.
Part 5: 702t Server Maintenance and Diagnostics 95



Using the Administrative PC to diagnose the server  Standard 1.0

dard 
tors 
u do 

s 

e 

ot 

tch.

iled 

 

. 
Details 
These states (Administrative, Availability, Operational, and Usage) are stan
Desktop Management Interface (DMI) states. They are shown for administra
who understand and use the DMI standard in other aspects of their jobs. Yo
not need to use the DMI states; the summary state listed in the State field i
provided instead. 

Alert icons
If one of the following icons appears next to a component in the tree, the 
component or one of its subcomponents is experiencing a problem:

Loading The component has been started, which takes it out of th
Off Duty state. 

This state occurs quickly and is immediately followed by 
Idle.

No resources The hardware required for the component to operate is n
installed or not operating properly. 

Off duty The component has been stopped.

Remote Off Duty The component has been taken out of service at the swi

Icon Description

 This means that a diagnostic test run on the component has fa
and the component has been placed into disabled status. 

You must view the last results of the diagnostic test. See 
“Viewing last diagnostic results” on page 105.

This means that a problem exists with one of the component’s
subcomponents. 

Expand the tree to locate the subcomponent with the problem

State Description
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To view the state of a hardware component 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 View the state of the selected component in the State field.
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Starting and stopping components

Introduction

When you stop a component, it goes out of service and stops operating. Yo
must either stop or courtesy stop a component before you can run a diagno
test on it. 

When you start a channel, it goes back into service. You must start a chann
after replacing it, or after running a successful diagnostic test, to bring it ba
into service.

Courtesy stop 
A courtesy stop takes the component out of service only after the componen
finished processing the active call. If the component is currently processing
call, the call is not dropped. If the component is not currently in use, it is tak
out of service immediately. This method is preferred over a regular stop.

Stop
A stop takes the component out of service immediately, regardless of wheth
the component is currently processing calls. All active calls are dropped. 
Typically, you perform a stop only when severe problems occur that are affec
a large number of incoming calls, or if your organization determines a spec
need for it.

ATTENTION  Nortel Networks recommends that you courtesy stop a 
component if possible. 

In the Maintenance window, the courtesy stop option is 
available only at the individual channel level. 

To courtesy down CallPilot, use the Multimedia Monitor to 
courtesy stop all DSPs. 

To courtesy stop a range of multimedia channels or all 
multimedia channels on an MPC [DSP] card, use the 
Multimedia Monitor. See “Checking channel status” on page 
79 for an overview of the Channel Monitor and Multimedia 
Monitor.
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Components that can be started and stopped

This section lists components that can be started and stopped.

If you want to start or stop more than one or two multimedia or call channel
use the Channels windows. See “Checking channel status” on page 79 for an 
overview of the Channel Monitor and Multimedia Monitor. For detailed 
information, refer to the Monitoring and Security for the Administrator guide.

Note: Based on the type of switch connected to CallPilot and the server typ
some of these components do not appear or do not have the Stop option: 

. 

CAUTION

Risk of Ring No Answer on disabled (stopped) call channel on 
Lucent, Mitel, or Rolm systems
For CallPilot servers connected to a Lucent, Mitel, or Rolm 
switch, if you stop an individual call channel, the corresponding
port on the switch side is not automatically disabled. As a resul
calls can continue to land on the stopped channel resulting in a
Ring-No-Answer.

If you need to stop an individual channel, you have two options

� Busy-out the port on the switch side. This must be done 
manually by the switch administrator.

� Courtesy stop the entire hunt group that contains the call 
channel or courtesy stop all call channels in the system.

This caution does not apply to stopping DSP ports.

Component Effect of stopping

SCbus takes out of service all call processing 
resources

Timeswitch takes out of service the MPB16 card that is 
serviced by the timeswitch
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MPC-8 cards takes out of service the selected MPC-8 
card

Multimedia (DSP) 
channels

takes out of service the selected DSP 
channel

Switch Interface Link 
(found under the Switch 
Interface Card 
component)

takes out of service the selected link to the 
switch

Call channels takes out of service the selected call channel

DS30x link takes out of service the selected DS30x link

Component Effect of stopping
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Getting there  CallPilot system > System Administration > Maintenance Administration 
> Maintenance

To start or stop a component in the Maintenance window

1 From the left pane of the Maintenance window, select the hardware 
component you want to start or stop. 

Result: The General page appears.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears. 

3 Click Start, Courtesy Stop, or Stop. 
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Running integrated diagnostics

Introduction

You should run diagnostic tests from the Diagnostic tab in the Maintenance
window in the following circumstances: 

� After installing or reinstalling a component, make sure it is operating 
properly. (A component must be Off Duty [stopped] before you can run 
diagnostic test. See “Starting and stopping components” on page 98.)

� Run the tests if the CallPilot server experiences trouble processing 
incoming calls. Problems include static, dropped calls, and cross talk 
(hearing another conversation).

Note: For a description of the Diagnostic tab, see “The Diagnostics tab” on page
90.

List of components that have diagnostic tests available
� MPC (DSPs)

� Timeswitch (depending on the switch type, diagnostics might not be 
available)

To view available diagnostic tests

The available diagnostic tests for each component appear in the Diagnostic
of the Maintenance window. Click a component to see the diagnostic tests 
available for that component. 

If a diagnostic test fails or cannot be run

If a warning box appears, the diagnostic test cannot be run because a prere
condition has not been met. If a diagnostic test fails, the failure is indicated a
bottom of the Diagnostic tab. 
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In both cases, check the Alarm Monitor to determine the reason and the 
appropriate action to take. (See “Detecting, isolating, and fixing hardware 
problems” on page 73.)

To run a diagnostic test

Note: See “Starting and stopping components” on page 98 for details about 
courtesy stopping a component. Nortel Networks recommends that you cou
stop rather than stop a component if possible.

1 From the left pane of the Maintenance window, select the hardware 
component for which you want to run a diagnostic test.

2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

3 Stop the component.

4 From the right pane, click the Diagnostic tab.

Result: The Diagnostic page appears. 
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5 Select the diagnostic test you want to run.

6 Click Run.

7 View the diagnostic test results at the bottom of the Diagnostic page. 
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Viewing last diagnostic results

Introduction

If the Alarm Monitor and Event Browser do not provide a solution to a hardw
problem, a component might need to be replaced or serviced. If the problem
rests with a component that is not replaceable because it is not a physical e
(such as the timeswitch), you must replace its parent component or contact
technical support, depending on the component.

Replaceable parts are called Field Replaceable Units (FRUs). View the last
diagnostic test result in the Diagnostic tab of the Maintenance window to ob
a list of FRUs that, when replaced, will likely fix the problem.

Notes: 

1. For general information on investigating hardware problems, see 
“Detecting, isolating, and fixing hardware problems” on page 73.

2. For a description of the Diagnostic tab, see “The Diagnostics tab” on page 
90.

Field replaceable units

When you view the last results of a failed diagnostic test, a Diagnostic Resu
description appears at the bottom of the Diagnostic tab. This description 
includes a list of components that might have caused the problem. 

Each FRU is shown with a percentage that represents how probable it is th
component caused the hardware problem. Use these percentages as a gui
determine which component to try replacing first; the higher the percentage
probability, the better the chance that replacing the FRU will fix the problem
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To view the last diagnostics result 

1 From the left pane of the Maintenance window, select the hardware 
component. 

Result: The General page appears.

2 From the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears.

3 Click Last Result.

Result: The results of the last diagnostic test appear at the bottom of the 
Diagnostics page.

4 View the last results to determine what action to take.
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Last diagnostic results

The results of the last diagnostic test display the following information at the
bottom of the Diagnostic page: 

Information Description

Target Object This is the component selected in the tree.

Diag ID This is the ID of the diagnostic test that was run. 
The diagnostics IDs and descriptions are listed in 
the List of Diagnostics for Selected Device 
window on the Diagnostics page.

Diag result The diagnostic result includes a return code and 
whether the diagnostic test passed or failed. 

Result Description This section appears only when the diagnostic te
fails. This is a more detailed description of the 
problem. This description includes the following:

� the error that was encountered

� a list of components that might have caused the
error with a probability percentage

� troubleshooting instructions
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Obtaining replacement part numbers

Introduction

If you determine that a component needs to be replaced, contact your distrib

The Replacement tab in the Maintenance window provides component 
information. However, your distributor has the latest part number informatio
The Replacement tab is not available on all platforms.
108 CallPilot



C h a p t e r  5

System utilities

In this chapter 
 Overview 110

 Diagnostics 111

 PEP Maintenance utility 114

 Services Monitor 116

 Session Trace 118

 System Information 126

 System Monitor 128

 VoiceBridge Monitor 131
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Overview

Introduction

The following table lists the CallPilot system utilities:

Accessing the System Utilities

All CallPilot customer administrator tools are accessible from the server usi
Start > Programs > CallPilot > System Utilities.

Diagnostic Enables CallPilot startup diagnostics to be 
enabled or disabled (turned on or off).

PEP Maintenance Displays a list of installed PEPs and enables PEP
uninstall.

Services Monitor Displays the true status of all CallPilot services 
according to WinNT definition.

Session Trace Provides detailed information about the activity 
in a user’s mailbox and the state of the message 
waiting indicator (MWI).

System Information Displays particulars about the CallPilot System 
such as names, keycodes, serial numbers, IP 
addresses, and system numbers.

System Monitor Displays the status of all CallPilot subsystems 
related to call processing.

VoiceBridge Monitor Troubleshooting tool that provides phone 
simulation for the DSE connectivity.
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Diagnostics

Introduction

The Diagnostics startup utility is a graphical user interface that enables Call
startup diagnostics to be enabled or disabled as required by the user or the
system.

CallPilot startup diagnostics automatically identifies hardware problems tha
might exist when the system and its services are started (DSP, TimeSwitch
SCbus).

This tool saves time during system maintenance operations where restarts 
Call Processing services restarts are required.

There are three recommended steps:

� Use the Diagnostics tool to turn off CallPilot startup diagnostics.

� Perform system maintenance.

� Use the Diagnostics tool to turn on CallPilot startup diagnostics.
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To access the startup Diagnostic Tool utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Diagnostic Tool.

Result: The Diagnostics Tool window appears.
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To enable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Enable.

To disable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Disable.

Note: Nortel Networks recommends that you leave the startup diagnostics 
turned on.

When you disable CallPilot startup diagnostics; you prevent CallPilot from 
automatically identifying hardware problems that might exist when the syste
and its services are started (DSP, TimeSwitch, SCbus).
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PEP Maintenance utility

Introduction

The PEP Maintenance utility displays a list of all installed PEPs on the serv
and enables you to uninstall PEPS.

For information on uninstalling PEPs, refer to “Installing PEPs” on page 302

To access the PEP Maintenance utility

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
PEP Maintenance. 

The DMI Viewer window appears.
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To view a list of all installed PEPs

1 Click the component to display the PEP list.

2 Click Show PEPs.

Result: A list of all installed PEPs appears to the right of the window.
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Services Monitor

Introduction

The Services Monitor is a graphical user interface tool that helps to determ
whether the CallPilot server is fully operational. It displays true states of the
CallPilot services according to Windows NT definition, including the states t
are not available through the control panel.

To access the Services Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Service Monitor.

Result: The ServiceMon window appears.
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Using the Services Monitor

The Services Monitor provides the status of each CallPilot service (for exam
running, any pending or pausing state).

The Refresh All button enables the display to be refreshed. Use the Set Re
Rate button to set the rate of refresh or set to none.

Note: The fact that a service is running does not necessarily mean that it is 
operational. It might require some initialization, database connections, inter
data structures, and so on.
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Session Trace

Introduction

The Session Trace tool allows you to obtain detailed information about the 
activity in a user’s mailbox and the state of the message waiting indicator 
(MWI). The session information includes

� voice messaging

� call answering

� express messaging activity (messages composed and sent, or left in a
mailbox)

� the number of messages played or unplayed at the beginning, middle, 
end of a session

� messages and personal distribution lists restored into a mailbox

� the last change to the MWI (turned on or off, or untouched)

This session information allows an administrator or technician to study the s
of a user’s mailbox and the MWI, and to use that information to follow up on
any user complaints. For example, a user might complain that the MWI was
but no voice messages were in the mailbox when the user logged on. The se
information might tell the administrator why the MWI was turned on.

To access the session trace tool

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
Session Trace Tool. 

Result: The MCE Session Trace window appears.
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To find a session

1 From the Session Type drop-down menu, select the type of session.

To display a list of all session types, select All Session Types.

2 Enter as much information in the search criteria fields in the window to 
identify the session you want to view.

To display a list of all users for the selected Session Type, leave the search 
criteria fields blank.

3 Click Search to initiate the search. 

a. If you did not enter any user information, a list of users matching the 
Session Type appears on the bottom of the window.

To select a user from the list, double-click the user name to display 
session type information.

b. If you selected All Session Types for a user, the session type 
information appears to the right of the window. 

4 Double-click the session type to display the session information.

Result: The Session Type information appears on the bottom of the 
window.
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Session type information

Call Answer session type information
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Expired messages session type information
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Express messaging session type information
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Logon session type information
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Selective restore session type information
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System Information

Introduction

Use this utility to view particulars about the CallPilot system, such as name
keycodes, serial numbers, IP addresses, and system numbers.

To access the System Information utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities > 
System Information.

Result: The CallPilot System Information window appears.
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To use the System Information utility

Use this utility to view CallPilot system information at a glance.

After viewing the information on this screen, click Close to close the window
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System Monitor

Introduction

The System Monitor is a graphical user interface based tool that provides a
single point of view of CallPilot call processing status at any time. The statu
provided reflects the true internal status of the Call Processing subsystem, 
including all related call processing components. This eliminates the need to
multiple tools to get the same information.

The System Monitor queries the current status of each component it is 
monitoring and displays them in a graphical user interface. The status of ea
service is obtained from the Windows NT Service Controller; Middleware 
Components status are obtained from the CT Media server; and the DSP a
Call channels status are obtained by querying Middleware. 

This tool shows the status of

� CallPilot Critical Services related to call processing

� CT Media-based Middleware Services

� CallPilot Call Channels and Media Channels

System Monitor is a nondestructive tool that does not alter the behavior of a
CallPilot components.

Note: Users of this tool require an understanding of CallPilot and the 
components they want to monitor.
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To access the System Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities > 
System Monitor.

Result: The CallPilot System Monitor window appears.

User interface

The user interface comprises four main areas listed below. Each area indic
the status of the particular components of the CallPilot server.

1. Services Area for Critical Windows NT-based services

2. CT Media Services Area for Middleware-based services

3. Call Channel Area for Call Arrival/Departure activities

4. Media Channel Area for DSP channel usage activities

CallPilot Critical Services
Critical Services needed for CallPilot Call Processing include

� CT Media Server Service

� Telephony Server (TAPI) Service

� MAS EMCI Service
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� MAS Notification Service

� MCE SLEE Service

� MCE Notification Service

� SQL Anywhere Service

� VBPC Load Service (useful in a DSE system)

CT Media-based Middleware Services
Middleware resources needed for CallPilot include

� Dialogic CT Media Server Core Service

� Dialogic CT Media Server ISE Service

� Call Channel Resource Service

� Blue Call Router Service

� Media Resource Service

� Maintenance Service Provider Service

CallPilot Call Channels and Media Channels
Call and media channels needed for CallPilot include

� Multimedia Ports and Call Channel (DSP channel usage as well as Call 
Channel usage)

Online Help
To obtain a description of the various status codes for each of the window’s
components, use the online Help.

Menu items
The System Monitor tool provides several menu items for configuration:

File Closes the tool.

Refresh rate Changes the refresh rate to a desired level.

Help Displays a legend for each status symbol 
shown.
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VoiceBridge Monitor

Introduction

The VoiceBridge Monitor is a graphical user interface tool that provides help
when the CallPilot DSE system is first configured by simulating a phoneset.

It can also be used to troubleshoot phoneset, line, cable, or switch-related 
problems should they occur.

The simulated phoneset provides the ability to

� answer an incoming call

� make an outbound call

� transfer an incoming call to another extension

� display dialed party extension

� show the carrier presence on the phoneset

� show other characteristics specific to the phoneset being simulated, su
time of day and other features programmed on the phoneset

Note: This tool is for DSE only. Users require an understanding of switches
involved in DSE connectivity.

Installing VoiceBridge Monitor

The VoiceBridge Monitor can be installed from the CallPilot Server PEP CD
For information on installing VoiceBridge Monitor, refer to “Installing softwar
for the Lucent, Mitel, and Rolm switch” on page 312.

It takes approximately three minutes to install this tool and requires a syste
restart.
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To access VoiceBridge Monitor

Click Start > Programs > VoiceBridge 2000 > VoiceBridge Monitor.

Using the VoiceBridge Monitor

Once executed, the VoiceBridge Monitor tool appears.

Menu items
The VoiceBridge Monitor tool includes several menu items for configuration

Use the mode menu to select Active PC Phone mode.

ATTENTION Do not use this tool when CallPilot is in use as it 
can affect CallPilot operation. When this tool is 
connected to an external phoneset, you cannot 
hear on the soft phoneset.

Mode menu Allows for the selection of a different mode of 
operation. Only active mode is used with this tool in 
DSE connectivity.

File menu Allows for the selection of a preferred channel for 
monitoring. Some channels can be opened.
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Note: Nortel Networks recommends that you do not use other modes, as th
require additional hardware components to function. 

Once the Active PC Phone mode is selected, you can open any or all chann
the VoiceBridge boards from the File menu and view them, as shown below

Using soft phones

The soft phone is connected to the VoiceBridge 2000 board installed on the
CallPilot system and can be considered a physical phoneset. Actions that c
done with a soft phone include

� checking if a carrier exists between the phoneset and the switch

� making a call to the physical phoneset and viewing the phoneset or the
that is assigned to this CallPilot port

� making a call from a physical phoneset to this soft phone to check if the
shows up on the soft phone

� making a call from a physical phoneset to this phoneset and transferrin
to another physical phoneset to see if transfer is possible with CallPilot
ports

Soft phone displays
The display of the soft phone varies depending on the switch to which the 
CallPilot server is connected. 
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Rolm phone
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Lucent 8400
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Section A: Replacing hardware
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Powering down the server

Introduction

If you need to install, reinstall, or replace hardware components, power dow
server, but do not shut down the hub.

To power down the server

1 Exit all applications.

2 Shut down Windows.

3 Turn off all peripheral devices connected to the server.

4 Turn off the server using the AC push-button switch on the front panel.

5 The green power light and LCD indicator power off.

6 Unplug the AC power cord from the wall outlet.

. 

CAUTION

Risk of data loss
Exit applications and shut down Windows before powerin
down the server, or you might lose data or corrupt files. 

. 

DANGER

Risk of electric shock
The AC push-button on/off switch on the front panel does 
not turn off the system AC power. To remove power from 
the system, you must unplug the AC power cord from the
wall outlet or the system. 
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Disconnecting peripheral cables

Before you begin

Before you access the server chassis, you must remove all peripheral cable
from the server (for example, mouse or keyboard).

To disconnect peripheral cables

Label and disconnect all peripheral cables attached to the I/O panel on the 
of the server. For the names of the cables, refer to the following diagram.
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Removing the side cover

To remove the side cover

1 If a padlock is installed on the back of the system, unlock and remove it. 
Refer to “A” shown in the diagram on page 145.

2 Remove and save the three screws from the back of the side cover. Refer to 
“B” shown in the diagram on page 145.

Note: You need the screws to reattach the side cover.

3 Place the fingertips of your left hand under the built-in handle on the back of 
the cover.

4 Pull the cover approximately 2.5 cm (one inch) away from the front of the 
server until it stops. Refer to “C” shown in the diagram on page 145.

5 Use your left hand to pull the back end of the cover toward you to 
disengage the bottom row of tabs from the notches in the chassis, as 
shown in the diagram on page 145.

6 Use both hands to lift the cover upward to disengage the top row of tabs 
from the notches in the top edge of the chassis.

7 Set the cover aside.

WARNING

Risk of personal injury
Do not touch the sharp metal edges of the cover as 
they might cause personal injury.
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Replacing the side cover

To replace the side cover

1 Position the cover over the chassis so the top row of tabs aligns with the 
slots in the top of the chassis.

2 Repeat the action for the bottom row of tabs.

3 Slide the cover toward the front of the system until the cover tabs firmly 
engage in the chassis.

4 Attach the side cover to the chassis using the three screws you removed 
earlier, and tighten them firmly.

5 Replace the padlock through the metal loop that protrudes through the slot 
in the back of the side cover.

6 Connect all external cables and the power cord to the back panel.

. 

CAUTION

Risk of equipment damage
Ensure that there are no tools or loose parts inside the 
server chassis before replacing the side cover.
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Removing the front cover

Before you begin

Before you remove the front panel assembly, disconnect all peripheral devi
from the server except the hub, and remove the side panel.

To remove the front cover

1 Remove and save the screw from the front cover. 

2 Squeeze the two plastic tabs inside the front cover, and push them in to 
unlatch the cover from the slots in the chassis.

3 Pull the left side of the cover out slightly, about 15°, until the cover clears 
the power and reset buttons.

4 Slide the cover to the right until the tabs disengage from the chassis slots.

5 Set the cover aside.
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Replacing the front cover

To replace the front cover

1 Insert the metal tabs on the front cover into the slots on the right of the 
chassis.

2 Align the front panel with the server by lining up the CD-ROM drive with its 
cutout.

3 Flex and snap the right edge of the panel to insert the four metal tabs into 
their slots.

4 Squeeze the front panel and chassis together along the left side until the 
plastic tabs snap into their slots.

5 Reinstall and firmly tighten the screw.
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Removing the floppy disk drive

Before you begin

Before you remove the floppy disk drive, power down and unplug the server,
remove the side panel. 

To remove the disk drive

1 Disconnect the disk drive’s power and signal cables.

Note: The connectors are usually keyed to allow you to easily reconnect 
them to the drive. If they are not, insert both cables so that the red wires are 
closest to the center of the drive.

2 Remove and save the screw securing the drive and carrier assembly to the 
5.25 inch drive bay.

3 Slide the assembly back toward the power supply to disengage the tabs 
from the slots in the bottom of the 5.25 inch drive bay.

4 Remove the assembly from the chassis, and place it component-side up on 
an antistatic surface. 

5 Remove the four screws that hold the bracket to the drive, and set them and 
the bracket aside.

6 Place the drive in an antistatic protective wrapper.
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Replacing the floppy disk drive

To install the floppy disk drive

1 Remove the disk drive from its protective wrapper, and place it component-
side up on an antistatic surface.

2 Record the drive model and serial numbers in your equipment log.

3 Place the drive carrier on the component side of the drive to align the four 
mounting holes.

4 Attach the brackets to the drive with four screws of the appropriate size and 
length (reuse the screws you removed before). Tighten the screws firmly. 
Refer to “A” in the diagram on page 151.

5 Position the drive/bracket assembly under the bottom 5.25 inch bay.

6 Slide the assembly toward the front of the system, and engage the bracket 
tabs in the slots under the bottom bay. Refer to “B” in the diagram on page 
151.

Note: The bottom of the drive/bracket assembly must accept the tab that 
sticks out from the inside of the front panel. Make sure that the front of the 
drive fits flush in the front opening of the system.

7 Secure the assembly to the 5.25 inch bay with the screw you removed 
earlier. Refer to “C” in the diagram on page 151. Tighten the screw firmly.

8 Connect the signal and power cables to the drive. 

Note: The red stripe on the signal cable must face toward the center of the 
drive.

9 Reinstall the side cover.
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IDE cabling requirements

Introduction

A 45 cm (18 inch) IDE cable that supports two drives is standard in the syst
If you install an IDE hard drive, place it in the lowest internal drive bay to ma
cabling easier, particularly if you also have an IDE device in the externally 
accessible bay. 

If no drives are present on an IDE channel, you must remove the cable.

Disable either IDE controller

If you plan to disable either IDE controller to reuse the interrupt for that 
controller, you must physically unplug the IDE cable from the board connec
(IDE0 or IDE1) if a cable is present. Simply disabling the drive by configurin
the SSU option does not free up the interrupt.

� When you have only the IDE CD-ROM installed, you can disable only t
secondary PCI IDE controller (since the primary IDE controller runs the
CD-ROM), which makes one IRQ available.

� You can disable both the primary and the secondary IDE, if there is a S
CD-ROM, which makes two IRQs available (IRQ 14 and IRQ 15).
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Preparing to install a mass storage device

Introduction

Three 5.25 inch half-height bays provide space for tape backup, CD-ROM, 
other removable media drives. 

Filler panels and EMI shields

System EMI integrity and cooling are both protected by drives installed in th
bays or by filler panels and EMI shields covering the bays. When installing 
drives, save the panel and shield to reinstall later, in case you remove the d
and do not reinstall one in the same bay.

Bus termination when installing SCSI devices

Your cabling and connections must meet the SCSI bus specification. Otherw
the bus can be unreliable, data corruption can occur, or devices might not w
Terminate the SCSI bus at each end of the cable.

. 

CAUTION

Risk of electrical damage
The internal SCSI interface in this system supports only 
single-ended SCSI devices. If you connect differential SC
drive types to this interface, you can cause electrical 
damage to the baseboard and peripherals.

Nortel Networks recommends that you do not install hard 
drives in the 5.25 inch bays because

� the drives cannot be properly cooled in this location

� a hard drive generates EMI and is more susceptible to
ESD in this location
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To prepare the server for mass storage device installation 
1 Remove the side and front system covers and place the front cover on a flat 

surface.

2 Remove the screws and filler panel from the bay and set them aside.

3 Push the tab on the left side of the EMI metal shield to the right to 
disengage it from the chassis, and save the shield.
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Removing a mass storage device

Before you begin

Before you remove a drive, power down the server and remove the front and
system covers.

To remove the removable media drive

1 Disconnect the drive’s power and signal cables.

2 Squeeze the plastic rail tabs toward each other as you carefully slide the 
drive forward out of the bay.

3 Place the device on an antistatic surface.

4 Remove and save the four screws and two slide rails.

5 If you plan to leave the bay empty, install a filler panel and stainless steel 
EMI shield on the bay.

6 If you do not replace the device with another SCSI device and it was 
installed at the end of the SCSI signal cable, modify the cable and 
termination arrangement so that a proper termination exists at the end of 
the cable (it can be a termination device only, not necessarily a SCSI 
peripheral).

7 Replace the system covers.
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Installing an add-in board

Introduction

The baseboard has four PCI bus master slots and two ISA bus master slots
slots accept any add-in PCI and ISA boards. They also accept any add-in b
that is compatible with an IBM PC AT or PC XT system (except for an 
8-bit drop card that fits only in an 8-bit PC XT connector).

Before you begin

Before you install or remove an add-in board, power down the server and 
remove the side cover. 

To install an add-in board

1 Remove and save the expansion slot screw and cover.

2 Remove the add-in board from its protective wrapper.

Note: Do not touch the components or gold-edge connectors. Place the 
board component-side up on an antistatic surface.

3 Record the serial number of the add-in board in your equipment log.

. 

CAUTION

Risk of equipment damage
Install Nortel Networks-authorized expansion cards only.

Add-in boards can be extremely sensitive to ESD and 
always require careful handling. Before handling add-in 
boards, wash your hands and leave them slightly damp. 
Touch a large metal object to ensure that you are not 
charged.

After removing the board from its protective wrapper or 
from the baseboard, place it component-side up on a 
grounded, static-free surface or conductive foam pad if 
available. Do not slide the board over any surface.
156 CallPilot



May  2000 Performing hardware maintenance 
4 Set jumpers or switches according to the manufacturer’s instructions.

5 Hold the board by its top edge or upper corners. Press it firmly into an 
expansion slot on the baseboard. Refer to “B” shown in the diagram below.

Note: The tapered foot of the board’s retaining bracket must fit into the 
mating slot in the expansion slot frame. Refer to “C” shown in the diagram 
below.

6 Align the rounded notch in the retaining bracket with the threaded hole in 
the frame. 

Result: The bracket fits the space that was occupied by the slot cover.

7 Use the screw removed earlier. Insert it into the threaded hole, and push 
the rounded notch against the screw. Tighten it firmly to prevent the bracket 
from interfering with adjacent brackets. Attach cables if necessary.

. 

CAUTION

Risk of equipment damage
Ensure that the board is completely seated.
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8 Reinstall the side cover.

System configuration utility

If you install an ISA board, you must run the SSU to reconfigure the system
reserve the resources required by that board. Run the SSU to configure an
board that you install in a system.

In PCI cards, run SSU to ensure the card’s resources are correctly allocate
according to the IRQ tables.

B

C

A

G100725
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Removing an add-in board

To remove an add-in board

1 Label and disconnect any cables attached to the board.

2 Remove the add-in board retaining screw.

3 Hold the board by its upper corners and rock it gently until the edge 
connectors pull free.

4 Store the board in an antistatic wrapper.

5 Run the System Setup Utility after you change a PCI or ISA board to 
ensure that the resource assignments are correct.

. 

CAUTION

Risk of equipment damage
Install slot covers on all vacant expansion slots. This 
maintains the electromagnetic emissions characteristics 
the system and ensures proper cooling of system 
components.
Part 5: 702t Server Maintenance and Diagnostics 159



Performing hardware maintenance  Standard 1.0

 cool 

 and 
Removing the fan

Introduction

For cooling and airflow, the system contains two removable chassis fans to
the boards and removable media drives. The integrated power supply fan 
provides additional cooling and airflow.

Before you begin

Before you remove the fan, power down the server, detach the power cord,
remove the side cover.

To remove the fan

1 Label and disconnect any cables attached to add-in boards.

2 Remove all add-in boards. 

Note: As you remove a board, label it with its slot number so that you can 
reinstall the board in the same slot.

3 Disconnect the fan power cable connector(s) from the fan header on the 
baseboard. Refer to “A” in the diagram on page 161.

4 Remove the plastic “snap-on” fan housing assembly by firmly pressing the 
plastic tabs on the assembly inward until you can pull the tabs out of the 
slots in the chassis. Refer to “B” in the diagram on page 161.

Note: The plastic tabs are actually sections of the housing that were 
created by cutting slots into the housing. There are three of them.

5 Swing the assembly to the left until you disengage the plastic tabs on the 
other edge of the assembly from the slots in the chassis. Remove the 
assembly from the chassis, and place it on a flat surface.

6 Unsnap the fan from the housing by pressing out on the plastic tabs that 
hold the fan in place. Remove the fan from the housing, and set it aside.
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Removing the fan

 

B

A

G100818
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Replacing the fan

Introduction

Replace a failed fan with the same type as the one removed. For more 
information about replacing a fan, contact your Nortel Networks customer 
service representative.

Correct airflow direction

The removable fan pulls air from outside of the chassis so that it flows acros
boards and out the back. Orient the fan for the correct airflow direction.

To install the fan

1 Position the cable side of the fan, label-side facing the card guides, over the 
plastic guide posts in the fan housing.

2 Thread the fan power cable through the two openings on the side of the 
housing.

Note: Do not pinch the cable as you snap the fan into the housing.

3 Insert the assembly’s inner edge plastic tabs, those near the fan cable, into 
the slots in the chassis.

4 Carefully swing the assembly to the right until the outer edge tabs on the 
fan housing snap into the slots in the front of the chassis.

5 Reconnect the fan power cable connector on the baseboard.

Note: A fan in the bottom of the housing connects to the Fan 1 header. A 
fan in the top of the housing connects to the Fan 0 header. Orient the 
cables so that the red wires are closest to the middle of the baseboard.

6 Reinstall the add-in boards.

7 Reconnect any cables to the add-in boards.

8 Reinstall the side and front covers.
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Replacing a SCSI drive in the internal bay

Introduction

The internal peripheral bay has space for six drives, each 1 inch high.

You can install 1-inch high peripherals that consume up to 11 W of power a
run at a maximum ambient temperature of 50°C in this bay.

The system supports a variety of single-ended SCSI devices. As shipped fr
your supplier, the system contains at least one 4 Gbyte-wide SCSI hard driv
The wide SCSI cable supplied with the system has connectors for eight dev
and the wide SCSI bus supports only 14 peripheral devices in addition to th
host adapter itself on the baseboard.

SCSI drive cabling

If you are installing a SCSI drive, the system includes a standard 68-pin wid
(16-bit) SCSI ribbon cable that supports up to eight SCSI devices. The syst
also includes a wide-to-narrow adapter used to connect the tape drive cable
the 68-pin wide SCSI connector on the baseboard, if required. 

Unique SCSI ID

You must assign a unique SCSI ID to the SCSI drive. Use the configuration
jumpers on the front of the drive to change the ID of the drive. The SCSI 
microcontroller on the baseboard is always set to SCSI ID 7.

. 

CAUTION

Risk of equipment damage
The internal SCSI interface in this system supports only 
single-ended SCSI devices. Use Nortel Networks-
authorized drives only. 
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Active termination of SCSI cables

Hard drives generally provide active termination and termination power. The
two drives in the SCSI channels must provide termination power to the activ
terminator.

Bus termination for SCSI drives

When you install a SCSI cable, you must provide active SCSI bus terminatio
the end of the cable. If you leave the cable installed without active terminati
this can cause the SCSI bus to be unreliable. You must also ensure that 
termination is removed or disabled in all other devices on the bus.

The last SCSI device on the cable must be the active bus termination or a 
separate active termination device.

To remove a SCSI drive from the internal bay

1 Power down the server.

2 Remove the side cover.

3 Disconnect the power and signal cables from the drives in the 3.5 inch bay.

4 Remove and save the three screws holding the bay to the chassis.

5 Swing the bay out to the left of the chassis.

6 Slide the bay upward to disengage its tabs from the chassis.

7 Remove the bay from the chassis, and place it on an antistatic surface.

8 Remove the screws that attach the drive to the bay.

9 Remove the drive from the bay, and place the drive on an antistatic surface.

10 If you removed the drive that was installed at the end of the SCSI cable, 
ensure that the device that is now the last SCSI device on the cable is 
properly terminated.

11 To reinstall the internal bay, insert the tabs on the bay into their slots in the 
chassis. Slide the bay downward until the tabs interlock with the slots.

12 Swing the bay to the right into the chassis.

13 Secure the bay to the chassis with the screws you removed earlier, and 
tighten the screws firmly.
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14 Replace all cabling.

15 Reinstall the side cover.

To install a SCSI drive

1 Disconnect power and signal cables from all drives installed in the bay.

2 Remove and save the three screws holding the bay to the chassis.

3 Swing the bay out to the left of the chassis.

4 Slide the bay upward to disengage its tabs from the chassis.

5 Remove the bay from the chassis, and place it on an antistatic surface.

6 Remove the new drive from its protective wrapper, and place it on an 
antistatic surface.

7 Record the drive model and serial numbers in your equipment log.

8 Set the SCSI ID by setting any jumpers or switches, referring to Nortel 
Networks specifications and the drive manufacturer’s instructions. See the 
following tables for jumper settings:

9 To terminate the SCSI bus, do the following steps:

a. If the drive is not the last device on the SCSI cable, disable the SCSI 
termination.

b. If the drive is one of the last two drives on the SCSI cable, ensure that 
the SCSI termination power is enabled.

c. Set the drive parity jumper to Enable Parity.

10 Starting with the space at the top of the bay, position SCSI hard drive 0, 
component-side facing down, in the bay. Align the screw holes in the drive 
with those in the bay, and secure the drive to the bay with four screws.

Install the other drives as shown in the following diagram.

11 To reinstall the bay in the chassis, insert the tabs on the bay into their slots 
in the chassis. Refer to “A” in the following diagram. Slide the bay 
downward until the tabs interlock with the slots.

SCSI ID configuration with RAID installed Page 167

Non-RAID SCSI hard drive configuration Page 168
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12 Swing the bay to the right into the chassis. Refer to “B” in the following 
diagram.

13 Secure the bay with the screws you removed earlier, and tighten the screws 
firmly. Refer to “C” in the following diagram.

14 Attach power and signals cables to all drives installed in the bay. Connect 
the SCSI signal cable to the wide connector on the baseboard or to the 
RAID controller, as appropriate. See the diagram “To install a SCSI drive” 
on page 165.

For proper cooling and air flow, neatly fold and secure the excess signal 
cable so that the cable does not drape across the baseboard or add-in 
boards. Use a tie wrap or cable clip to tie back the cable. 

15 Reinstall the side cover.

16 Run the SCSI Select utility to configure the SCSI hard disk drives installed 
in the server.

Result: For RAID systems, software configuring is required. Configure non-
RAID systems in WINNT before initializing the drives.

Note: Each drive upgrade for a RAID system consists of two physical 
drives.

G100811

A

C

B
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SCSI ID configuration with RAID installed    

Refer to the figures on pages 195 to 198 for more information.

RAID 
Channel 
(Wide) SCSI ID

Device and 
recommended 

disk size Comments

A

(Ch 0)

0 First Disk
 (9 Gbytes)

Should always be located in the top slot of the
internal bay area, with drive jumper set to 
assigned SCSI ID.

1 Second Disk
(9 Gbytes)

Set drive jumper to assigned SCSI ID.

3 Third Disk
(9 Gbytes)

Set drive jumper to assigned SCSI ID.

7 SCSI Controller PCI RAID Controller

B

(Ch 1)

4 Fourth Disk
(9 Gbytes)

Should be located in the fourth slot of the 
internal drive area, with drive jumper set to 
assigned SCSI ID.

5 Fifth Disk
(9 Gbytes)

Set drive jumper to assigned SCSI ID.

6 Sixth Disk
(9 Gbytes)

Set drive jumper to assigned SCSI ID.

7 SCSI Controller PCI RAID Controller
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Non-RAID SCSI hard drive configuration   

Refer to the figures on pages 195 to 198 for more information.

SCSI ID

Device and 
recommended 

disk size Comments Drive

0 First Disk
 (9 Gbytes)

Should always be located in the top slot of the 
internal bay area. (Wide SCSI distribution)

A0

1 Second Disk
(9 Gbytes)

Second bay slot from top. B0

3 Third Disk
(9 Gbytes)

Third bay slot from top. C0

4 Fourth Disk
(9 Gbytes)

Fourth bay slot from top. D0

5 Fifth Disk
(9 Gbytes)

Fifth bay slot from top. E0

6 Sixth Disk
(9 Gbytes)

Sixth bay slot from top. F0

2 Tape Drive Narrow SCSI distribution (RAID or Non-
RAID)

N/A

7 SCSI Controller PCI Symbios Controller N/A
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Replacing baseboard DIMMs

Introduction

The baseboard supports either fast page mode (FPM) dynamic RAM (DRA
or extended data out (EDO) 3.3 V 60 ns. DRAM Dual Inline Memory Modul
(DIMMs):

� from 8 Mbytes to 512 Mbytes of memory, using up to four single-banke
DIMMs

� from 16 Mbytes to 1 Gbyte of memory, using up to four double-banked
DIMMs

DIMM sizes and compatibility

Contact your Nortel Networks sales representative or customer support 
representative for a list of approved, Nortel Networks-qualified DIMMs for th
platform you are using.

Before you begin

Before you remove baseboard DIMMs, power down the server and remove
side panel. 

. 

CAUTION

Risk of equipment damage
Use extreme care when removing a DIMM. Too much 
pressure can damage the socket slot. Apply only enough
pressure on the plastic ejector levers to release the DIMM
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To remove baseboard DIMMs

1 Gently push the plastic ejector levers out and down to eject a DIMM from its 
socket.

2 Hold the DIMM only by its edges; be careful not to touch its components or 
gold-edge connectors. Carefully lift it away from the socket, and store it in 
an antistatic package.

3 Repeat to remove other DIMMs as necessary.

To install baseboard DIMMs

1 Holding the DIMM only by its edges, remove it from its antistatic package.

2 Orient the DIMM so that the two notches in the bottom edge of the DIMM 
align with the keyed socket.

. 

CAUTION

Risk of equipment damage and data corruption
Use extreme care when installing a DIMM. Too much 
pressure can damage the socket. DIMMs are keyed and 
be inserted in only one way.

Mixing dissimilar metals can cause later memory failures
resulting in data corruption. 
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Replacing the CPU

Introduction

The CPU is an Intel Pentium II processor running at up to 450 MHz. The 
baseboard has two single-edge connectors (SEC) for two Intel Pentium II 
processors. The CPU can be upgraded in the future. 

For Dual CPU Servers

Each release of a processor model is accompanied by a stepping number (
version number).

For 702t servers that are to run with dual processors, the second processor
be within one release (either plus or minus) of the stepping of the installed C

For example, if the installed server is stepping 3, the second CPU must be 
stepping 2, 3, or 4 only.
Part 5: 702t Server Maintenance and Diagnostics 171



Performing hardware maintenance  Standard 1.0

g 

nd 
rn, 
To remove the existing CPU

1 Power down the server and remove the side cover.

2 Pinch the latches at either side of the existing CPU, and press in until they 
snap into the closed (unlocked) position.

3 Pull the CPU straight out.

To install a CPU

1 Pinch the latches at either side of the existing CPU, and press in until they 
snap into the closed (unlocked) position.

2 Pull the processor straight out.

3 Remove the new CPU from its protective package.

4 Pull the latches gently out to the open (locked) position.

5 Align the CPU with the SEC on the baseboard. 

6 Press the CPU firmly into place until you hear the snap that indicates the 
processor is in place. The latches automatically click open to hold the CPU 
locked in place.

. 

CAUTION

Risk of equipment damage
Make sure that you are not statically charged by groundin
yourself to a large metal object, then to the server itself.

. 

DANGER

Risk of personal injury
If the system has been running, any installed processor a
heat sink on the processor board(s) is hot. To avoid a bu
be careful when removing or installing baseboard 
components that are located near processors.
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Replacing the RAID controller

Introduction

Note: The CallPilot cannot be upgraded in the field from non-RAID to RAID
The RAID controller must be installed in the factory.

Add a Mylex PCI RAID controller (model DAC960) to provide high-
performance disk mirroring. It can be configured for a single bus or for two 
SCSI buses.

RAID cabling and configuration

After the RAID controller is installed, it must be connected and configured.

To add the RAID controller

1 Power down the server, and unplug the AC power cords.

2 Insert the DAC960 card in PCI Slot 4 (top PCI slot).

3 Connect RAID channel 0 on the controller to the upper drives. See the 
figures on page 195 – 198.

4 Connect RAID channel 1 on the controller to the lower drives. See the 
figures on page 195 – 198.

. 

CAUTION

Risk of reduced performance
Do not use the software-only approach provided by 
Windows NT for RAID. 
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Configuring the RAID system

Introduction

To configure the RAID system, follow these procedures:

1. Create and arrange system packs

2. Specify system drive sizes

3. Initialize the system drive

4. Back up the RAID configuration

Requirements

Before you configure the RAID system, ensure that the file \daccfg\daccf.exe
configuration disk DAC960 Configuration & Utilities, is dated 08/04/98 (Augu
4, 1998), or later (version 4.78 or better). Also, ensure that the file 
\NT\dac960nt.sys, on the Windows NT driver disk (DAC960 Software Kit), is
version 4.18.

Note: If your disks are outdated, you must obtain the latest version from you
Nortel Networks customer support representative.

. 

CAUTION

Risk of loss of system functionality
You must use the DAC960 Utility and Driver provided by 
Nortel Networks. Other software can cause a loss of syste
functionality.
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RAID system packs

The following example displays the requirements for configuring and arrang
system packs on a RAID system for the server. Based on the system, you m
be required to configure two or three system packs.

Note:  Both drives A-0 and A-1 provide the termination for the SCSI channe

Refer to the figures on pages 195 to 198 for more information.

System 
pack

Location of drives 
in internal drive 
bays

Physical 
drive 
capacity

System 
pack 
capacity

SCSI 
channel

SCSI 
ID

System 
pack 
label

A Top 4096 
Mbytes

8192 
Mbytes

0 0 A-0

Fourth slot from top 4096 
Mbytes

1 4 A-1

B Second slot from top 8192 
Mbytes

16384 
Mbytes

0 1 B-0

Fifth slot from top 8192 
Mbytes

1 5 B-1

C Third slot from top 8192 
Mbytes

16384 
Mbytes

0 3 C-0

Sixth slot from top 
(bottom slot)

8192 
Mbytes

1 6 C-1
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To create and arrange system packs

1 Insert the bootable DAC960 Configuration & Utilities disk in drive A and 
power up the computer.

Result: The DAC960 main menu appears.

2 Select New Configuration, and press Enter.

3 Select Define Pack, and press Enter.

4 Select Create Pack, and press Enter.

5 Select the first device (Channel and SCSI ID) for System Pack A.

Choose Channel 0 and SCSI ID #0.

Result: The device is labeled A-0.

6 Select the second device for System Pack A.

Choose Channel 1 and SCSI ID #4.

Result: The device is labeled A-1.

7 Press ESC to close this pack.

8 Repeat steps 5 to 7 for System Packs B and C (if applicable). Substitute the 
appropriate channel and SCSI ID references for the drives. Refer to “RAID 
system packs” on page 175.

9 Select Arrange Pack, and press Enter.

10 Select a drive from System Pack A (for example, A-0), then press Enter.

11 Repeat step 10 for a drive in System Packs B and C (if applicable).

12 Press Enter to continue.

13 Select Define System Drive, and press Enter.

14 Select Create System Drive, and press Enter.

15 Save the Configuration to a file and copy the file to a floppy disk,
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RAID system pack sizing

The RAID system limits the actual capacity of any system pack to the size o
smallest drive in its pack. As drives are replaced, a mirrored set might cons
two drives of different sizes, possibly from different manufacturers. To supp
the replacement of a failed disk drive with that of another manufacturer, an 
engineering restriction specifies the size of the system pack.

To continue configuring the RAID system, calculate the drive size as follows

2 x smallest drive in the pack

For example, if System Pack A has a nominal capacity of 4 Gbytes (2 x 2 
Gbytes), enter a system drive size of 4096. Since RAID Level 1 (mirroring) 
used, the resulting capacity is half of what you calculated.

The following table specifies the system drive sizes to enter when you confi
RAID systems. These sizes apply for currently qualified disk drives and mig
change in the future.

Note: The DAC Config software is generic. Ignore trailing letters of the disk 
drive models.

Qualified disk 
drive make/model

Physical drive 
capacity 

Size of RAID 
system drive to 
specify

Resulting RAID 
level 1 capacity

Seagate ST32155 2048 Mbytes  4096 Mbytes 2048 Mbytes

Seagate ST32272 2048 Mbytes  4096 Mbytes 2048 Mbytes

Seagate ST34371 4096 Mbytes  8192 Mbytes 4096 Mbytes

Seagate ST34573 4096 Mbytes  8192 Mbytes 4096 Mbytes

Seagate ST39173 8192 Mbytes 16384 Mbytes 8192 Mbytes

Seagate ST39175 8192 Mbytes 16384 Mbytes 8192 Mbytes
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To specify system drive size

1 On the Create System Drive screen, from the DAC960 Main Menu, select 
RAID 1, and press Enter.

2 Enter the size of the system drive as specified in “RAID system pack sizing” 
on page 177, and press Enter.

Result: You are prompted to confirm that you want to create this system 
drive.

3 Select Yes.

4 Repeat steps 1 to 3 for the remaining packs. When you finish, press Esc to 
exit to the Create System Drive screen.

5 Press ESC to return to the Define System Drive screen.

6 When prompted, select Yes to save the configuration.

Result: The Main Menu appears.

To initialize the system drive

The initialization of the drives completes the configuration of the RAID syste
This takes from one to several hours, depending on the size of the hard dis

1 From the DAC960 main menu, select Initialize System Drive, and press 
Enter.

2 Use the arrow keys to select each system drive. Press Enter to toggle your 
selection.

Result: A check mark indicates a selected drive.

3 Press ESC to return to the previous screen.

Result: The main menu appears.

4 Select Start Initialize, and press Enter.

Result: You are prompted to confirm that you want to initialize this System 
Drive.

5 Select Yes.

6 When the initialization is complete, press any key to continue. 
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To back up the RAID configuration

1 Press ESC to go to the daccfg Main Menu.

2 Select Tools from the daccfg Main Menu, and press Enter to display the 
Tools menu.

3 Select “Backup/Restore conf,” and press Enter.

Result: A cautionary message appears.

4 Press any key to acknowledge the cautionary message.

Result: The system displays the Backup and Restore Configuration 
submenu.

5 Select “Backup Configuration,” then press Enter.

Result: The system displays the “Enter File Name” pop-up window.

6 Type a:\ and the name of the backup file (for example, a:\raidback ), then 
press Enter. 

Result: The system displays a warning, Existing file, if any 
will be overwritten .

7 Enter Yes.

Result: The RAID configuration is backed up on the floppy disk. A 
message displays when the backup has been successfully completed.

8 Press ESC to return to the Main Menu.

. 

CAUTION

Risk of data loss
You must save this file to drive A on a floppy disk; 
otherwise, you might not be able to restore the RAID 
configuration if the RAID card fails. 

Ensure the floppy disk is stored in a safe and accessible 
location. 
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Rebuilding a hard disk in RAID

Introduction

In RAID level 1, two equal-capacity disks mirror one another. Both drives ru
simultaneously with one disk serving as the backup copy of the other disk. If
drive fails, the other continues to run. When the failed drive is physically 
replaced with a new one, the data on the operating drive of the system pack
be copied onto the new drive to rebuild it. RAID automatically performs this
rebuild process when the replacement drive is accessed.

If you would like to start the initiation process sooner, or monitor the rebuild
process, use the the DAC Administration software that is installed on the sy

Before you begin

Perform this procedure in response to the system message that a hard disk
failed. The message displays information about drive location. Perform this
procedure while the system is powered on.
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To rebuild a hard disk in a RAID system

1 Observe the warning message given by the DAC Monitor software that 
indicates a hard drive failure.

2 Record the SCSI channel SCSI ID of the drive that failed from the 
information in the DAC Monitor window.

3 Identify which drive drive failed using this information and referring to the 
tables contained on page 175.

4 Shutdown Windows NT and power down the server.

5 Remove the failed hard disk.

6 Replace with a new hard disk.

7 Power up the server and logon to Windows NT.

8 Click on the DAC Administration icon.
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9 Choose Rebuild Drive from the Management menu.

10 Click the drive marked DED.
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11 When the rebuild completes, click OK.

Note: This procedure takes up to one hour, depending on the size of the 
drive (an average of 4 Gbytes in 20 minutes).

12 After the procedure is complete, close the application.
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Replacing Ethernet CLAN cards

Introduction

The 702t server can only use a PCI Ethernet card.

To replace Ethernet cards

1 Power down the server.

2 Unplug the AC power cord.

3 Remove the chassis cover.

4 To make access to the internal components easier, turn the server over on 
its side.

5 Locate the CLAN Ethernet card to be removed, and unplug its network 
cabling.

6 Remove the screw that fastens the card in the chassis.

7 Gently pull the card out (use a slight rocking motion).

8 Remove the new Ethernet card from its protective packaging.

Note: Place the old Ethernet card into the protective packaging.

9 Line up the new Ethernet card with the slot (PCI or ISA, as appropriate). 

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

10 Press the card into the slot. 

11 Secure the card to the server chassis with the fastening screw.

12 Stand the server up and replace the chassis covers.

13 Plug in the AC power cord.

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or it will short-
circuit.
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14 Power up the server.

15 Remove the old network card driver if appropriate.

16 Install the network adapter software. 

17 Optimize the binding order.
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Replacing the PCI Token Ring card

Introduction

The system uses a PCI bus Token Ring adapter for CLAN connectivity.

To replace the PCI Token Ring card

1 Power down the server.

2 Unplug the AC power cord.

3 Remove the chassis covers.

4 To make access to the internal components easier, turn the server over on 
its side.

5 Locate the PCI Token Ring card to be removed, and unplug its network 
cabling.

6 Remove the screw that fastens the card in the chassis.

7 Gently pull the card out (use a slight rocking motion).

8 Remove the new PCI Token Ring card from its protective packaging.

Note: Place the old PCI Token Ring card into the protective packaging.

9 Line up the new PCI Token Ring card with the PCI slot.

Note: Make sure the end-plate tab is lined up with the opening in the 
chassis.

10 Press the card into the slot. 

11 Secure the card to the server chassis with the fastening screw.

12 Stand the server up, and replace the chassis covers.

13 Plug in the AC power cord.

. 

CAUTION

Risk of equipment damage
Ensure that the card is completely seated or it will short-
circuit.
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14 Power up the server.

15 Install the network adapter software. 

16 Optimize the binding order.
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Section B: Expanding hardware

In this section
 Powering down the server 190

 Disconnecting peripheral cables 191

 Configuring the SCSI subsystem 192

 Connecting the IDE CD-ROM 199

 Configuring SCSI devices 200

 Installing the CLAN network card 204
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Powering down the server

Introduction

If you need to install, reinstall, or replace hardware components, power dow
server.

To power down the server

1 Exit all applications.

2 Shut down Windows.

3 Turn off all peripheral devices connected to the server.

4 Turn off the server using the AC push-button switch on the front panel.

5 The green power light and LCD indicator power off.

6 Unplug the AC power cord from the wall outlet.

 

. 

CAUTION

Risk of data loss
Exit applications and shut down Windows before powerin
down the server, or you might lose data or corrupt files. 

. 

DANGER

Risk of electric shock
The AC push-button on/off switch on the front panel does 
not turn off the system AC power. To remove power from 
the system, you must unplug the AC power cord from the
wall outlet or the system. 
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Disconnecting peripheral cables

Introduction

Before you access the server chassis, you must remove all peripheral cable
from the server (for example, mouse or keyboard).

To disconnect peripheral cables

Label and disconnect all peripheral cables attached to the I/O panel on the 
of the server. 
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Configuring the SCSI subsystem

Hard disk subsystem configuration

A 702t platform can be configured as either a RAID or non-RAID server. Th
configurations offer differing capacities of 4 Gbyte and 9 Gbyte hard drives.

Getting started

The process of configuring the SCSI subsystem includes the following 
procedures:

1. Connecting the IDE CD-ROM 
This procedure applies to both RAID and non-RAID systems.

2. Configuring SCSI devices 
Steps relevant to RAID and non-RAID systems are included in this 
procedure.

3. Configuring the RAID system 
A series of four procedures explains the steps for configuring the RAID
system.

Cabling and termination

The following figures illustrate the cabling and termination of the SCSI devic
in the system. SCSI devices include hard disks and optional disk drives.

Note: The tape drive MUST be installed using only one narrow-to-wide adap
in its cabling chain. Also, unless there is no other option, the tape drive mus
connected to a SCSI bus other than the SCSI bus being used for the disk d
If possible, the tape drive must use the same connector and cable type whe
connecting it to the baseboard. 

For example, if the tape drive has a narrow connector, please use a narrow
narrow cable. If the tape drive has a wide SCSI connector, use a wide-to-w
cable. If necessary, you must use one narrow-to-wide adapter.
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Tape drive settings

 Settings for the tape drive must be set to the following values:

1. Tape drive terminator is added to end of tape drive SCSI channel, as 
outlined in the diagrams “Cabling for a RAID system with IDE CD-ROM 
and SCSI tape drive” on page 196, and “Cabling for a non-RAID system 
with CD-ROM and tape drive” on page 198.

2. SCSI ID is set to 2.

3. Parity must be enabled.

4. Termination power must be enabled. (TPWR)

5. Termination is disabled.

The tape drive requires an active SCSI terminator to terminate its SCSI bus
both the system’s wide and narrow SCSI controller, as illustrated in the 
following diagrams. The appropriate active terminator is required, as follows

� Wide Active Terminator (A0766997)
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� Narrow Active Terminator (A0767002)

� Narrow to wide adapter
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Cabling for a RAID system with IDE CD-ROM

A0

B0

C0

A1

B1

C1

RAID card

Channel 0 Channel 1

CD-ROM

G100813

Note 1:  A "T" indicates an active wide terminator.
Note 2:  The CD-ROM is connected to the IDE 0 (PRI IDE).

Wide
SCSI
Narrow
SCSI

IDE 0
IDE 1

T

T
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Cabling for a RAID system with IDE CD-ROM and SCSI tape drive 

A0

B0

C0

A1

B1

C1

Tape drive

RAID card

Wide
SCSI
Narrow
SCSI

Channel 0 Channel 1

IDE 0

CD-ROM

IDE 1

Note 1:  A "T" indicates a wide active terminator.
Note 2: *A wide SCSI active terminator (A0766997) must be the last device on
              the SCSI bus.
Note 3:  The CD-ROM is connected to IDE 0. 

*
T

T

T
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Cabling for a non-RAID system with CD-ROM

A0

B0

C0

CD-ROM

G100815

Note 1: A "T" indicates an active wide terminator.
Note 2: The CD-ROM is connected to IDE 0

Wide
SCSI

Narrow
SCSI

IDE 0
IDE 1

T
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Cabling for a non-RAID system with CD-ROM and tape drive 

A0

B0

C0
Tape drive

CD-ROM

Note 1:  A "T" indicates an active terminator.
Note 2: *A narrow SCSI active terminator (A0767002) must be the last device on
              the SCSI bus.
Note 3:  An "A" indicates a narrow to wide adapter.
Note 4:  The CD-ROM is connected to IDE 0.

Wide
SCSI

Narrow
SCSI

IDE 0
IDE 1

*

T

T

A
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Connecting the IDE CD-ROM

Introduction

The CD-ROM is an IDE device that is not part of the SCSI chain. 

To connect the IDE CD-ROM

1 Remove the side cover. Refer to “Cabling for a RAID system with IDE CD-
ROM” on page 195 and “Cabling for a non-RAID system with CD-ROM and 
tape drive” on page 198 for the proper connections.

2 Set the CD-ROM jumper settings to indicate “Master/Single.”

Note: Refer to the CD-ROM drive manufacturer’s documentation for 
specific jumper settings.

3 Connect the CD-ROM to the Primary IDE (IDE 0) interface on the 
baseboard.
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Configuring SCSI devices

Introduction

See the figures on page 195 and page 197.

Hard drives are connected to a wide SCSI bus, or the wide SCSI channels o
RAID controller.

SCSI termination

RAID systems
The last two disk drives on each of the SCSI cables should have terminatio
power applied to the SCSI bus, and also to internal terminators. Terminator
the disks themselves should be disabled. Wide SCSI active terminators sho
be used to terminate these SCSI buses at the very end of the SCSI cable. 

Refer to the diagrams, “Cabling for a RAID system with IDE CD-ROM” on 
page 195 and “Cabling for a RAID system with IDE CD-ROM and SCSI tape 
drive” on page 196. Refer to the manufacturer’s manual for specific disk drive
settings.

Non-RAID systems
Hard disks should be cabled to the on-board wide SCSI controller using a w
SCSI cable. The last two disk drives on the SCSI cable must have terminat
power applied to the SCSI bus and to the internal terminators. Terminators 
the disks should be disabled. A wide SCSI active terminator should be used
terminate this SCSI bus at the very end of the cable.

Tape drives
For all Meridian Application Servers, the NTRH9036 tape drive must have a
active SCSI terminator as the last device on the SCSI cable, as this tape dr
incapable of providing SCSI bus termination. You will need to purchase an 
appropriate active terminator as specified below:

� Wide Active Terminator (Part Number A0766997)

� Narrow Active Terminator (Part Number A0767002)
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If the tape drive is on a wide SCSI cable, ensure the jumper labeled TPWR
“Termination Power to the SCSI bus”) is enabled on the tape drive, and that
tape drive is attached to the second last connector on the SCSI cable. Attac
wide SCSI active terminator to the last connector at the very end of the SCS
cable.

If the tape drive is on a narrow SCSI cable, ensure the jumper labeled TPW
“Termination Power to the SCSI bus”) is enabled on the tape drive, and tha
tape drive is attached to the second last connector on the SCSI cable. Attac
narrow SCSI active terminator to the last connector on the SCSI cable.

One end of the SCSI bus is terminated on the baseboard with active termin
that are permanently enabled. The other end(s) of the SCSI bus(es) must b
terminated using one of the active terminators.

SCSI Parity

Parity is always enabled in any, and all, SCSI devices.

SCSI IDs

Each SCSI device on a SCSI bus must have a unique SCSI ID. IDs for narr
(8-bit) SCSI devices must be in the range from 0–7. IDs for wide (16-bit) SC
devices also include the range from 8–15. Typically, an ID of 7 is used by th
host adapter.

Note: To minimize potential problems, the boot drive (A-0) must have SCSI 
0, and the tape drive must have SCSI ID 2. Hard drive jumpers must be set
that the disk drives use the IDs 0, 1, 3, 4, 5, and 6, as shown at the end of t
following procedure.

If it is not clear from the disk drive manufacturer’s documentation how to se
disk drive jumpers for SCSI ID and bus termination, call your Nortel Networ
customer support representative.
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To configure SCSI devices

Disk drives

1 To configure the drives in specific systems, do the following steps:

a. In RAID systems:

Drives labeled A0, B0, and C0 terminate on channel 0 of the SCSI RAID 
card. Set the SCSI ID for A0 to 0, B0 to 1, and C0 to 3. Drives labeled A1, 
B1, and C1 terminate on channel 1 of the SCSI RAID card. Set the SCSI ID 
for A1 to 4, B1 to 5, and C1 to 6.

b. In non-RAID systems:

Drives labeled A0, B0, and C0 terminate on the wide SCSI connector on 
the baseboard. Set the SCSI ID for A0 to 0, B0 to 1, and C0 to 3. The last 
two disk drives on the SCSI cable must have termination power applied to 
the SCSI Bus, and also to internal terminators. Disable terminators on the 
disks. Use a wide SCSI active terminator to terminate this SCSI bus at the 
very end of the cable.

Refer to the diagrams on “Cabling for a non-RAID system with CD-ROM” on 
page 197 and “Cabling for a non-RAID system with CD-ROM and tape 
drive” on page 198.

c. For all other drives:

Disable Termination and use the following SCSI IDs:

Drive     SCSI ID
A0             0
B0             1
C0             3
A1             4
B1             5
C1             6

Refer to the manufacturer’s manual for specific disk drive jumper settings.

Tape drive

1 Remove the side cover to expose the drive bays. Refer to the diagram 
“Cabling for a RAID system with IDE CD-ROM and SCSI tape drive” on 
page 196  or “Cabling for a non-RAID system with CD-ROM and tape drive” 
on page 198 for the location of the drive bays.

2 Set the SCSI ID on the tape drive to 2.
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3 Set the tape drive parity checking to Enabled.

Note: You might have to move or insert a jumper. Refer to the 
manufacturer’s manual for specific jumper settings.

4 Remove the SCSI Termination from the tape drive if it is installed.

Note: Do not set the jumper for applying termination power to the bus. 
Refer to the manufacturer’s manual for specific tape drive jumper settings.

5 Using either a narrow or wide SCSI cable, depending on your system 
configuration, connect the tape drive to the on-board SCSI controller not 
used by the hard disks. Refer to the diagrams on pages 195 to 198 for the 
exact cabling.

Note: Use a wide (68-pin) to narrow (50-pin) SCSI connector that is 
shipped with the system, if required.
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Installing the CLAN network card 

Introduction

The server has a built-in Ethernet network controller—the ELAN (embedde
LAN) controller. You must install a secondary controller for the CLAN 
(customer LAN).

To install the CLAN network card

1 Power down the server.

2 Install the CLAN card.

� If the card is PCI, install it in the appropriate PCI slot.
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Section C: Adding and replacing switch-
specific boards and cards

In this chapter 
 Replacing MPB16 boards 206

 Adding a VoiceBridge 2000 card 214

 Replacing the VoiceBridge 2000 card 216

 Replacing the DTI/480SC board 218
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Replacing MPB16 boards

Introduction

This section describes how to replace MPB16-4, MPB16-2T boards, and MP
cards.

Parts to install

The MPB16 board comes in two different versions.

� MPB16-4 (for the Meridian 1, MSL-100/DMS-100, Lucent, Mitel and 
Rolm switches)

� MPB16-2T (for the Matra switches)

MPB16-4 (NTRH20BA)
There are four slots available on the MPB16-4 (NTRH20BA) to hold four 
MPC-8 cards.

There is also a DB-25 pin digital connector.

MPB16-2T (NTRH21CA) board
The MPB16-2T/LS*16 is a PCI form-factor card that includes two bays to h
MPC-8 DSP cards.

connector
DB-25

SCbus connector
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Note: The MPB16-2T/LS*16 will be referred to as the MPB16-2T for the 
remainder of this document.

Below is a picture of the MPB16-2T with analog mezzanine and two MPC-8
cards installed.

Analog loop start cable (NTRH0914)
The following photograph shows the 10 m (32.8 ft) NTRH0914 analog loop s
cable. The DB37 end connects at the back of the server to the MPB16-2T. T
other end of the cable must be stripped and connected to a bix block servic
the Matra switch.
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CT-Bus cable (NTRH0915)
The CT-Bus ribbon cable is used to series two MPB16-2T cards in a single 
server. The connectors are keyed to optimize correct installation.

MPC-8 card (NTRH01AA)
The MPC-8 is a credit-card-sized PC-card that plugs into all MPB16-2Ts. T
MPC-8 provides multimedia expansion to the MPB16-2T. Below is a picture
an MPC-8.
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Maximum number of MPC-8s per server

The server supports up to a maximum of two fully loaded MPB16 boards, wh
provides 96 channels (or 64 channels if the MPB16-2T board is used), as s
on the following table. 

Maximum multimedia 
channels 

Optional MPC-8s

One MPB16-4 48
(16 of which are built into the 
MPB16-4 board) 

4
(provides up to 32 
additional channels)

Two MPB16-4s 96
(32 of which are built into the 
two MPB16-4 boards—16 
channels per board)

8
(provides up to 64 
additional channels)

One MPB16-2T 32
(16 of which are built into the 
MPB16-4 board) 

2
(provides up to 16 
additional channels)

Two MPB16-2Ts 64
(32 of which are built into the 
two MPB16-4 boards—16 
channels per board)

4
(provides up to 32 
additional channels)
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Maximum number of MPB16-2Ts per server

The server supports up to a maximum of two fully loaded MPB16-2Ts, whic
provide 32 channels each for a maximum of 64 channels, as shown in the 
following table. 

Installing the MPC-8 cards

1 Slide the MPC-8 into any available bay on the MPB16 with the label side up. 

2 Press the MPC-8 gently into the bay until you feel the card slide firmly into 
place. If the card is placed upside down, it will not slide completely into the 
bay.

Note: To simplify the installation, install the MPC-8 into the MPB16 prior to 
installing the MPB16 in the server.

Embedded multimedia 
channels 

Optional MPC-8s

One MPB16-2T 16 2
(provides up to 16 
additional channels)

Two MPB16-2Ts 32 4
(provides up to 32 
additional channels)

. 

CAUTION

Risk of electrical damage
Wear an antistatic ESD wrist strap when handling 
multimedia processing boards and cables.

ATTENTION MPC-8 cards are not hot-pluggable. Power down your serv
before installing the cards.
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Installing the MPB16-2T board

1 Disconnect the CT-Bus cable from the existing MPB16-2T board.

2 Remove the existing MPB16-2T from its slot in the backplane. Retain the 
screw to reuse when installing the new board.

3 Press the MPB16-2T firmly into its slot in the backplane. 

Note: Take care to slide the MPB16-2Tcarefully past the protective foil 
strips, as they are easily damaged.

4 Secure the board at the rear of the server using the same screw you 
removed earlier.

5 If are installing a second MPB16-2T, repeat steps 2 and 3.

6 If you have two MPB16-2T’s installed in the server, use the CT-Bus cable to 
connect the two boards. This cable is keyed; do not force the cable onto the 
card connectors.

7 Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover 
back on.

8 Connect the NTRH0914 loop start cable from the MPB16-2T to the Matra 
switch. This cable connects to the punch-down panel servicing the Matra 
switch.

9 Run the Configuration Wizard to detect the new hardware.

10 The MPB16 installation is complete.

. 

DANGER

Risk of electrical shock
Disconnect the AC power and remove the AC power cord from t
host product.
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DSP numbering
Use the following table as a guide for DSP numbering with multiple MPB16-
cards.

MPC-8 cards are counted from the handle side of the MPB16-2T, as shown
the following photographs.

MPB16-2T board DSP assignments

First MPB16-2T 1 and 2 = embedded

3 and 4 = MPC-8

Second MPB16-2T 7 and 8 = embedded

9 and 10 = MPC-8

DSP 3DSP 4First MPB16-2T

DSP 9DSP 10

Second MPB16-2T
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Installing the MPB16-4 boards

1 Disconnect the SC-Bus cable from the existing MPB16-4 board.

2 Remove the existing MPB16-4 from its slot in the backplane. Retain the 
screw to reuse when installing the new board.

3 Press the MPB16-4 firmly into its slot in the backplane. 

Note: Take care to slide the MPB16-4 carefully past the protective foil 
strips, as they are easily damaged.

4 Secure the board at the rear of the server using the same screw you 
removed earlier.

5 If you are installing a second MPB16-4, repeat steps 2 and 3.

6 Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover 
back on.

7 Run the Configuration Wizard to detect the new hardware.

Result: The MPB16 installation is complete.

. 

DANGER

Risk of electrical shock
Disconnect the AC power and remove the AC power cord from t
host product.
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Adding a VoiceBridge 2000 card

Introduction

This section describes how to add a VoiceBridge 2000 Digital PBX/CBX 
integration card (also referred to as the VB2000 card). This card is installed
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards 

Note: These cards are identical in external appearance, and the procedures
installing and configuring them are the same.

The 1001rp can have a maximum of two VoiceBridge 2000 boards installed.
first board should be installed in ISA slot 1, and the new board in ISA slot 2
Refer to the picture on page 143 for the location of the ISA slots.

To install the VoiceBridge 2000 card

1 Shut down Windows NT and power down the server.

2 Remove the chasis cover.

3 Write down the serial number of the new VoiceBridge 2000 board.

Switch VB2000 card model Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060

Mitel

SX-200D, SX-200 Light, SX-2000 Light, 
SX-2000 S, SX-2000 VS

VB-2007 NTRH9059

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057
214 CallPilot



May  2000 Performing hardware maintenance 
4 Remove the screw holding on the cover of the ISA slot and remove the 
cover.

5 Insert the VoiceBridge 2000 board and secure it with the screw.

6 Connect the SCbus cable so that it interconnects both of the VoiceBridge 
boards and the MPB16-4 board.

7 Replace the chassis cover.

8 Connect the external cable to the PBX connector on the back of the 
VoiceBridge 2000 board.

9 Power on the server.

10 Boot the SSU.

11 Define the new VoiceBridge 2000 board.

12 Assign the appropriate IRQ.

13 Save and exit from the SSU.

14 Restart the server and log on to Windows NT.

15 Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).

16 Click ADD.

Result: The Add Board dialog box appears.

17 Enter the serial number of the new VTG board and click OK.

18 Click Close.

Result: The VTG Configuration closes.

19 Run the Configuration Wizard to reconfigure the VTG channel 
configuration.

Result: The VoiceBridge 2000 card installation is complete.
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Replacing the VoiceBridge 2000 card

Introduction

This section describes how to replace the VoiceBridge 2000 Digital PBX/CB
integration card (also referred to as the VB2000 card). This card is installed
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards 

Note: These cards are identical in external appearance, and the procedures
installing and configuring them are the same.

To install the VoiceBridge 2000 card

1 Disconnect the external cable from the VoiceBridge2000 card.

2 Remove the chassis cover.

3 Disconnect the internal SCbus cable from the VoiceBridge2000 card.

4 Remove the existing VoiceBridge 2000 card from its ISA slot.

5 Remove the new VoiceBridge 2000 card from its ESD bag. 

Switch VB2000 card model Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060

Mitel

SX-200D, SX-200 Light, SX-2000 Light, 
SX-2000 S, SX-2000 VS

VB-2007 NTRH9059

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057
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6 Write down the VoiceBridge 2000 card serial number, which is printed on 
the backplate of the card, and the slot number. The serial number is shown 
as “S/N: xxxxx.” 

7 Insert the VoiceBridge 2000 card into the ISA slot. The PBX connector 
should be positioned in the open slot in the backplane.

8 Replace and tighten the retaining screw to secure the board. 

9 Repeat steps 4 to 8 for each VoiceBridge 2000 card.

10 The SCbus cable consists of two connectors at one end (intended for the 
MPB16-4s), a large gap with no connectors, and then seven connectors at 
the other end (intended for the VoiceBridge 2000 cards). 

Use the SCbus cable to connect the MPB16-4 and VoiceBridge 2000 cards.

11 Put the cover back on the server.

Note: Be careful not to pinch the SCbus cable when sliding the server 
cover back on.

12 Power on the server and log on to Windows NT.

13 Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).

14 Select the serial number of the board that was removed and click Delete.

15 Click ADD.

Result: The Add Board dialog box appears.

16 Enter the serial number of the new VTG board and click OK.

17 Click Close.

Result: The VTG Configuration closes.

18 Run the Configuration Wizard to reconfigure the VTG channel 
configuration.

Result: The VoiceBridge 2000 card installation is complete.
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Replacing the DTI/480SC board

Introduction

This section describes how to replace the DTI/480SC board. The DTI/480S
board provides a T1 network interface to the switch. 

Switch settings

� Board locator switch (SW100)
Switch SW100 is used to assign the unique board locator ID. The installatio
procedure instructs you to assign a unique board locator ID to each board.

� Remote Loopback Switch
The loopback switch is factory set to ON for normal mode. You can move th
loopback switch to the OFF position for loopback mode as part of 
troubleshooting a system problem.
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DTI/480SC board–switch locations

Installing the DTI/480SC boards

1 Remove the existing DTI/480SC from its ISA slot in the backplane. Retain 
the screw to reuse when installing the new board.

2 Remove a DTI/480SC board from its ESD bag. 

G101466

P4

Dual RJ-48C
jacks

SW100

Red

Span 1 Span 1 Span 1

Loopback
LED

Loopback
switches

Status
lights

Span 2

Yellow
Green

Loopback
switches

Normal mode
Default

Loopback
switches

Remote loopback
mode

ON

ON
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3 On the board, dial the rotary switch (SW100) to select a number. Set the 
first board to 0, the second to 1, and so on. 

The switch has hexadecimal numbers ranging from 0 to F inclusive. See 
“DTI/480SC board–switch locations” on page 219.

4 Ensure that the loopback switch is in the ON (down) position. See “DTI/
480SC board–switch locations” on page 219.

5 Use the slot’s board guides as you insert the board edge connector into the 
slot. Press firmly until the board is securely seated in the slot.

6 Replace and tighten the retaining screw to secure the board. 

7 Repeat steps 1 to 6 for each DTI/480SC board you are installing.

8 Use the SCbus cable to connect the MPB16-4 and DTI/480SC boards. See 
“DTI/480SC board–switch locations” on page 219 for the location of the P4 
connector.

The SCbus cable consists of two connectors at one end (intended for the 
MPB16-4s), a large gap with no connectors, and then seven connectors at 
the other end (intended for the DTI/480SC boards).

9 Put the cover back on the server.

Note: Be careful not to pinch the SCbus cable when sliding the server 
cover back on. 

10 Run the Configuration Wizard to detect the new hardware. 

Result: The board installation is complete. 
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Section D: Upgrading and using the SSU 
and BIOS

In this section
 Overview 222

 Backing up the BIOS and SSU upgrade disks 223

 Recovering the BIOS 224

 Crisis recovery 226

 Upgrading and configuring the BIOS 228

 SSU overview 231

 Configuring your system using SSU 233
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Overview

Introduction

BIOS defines the compatibility of your PC with expansion hardware. Each 
BIOS has a corresponding SSU release. The proper SSU floppy disk is iden
by the Intel software version number.

All systems configured by Nortel Networks manufacturing are shipped with 
least the minimum vintage BIOS and corresponding SSU. However, new BI
might be issued to fix discovered bugs or to support new hardware standard
options. 

Minimum vintage

If the SSU/BIOS firmware does not meet minimum vintage requirements, it 
must be updated. 

To determine BIOS vintage

1 Power on the server.

2 Read the BIOS version on the display.

BIOS and SSU releases

The following are tested and supported releases of BIOS and SSU for the se

Server
Intel SSU/
Release

Intel BIOS 
Release When to use

702t 3.0 12.0 No upgrade required 
if already at this 
release.
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Backing up the BIOS and SSU upgrade disks

Introduction

Because the SSU software holds server configuration for individual system
make a backup copy of the BIOS and SSU upgrade software. 

Before you begin

Before you can back up the BIOS/SSU upgrade, you must have the BIOS a
SSU upgrade software on a floppy disk.

You also need two blank floppy disks for the backup copies.

To backup the BIOS and SSU

1 Write-protect the BIOS upgrade floppy disk.

2 Insert the BIOS upgrade floppy disk into drive A.

3 Type diskcopy a: b: /V and press Enter.

4 When prompted to insert the destination disk, insert a blank floppy disk, 
and press Enter.

Note: If prompted to insert the source disk, insert the original upgrade disk.

5 When prompted, “Copy another disk (Y/N)? ”, type N.

6 Remove the disk from the disk drive.

7 Label the backup copy with the information on the original disk.

8 Repeat the procedure for the SSU upgrade.
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Recovering the BIOS

Flash memory description

Flash memory contains a protected area that, in most cases, cannot be corr
Code in this area starts the server from drive A when the BIOS is corrupted
BIOS corruption is generally detected by the POST diagnostics at system 
startup.

BIOS recovery description

The recovery procedure automatically loads flash memory from the BIOS fi
on the BIOS recovery disk.

To recover the BIOS

1 Insert the BIOS recovery disk in drive A.

Note: The disk is shipped with the server. Call your Nortel Networks 
customer support representative if you need a disk. 

2 Power up the server.

3 Type option 1, then press Enter.

Result: The BIOS is updated, and the server will restart.

4 Power down the server, and remove the power cord from the system for 60 
seconds.

5 Remove the server side cover.

6 Move the CMOS Clear jumper (J3J2) to the Erase position (from pins 1-2 to 
pins 2-3). 

Result: This replaces the contents of the NVRAM with the manufacturing 
default settings.

7 Restart the system.

Result: The system displays a message that the CMOS area has been 
cleared when the operation is complete.

8 Power down the server.
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9 Move the CMOS Clear jumper to the Protect position (from pins 2-3 to pins 
1-2). 

Result: This protects the contents of the NVRAM.

10 Replace the side cover.

11 Power up the server.

12 Reconfigure the system with SSU, as outlined in “Configuring your system 
using SSU” on page 233.
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Crisis recovery

To recover from a corrupted CMOS

If the system behaves abnormally (for example, it does not start up or it free
during the startup process), the CMOS might be corrupted. To correct this, 
follow these steps:

1 Power down the server.

2 Remove the server cover and access the motherboard.

3 Move the J3J2 jumper to pins 2 and 3 (by default the jumper is set to pins 1 
and 2).

4 Power up the server.

Result: A message stating that the CMOS has been cleared displays.

5 Power down the server.

6 Reset the J3J2 jumper to pins 1 and 2.

7 Replace the server cover.

8 Power up the server.

9 The CMOS setup must be performed. Refer to “Upgrading and configuring 
the BIOS” on page 228 for more information.

To recover from a corrupted BIOS

In situations of a corrupt BIOS or an unsuccessful BIOS update, the 702t se
can boot in recovery mode. To boot in recovery mode, follow these steps:

1 Power down the server.

2 Remove the server cover and access the mainboard.

3 Move the boot option jumper J3J2 (pins 9-11) into the recovery boot 
position (pins 10-11). The jumper connects pins 9 and 10 by default 
(normal BIOS).

Note: Recovery mode requires a memory DIMM module in the first socket.

4 Insert the Nortel Network’s 702t BIOS disk in drive A.
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5 Power up the server.

Note: During this process, video is not initialized.

Result: A high-pitched beep tone announces the start of the recovery 
process. The entire process takes from two to four minutes.

A successful update ends with two high-pitched beep tones.

A failed update is indicated by a long series of short beep tones. This 
indicates that some of the BIOS files might be corrupted.

6 After a successful update, power down the server.

7 Move the recovery jumper back to pins 9 and 10.

8 Power up the server.

9 Verify that the BIOS version matches the version that was updated.

Note: The CMOS is not cleared when the system BIOS is updated.
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Upgrading and configuring the BIOS

BIOS update availability

Obtain BIOS upgrades from your Nortel Networks distributor.

BIOS upgrade floppy disk

You must perform the Intel server BIOS upgrade using a bootable floppy di
This disk must load the MS-DOS extended memory driver, himem.sys. 

Before you begin

The process of upgrading the BIOS includes four steps:

1. Make the BIOS disk bootable.

2. Update flash memory for BIOS upgrades.

3. Clear the NVRAM.

4. Run SSU to reconfigure the system and memory.

To make the BIOS upgrade disk bootable

1 From the C:\> prompt, type sys a:  and press Enter.

2 Type copy C:\dos\himem.sys a:\  and press Enter.

3 Create a config.sys file on the floppy disk to load himem.sys. The config.sys 
file must contain the following line:
device=\himem.sys 
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To upgrade the BIOS

1 Power down the server.

2 Insert the update disk in drive A.

3 Power up the server.

Result: The upgrade process starts automatically following the system 
startup.

4 Follow the instructions, depending on which version of the BIOS is currently 
installed on the target machine.

5 Power down the server after the update process is complete.

6 Remove the BIOS update disk from the drive.

7 Continue with the next procedure to clear the NVRAM and update the flash 
memory.

To clear the NVRAM

1 Power down the server.

2 Move the BIOS recovery jumper from pins 1–2 to pins 2–3.

3 Insert the BIOS recovery disk in drive A.

4 Power up the server.

Result: When the recovery process has run its course, the system displays 
a message to state that the NVRAM has cleared.

5 Power down the server.

6 Remove the disk from drive A.

7 Set the BIOS recovery jumper from pins 2–3 back to pins 1–2.

8 Replace the side cover.

9 Power up the server.

10 Reconfigure the system with SSU.

11 Start up from the hard disk

12 Continue with the next procedure to configure the BIOS.
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To configure the BIOS

1 Power up the server.

Result: The system displays server start-up messages.

2 Press F2 to display the Setup screen.

3 Press BIOS Default (F9) to load the default BIOS settings.

4 Ensure the BIOS settings are set to the following values:

5 Select Save and Exit to save the correct BIOS settings and return to the 
Main Menu.

Setting: Set To:

Main CPU Speed Setting 350 Mhz or 450 Mhz 
depending on CPU 
speed

Advanced Use Multiprocessor Spec 1.4

Server PCI IRQs to I/O APIC Mapping Disabled
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SSU overview

Introduction

The System Setup Utility (SSU) configures computer systems with ISA and 
cards.

Purpose of the SSU

The SSU automates the configuration process for systems, maintains syste
parameters, and stores those parameters in non-volatile RAM. If the SSU is
to assign all system resources, there should be no conflicts between adapt
cards.

When to use the SSU

You must execute the SSU every time ISA or PCI adapter cards are physica
added, removed, or moved in your system. Use SSU when you

� initially set up and configure the system

� encounter a configuration error message at power up

� add or remove system hardware

The SSU operates on information provided by the configuration files, 
configuration registers on PCI cards, and NVRAM in the system memory.

Record the SSU settings 

Record the SSU settings in the system log. If the default values ever need t
restored, you must run the SSU to reconfigure the system.

SSU upgrade floppy disk

The SSU must be run from a bootable floppy disk. This disk must load the 
MS-DOS extended memory driver, as well as a mouse driver.
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To make the SSU disk bootable

1 From the C:\> prompt, type sys a: and press Enter.

2 Type copy C:\dos\himem.sys a:\  and press Enter.

3 Create a config.sys file on the floppy disk to load himem.sys. The config.sys 
file must contain the following line:

device=\himem.sys 
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Configuring your system using SSU

Introduction

To run the SSU, restart your system using the Nortel Networks 702t Meridia
Application Server System Setup Utility disks (Version 3.0). There are three
disks.

To configure the system using SSU

1 Reboot the CallPilot server form the SSU Version 3 Floppy disk.

2 Insert the Floppy disks as requested.

3 The system detects the mouse and keyboard and then boots into the SSU 
banner screen. Confirm that this is version 3.x or greater.

Note: The following descriptions assume that you have a mouse attached. 
If not, you can use the Tab or arrow keys to maneuver around the SSU 
screens. 
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4 Press Enter and the System Setup Utility window appears.

Note: You might have a later version of the SSU. The menus can differ 
slightly, but the steps are the same.

The box on the left describes the Available Tasks and the box on the right 
provides help on the highlighted task. Indented items, under the Available 
Task heading, are configurable. The headings are not.

5 Double-click the Boot Device Task.

Result: A Multiboot Options Add-in menu that defines the the boot devices 
and ordered appears.
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6 You can move the Boot Device Priority item up and down by using the Move 
Up (+), or Move Down (-) buttons. Arrange the Boot device Priority in the 
order Removable Devices, Hard Drive, 8XX SCSI CD-ROM Symbios, ATAPI 
CD-ROM, and LANDesk.

Note: Do not make any adjustments in the Hard Drives window.

7 Save and Close the window.

Note: Do not select the Security window and enter any passwords. You 
might lock yourself out of the server.

8 To add a Resource, double-click the Resource under the Available Tasks 
window.

9 A window pops up asking to restore the configuration from a backup file. 
Click No.

Result: The Resource Configuration Add-in window appears.
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10 To change the IRQ of a PCI card, double-click that card (for example, the 
network card). A submenu appears. Double-click within the IRQ window 
within the PCI board window.

Result: The Change IRQ window appears.

11 Set the IRQ using the pull-down menu, and then press + Add/Change.

Result: You have completed changing the IRQ.
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12 Click OK.

Result: The resource window appears.

13 To add an ISA card (Such as a DSE card,) click Define ISA card. 

Result: The Define ISACard window appears.

14 Enter a description in the Board Name field.

� For TI board, enter T1 ISA Board .

� For DSE board, enter VB2000 Board .

15 Select Connections Device from the Type Pull down arrow.

16 Double-click the IRQ subwindow.

17 Change the IRQ to the appropriate IRQ for the connections device.

The following table shows the Resource List with the IRQs:
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18 Click on Add.Change in the IRQ sub-window.

19 Click Close in the define ISA card window.

20 To end click Close or continue to add cards as are needed.

IRQ Resource

0 Baseboard: System Board Timer

1 Baseboard: System Board Keyboard (might be listed as Chipset)

2 Unused

3 Baseboard: System Board Serial Port 2 (COM 2)

4 Baseboard: System Board Serial Port 1 (COM 1)

5 PCI Card: Bus 00 Dev 0C Reserved for connections cards when 
they are used. Otherwise this is available 
for Ethernet Controller (CLAN).

6 Baseboard: System Board On-Board Floppy Controller

7 Baseboard: System Board Parallel Port (LPT1)

8 Baseboard: System Board RTC (Real Time Clock)

9 Baseboard: System Board ACPI SCI Interrupt

10 PCI Card: Bus 00 Dev 0F Ethernet Controller (ELAN)

11 PCI Card: Bus 00 Dev 0E Available for application

12 Baseboard: System Board PS/2 mouse

13 Baseboard: System Board Math Co-processor

14 Baseboard: System Board On-Board IDE Controller

15 PCI Card: Bus 00 Dev 0D Multifunction Controller - SCSI Controller

15 PCI Card: Bus 00 Dev 0C Multifunction Controller - SCSI Controller

15 PCI Card: Bus 00 Dev 12 Multifunction Controller - USB Controller
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Before you be gin the installation

Introduction

This chapter outlines procedures for installing Windows NT 4.0 software on
server. 

Some of these procedures are necessary only if you must install the base 
software as a failure recovery procedure. 

Requirements

The following is a list of the media and data components you should have be
starting the Windows NT installation.

Disks received with CallPilot

� Windows NT setup disks (3 disks)

� MS-DOS 6.20 setup disks

Disks you must create
You must copy several drivers from the Application Server Driver CD to dis
before starting the Windows NT installation. You will be prompted during th
installation to insert the driver disk when appropriate. 

Refer to “Copying drivers from CD” on page 243 to determine the procedure for
working with the drivers.

CDs

� Application Server Driver CD

Label Contents

NTRH8003 PCI RAID driver Mylex RAID Driver 

NTRH8023 SCSI driver Symbios SCSI Driver

NTRH8013 PCI Ethernet drivers Intel Ethernet NIC Driver
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tor 
� MAS 2.0 Operating System CD

Confi guration information
Use the following table to record data that you need to enter during the 
installation of Windows NT. Consult with the company’s network administra
to obtain the values for the items listed in the table.

Item
Information from com pany’s 
network administrator

Name

Company name

Computer name

Administrative account password

Remote Access

Begin

End

From

To

Excluded

Network - IP address

IP address

Subnet mask

Default gateway

Network - DNS

Host name (= Computer name)
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Domain

DNS Service Search Order

Domain Suffix Search Order

Network - WINS

Primary WINS server

Secondary WINS server

Item
Information from com pany’s 
network administrator
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Copying drivers from CD

Introduction

The network drivers that you need to install during the Windows NT installat
are provided on the Application Server Driver CD that is supplied with your 
CallPilot system. For some drivers to be functional, you must copy the drive
disks and label them accordingly. 

Requirements
� Application Server Driver CD

� blank disks (supplied with CallPilot)

To co py drivers to disk

1 Power up the server.

2 Insert the Application Server Driver CD into the CD-ROM drive. 

Result: The CD starts a DOS session. After a few minutes, the MS-DOS 
6.2 Startup Menu appears.

3 Select the appropriate platform type and press Enter.

Result: The platform menu appears.

4 Select the appropriate option, depending upon the driver you want to copy.

Result: The system responds with the following message: Please 
insert a floppy into drive A. Press any key to 
continue...

5 Insert a disk into the floppy drive and press any key. 

Result: You are asked if you want to format the disk. Press N if the disk is 
blank or Y if the disk contains unwanted data.

If you select Y, DOS performs a quick format of the disk and alerts you 
when the format is complete. 

6 The drivers are then copied to disk. When the copying is complete, the 
following message appears: Diskettes successfully completed .
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Some drivers require more than one disk. After DOS has finished copying 
drivers to Disk 1, it displays the following message: [x] files copied . 
You are prompted to insert a blank disk into drive A. Repeat step 5 for each 
subsequent disk. 

7 Repeat steps 4 to 6 for each driver you want to copy.

8 Nortel Networks recommends that you label the disks with the name 
specified in the “Disks you must create” table on page 240.
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Preparin g the platform

To create the FAT partition

1 Insert MS-DOS Setup Disk 1 in the floppy drive. Power up the system.

Result: The system starts and after approximately 3 minutes displays the 
MS-DOS Setup screen.

2 Press F3, and when prompted, press F3 again.

Result: The A:\> prompt appears.

3 Type fdisk  and press Enter.

Result: The Fixed Disk Setup Program appears.

4 Type 1 (Create DOS Partition) and press Enter.

Result: The Create DOS Partition menu appears.

5 Type 1 (Create Primary DOS Partition) and press Enter.

Result: You are prompted to use the maximum size for the partition.

6 Type N (Do not use maximum partition size) and press Enter.

Result: You are prompted to enter primary partition size.

7 Enter 600 as the partition size for 4095 Mbyte hard drives, or 1024 for 9 
Gbyte hard drives, and press Enter.

Result: A 600 or 1024 Mbyte Primary DOS partition is created.

8 Press Escape to exit.

Result: The main fdisk menu appears.

9 Type 2 (Set active partition) and press Enter.

Result: You are prompted to enter the active partition.

10 Type 1 and press Enter.

Result: The primary partition is set to active.

11 Press Escape to exit.

Result: The main fdisk menu appears.
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12 Press Escape to exit the fdisk program.

Result: You are prompted to restart the system.

13 Press Ctrl + Alt + Delete to restart the system.

Result: The system restarts. Power down the computer to prepare for the 
Windows NT installation.
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Installin g the Windows NT server o peratin g 
system

To install the Windows o peratin g system

1 Insert Windows NT Setup Disk 1 in the floppy drive, and power up the 
server.

Result: The system starts, the disk loads, and after approximately five 
minutes, a prompt appears for Disk 2.

2 Insert Windows NT Setup Disk 2, and press Enter.

Result: Setup loads files from Disk 2. The Windows NT Setup screen 
appears.

3 When prompted, press Enter to begin installation of Windows NT.

Result: On the Windows NT Server Setup screen, Setup prompts you to 
select automatic or manual detection of mass storage controllers.

4 Type S to skip automatic detection of mass storage controllers.

Result: Setup prompts you to select mass storage controllers.

5 Type S to select a controller.

Result: Setup displays a list of controllers.

6 Use the UP arrow key to scroll through the list and highlight 
IDE CD-ROM (ATAPI 1.2) / PCI IDE Controller, and press Enter.

Result: Setup prompts you to insert Windows NT Setup Disk 3 in the floppy 
drive.

7 Insert Disk 3 and press Enter.

Result: The Setup window appears.

8 Type S to select another controller.

Result: Setup displays a list of controllers.

ATTENTION
Before you start, ensure that the server is powered down.
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9 Highlight Other (Requires disk provided by a hardware manufacturer) and 
press Enter.

Result: You are prompted to insert the manufacturer’s support disk. 

Note: You should have created this disk as part of the preparation for 
installation. If you have not created this disk, refer to “Copying drivers from 
CD” on page 243 for instructions on creating the disk.

10 If your system has a RAID controller, insert the NTRH8003 PCI RAID 
driver disk. Otherwise, insert the NTRH8023 Symbios SCSI driver disk. 
Press Enter.

Result: You are prompted to choose the correct driver for the installed 
hardware.

11 Highlight the appropriate driver for the platform and operating system 
version and press Enter.

Result: The driver is loaded from the disk.

12 Press Enter to continue the setup.

Result: Setup prompts you to insert Windows NT Setup Disk 3 in the floppy 
drive.

13 Insert Disk 3 and press Enter.

Result: Setup loads drivers from the disk. 

14 Remove Windows NT Setup Disk 3 from the floppy drive.

15 Press Enter to continue.

Result: The system loads more driver files, then prompts you to insert the 
Windows NT Server CD-ROM into the CD-ROM drive.

16 Insert the CD-ROM labeled “MAS 2.0 Operating System CD” and press 
Enter.

Result: The Windows NT licensing agreement appears.

ATTENTION
On 9-Gbyte hard disk systems, the following message 
might appear: Setup has determined that one of 
your hard disks has more than 1024 
cylinders... . This is not a cause for concern.
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17 Setup requires you to scroll down to the end of the text with the Page Down 
key. Press F8 to agree with the licensing agreement.

Result: Setup displays the list of installed hardware components.

18 Highlight The above list matches my computer, and press Enter.

Result: The Windows NT disk partitioning screen appears.

19 Select C:FAT ... 600/1024MB option. Press Enter.

Result: The system responds with the following message: The 
partition you have chosen is recognized by Windows NT 
but is unformatted or damaged. Setup will have to 
reformat this partition to install Windows NT on it.

20 Type C to continue using the unformatted partition.

Result: The system responds with the following message: You have 
asked to install Windows NT on the partition: “C: 
Unformatted or damaged..600MB or 1028MB .

21 Highlight the Format the partition using FAT file system, and press Enter.

Result: Setup prompts you to choose the location where you want the 
Windows NT files installed.

22 Press Enter to accept the default installation path (\WINNT).

Result: Setup prompts you to perform a comprehensive disk check.

23 Press Enter to perform an exhaustive secondary examination of your hard 
drive.

Result: Setup prompts you to insert a driver disk.

24 If your system has a RAID controller, insert the NTRH8003 PCI RAID 
driver disk. Otherwise, insert the NTRH8023 Symbios SCSI driver disk. 
Press Enter.

Result: Setup copies installation files to the hard disk, and prompts you to 
restart.

25 Remove the MAS 2.0 Operating System CD from the CD-ROM drive, 
remove the SCSI/RAID driver disk from the floppy drive, and press Enter to 
restart the computer.

Result: The system restarts and begins the graphical portion of Windows 
NT setup. After approximately 3 minutes, you are prompted to insert the 
CD-ROM labeled “MAS 2.0 Operating System.”
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To com plete the Windows NT 4.0 setu p

1 Insert the MAS 2.0 Operating System CD in the CD-ROM drive and click 
OK.

Result: Setup copies files to the system, then it prompts you to start the 
Windows NT Setup Wizard.

2 Click Next to continue.

Result: Setup prompts you to enter the customer name and company 
name.

3 Enter the name and company name, and click Next.

Result: Setup prompts you to enter the product ID.

4 Enter the assigned product ID and click Next to continue. The product ID is 
listed on the Certificate of Authenticity that is supplied with your server.

Result: Setup prompts you to choose the Windows NT 4.0 licensing mode.

5 On the licensing mode screen, select Per server, specify 5 as the number 
of concurrent connections, and click Next to continue.

Result: Setup prompts you to enter the computer name.

Note: The customer supplies the computer name.

6 Enter the computer name, and click Next to continue.

Result: Setup prompts you to select the computer’s role.

7 Select the radio button for Stand-Alone Server, and click Next to continue.

Result: Setup prompts you to enter the password for the Administrator 
account.

Note: Passwords are case-sensitive. Ensure that the Caps Lock key on the 
keyboard is not on accidentally.

8 Enter the Administrator account password, and reenter it to confirm it. 

Note: If installing at a customer site, enter the password specified by the 
Network Administrator.

9 Click Next to continue.

Result: Setup prompts you to create an Emergency Repair Disk.
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To create an emer gency repair disk
Because the Setup process installs further changes, if you create the 
emergency repair disk now, you must update the disk at the end of the 
installation process, using the RDisk.exe utility. To skip making a repair disk 
now, continue to step 13. When you are ready to make a repair disk (after 
installation is finished and just before putting the system into service), 
follow the procedure called “Making an emergency repair disk” on page 
289. An emergency repair disk is important for support purposes.

10 Click Yes, create an emergency repair disk (recommended), and click Next 
to continue.

Result: Setup prompts you to select the Windows components to install.

To install Windows com ponents
11 Ensure that the component check boxes are selected as follows:

a. Accessibility Options, Games, Multimedia, and Windows Messaging 
components are unchecked.

b. Check the Accessories component and then click Details. Uncheck all 
subcomponents except for the WordPad component. Click OK when 
done.

c. Check the Communications component and then click Details. 
Uncheck all subcomponents except for the HyperTerminal component. 
Click OK when done.

12 Click Next to install the accessories you have chosen for Windows NT.

Result: Setup prompts you to begin the setup of Windows NT Networking.

13 Click Next to install Windows NT networking.

Result: Setup prompts you to select how Windows NT participates on the 
network.

To confi gure the server for network use
14 Click This computer will participate on a network.

15 Ensure that the component check boxes are selected as follows:

� Wired to the network—Checked

� Remote access to the network—Unchecked
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16 Click Next to continue.

Result: Setup prompts you to install the Internet Information Server.

17 Uncheck the “Install Microsoft Internet Information server” check box and 
click Next.

Result: Setup prompts you to install the network adapters.

18 Click Select from List to select the ELAN network card driver.

Result: Setup displays a list of network adapters.

19 Click Have Disk... to load the ELAN network card driver from the disk in the 
floppy drive.

Result: Setup prompts you to insert the network card driver disk for the 
ELAN card in the floppy drive.

20 Insert the NTRH8013 Ethernet driver disk in the floppy drive and click OK to 
continue. Specify the path if it is other than A:.

Note: You should have created this disk as part of the preparation for 
installation. If you have not created this disk, refer to “Copying drivers from 
CD” on page 243 for instructions on creating the disk.

Result: Setup prompts you to select the appropriate network card driver 
from a list.

21 Click the check box that describes the appropriate installed network 
adapter, and click OK to accept the selection.

Result: Setup returns to the Network Adapter setup screen. The driver you 
loaded from the floppy disk is listed and checked.

22 Click Next to continue.

Result: Setup prompts you to select the network protocols to install.

23 Ensure that the check boxes are selected as follows:

� TCP/IP Protocol: Checked

� NWLink IPX/SPX Compatible Transport: Unchecked

� NetBEUI Protocol: Unchecked 

24 Click Next to continue.

Result: Setup prompts you to select which network services are installed.

25 From the Network Services Installation screen, click Select from List... .

Result: Setup displays a list of network services.
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26 Use the arrow keys to scroll to SNMP Service, then click OK.

Result: You are returned to the Network Services Installation screen.

27 Click Select from List... to add additional network services.

28 Select Microsoft TCP/IP Printing and click OK.

Result: You are returned to the Network Services Installation screen.

29 Click Select from List... to add additional network services.

30 Select Remote Access Service and click OK.

Result: You are returned to the Network Services Installation screen.

31 Click Next to continue.

Result: Setup prompts you to confirm the installation of network 
components.

32 Click Next to install the selected networking components.

Result: Files are copied to the system.

33 Click Next to continue. 

Note: At this point, Setup might prompt you with a dialog box indicating that 
the network card driver was loaded successfully, and you are offered a 
chance to run a diagnostics check. Follow the instructions on the screen to 
perform the test. A setup message might be: A network card of this 
type is already installed in the system, do you want to 
continue?  Click OK to continue. This message appears when both the 
ELAN and CLAN cards are of the same make, model, and manufacturer. 
Click OK to complete the tests, then click OK to continue with the 
installation process.

34 You are given the option to use DHCP to configure the network. Click No to 
indicate that you do not wish to install DHCP.

Result: Setup prompts you to configure the SNMP Service. Because this 
service is added only to provide additional Performance Monitor counters, 
you do not need to configure it.

35 Click OK to accept the default SNMP configuration.

Result: The Add Remote Access Setup Device screen message displays 
the following message: There are no RAS capable devices to 
Add. Do you want RAS setup to invoke the Modem Installer 
to enable you to add a modem?
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36 Click Yes to invoke the modem installer.

Result: The Install New Modem screen appears.

37 Check the box, Don’t detect my modem, I will select it from a list.

38 Click Next.

Result: Manufacturers and models appear in the Install New Modem 
screen.

39 Select US Robotics Inc. from the Manufacturer list.

40 Select Sportster 28800-33600 External from the Model list.

Note: If the manufacturer and model for your modem is not listed, select 
“Standard Modem types” as the Manufacturer and “Standard 28,800 bps 
Modem” as the Model.

41 Click Next on the Install New Modem screen showing manufacturers and 
models.

Result: Setup displays the port selection screen.

42 Click the radio button for Selected ports, click COM1, then click Next.

Result: The Location Information screen appears.

43 Select the customer’s country, area code, and dialing option, then click 
Next.

Result: Setup displays the message Your modem has been setup 
successfully .

Note: The information you enter at this step can be changed later by 
double-clicking the Modems icon in the Control Panel, selecting this 
modem, and then clicking Properties.

44 Click Finish to complete the modem installation.

Result: Setup displays the Add RAS Device screen.

45 Click OK to close the Add RAS Device screen.

Result: Setup displays the Remote Access Setup screen.

ATTENTION
If your modem is not listed and you have the 
manufacturer’s installation disk, click Have disk... and 
follow the instructions on the screen.
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46 Click Configure... .

Result: Setup displays the Configure Port Usage screen.

47 Select the Receive Calls Only radio button, then click OK.

Result: Setup redisplays the Remote Access Setup screen.

48 Click Network... .

Result: The Network configuration screen appears.

49 Ensure that the component check boxes are selected as follows:

Allow remote clients running:

� NetBEUI: Unchecked

� TCP/IP: Checked

� IPX: Unchecked

Encryption settings:

� Require Microsoft encrypted authentication: Checked

� Require data encryption: Unchecked

� Enable multi-link: Unchecked 

50 Click OK to display the RAS Server TCP/IP Configuration dialog box.

51 On the dialog box, make the following selections:

a. Under Allow remote TCP/IP clients to access, select This computer 
only.

b. Select Use static address pool.

Note: For the next two selections, if installing at a customer site, the 
customer must provide these addresses.

c. Enter Begin and End addresses (for example, 192.168.0.40 and 
192.168.0.254)

d. Enter From and To addresses, and enter excluded ranges, if any.

e. Uncheck Allow remote clients to request a predetermined IP address.

52 Click OK to redisplay the Remote Access Setup screen.
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53 Click Continue.

Result: Files are copied to the system. Setup displays the Microsoft 
TCP/IP Properties window and prompts you to enter the TCP/IP 
parameters.

54 Enter the values provided by the customer’s Network Administrator for

� IP Address (for example, 1.1.1.1)

� Subnet Mask (for example, 255.255.255.0)

� Default Gateway

� Primary WINS Server

55 Click OK.

Result: You are returned to the Windows NT Server Setup screen showing 
bindings.

56 Click Next to accept the defaults of the binding order of network services. 
Binding order is optimized later in the installation.

Result: Setup indicates that Windows NT will start the network.

57 Click Next to display the message that Windows NT Setup will start the 
network, and click Next again. 

Result: Windows NT Setup starts the network, and prompts you to enter 
Domain/Workgroup settings.

58 Enter the Domain/Workgroup information.

Note: The customer’s network administrator supplies the name of the 
workgroup.

59 Click Next to add the computer to the workgroup.

Result: Windows NT prepares to complete the setup. 

ATTENTION
This dialog box configures the Domain/Workgroup 
settings for the CallPilot server.

ATTENTION
The computer must not belong to a Windows NT domain.
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60 Click Finish to proceed.

Result: You are prompted for Date / Time configuration settings.

61 Enter the correct date and time, and select the time zone. Check the check 
box to Automatically adjust clock for daylight saving changes.

62  Click Close.

Result: Windows NT Setup detects the installed display adapter.

63 Click OK to accept the display adapter Windows NT has detected.

Result: Setup prompts you to configure the display adapter.

64 Ensure that you select the following values:

� Color Palette: 16 Colors 

� Desktop Area: 640x480

� Font Size: Small Fonts 

� Refresh Frequency: Use default hardware settings

Note: You must test these settings before Windows NT Setup allows you to 
proceed.

65 Click Test to start the test.

Result: Setup prompts you to continue with the test.

66 Click OK to proceed with the display settings test.

Result: A test screen appears. After five seconds, Setup prompts you to 
respond whether you saw the bitmap properly.

67 Click Yes.

Result: Setup prompts you to save the display settings.

68 Click OK to save the display settings and continue.

Result: You are returned to the display settings configuration screen.

69 Click OK to finalize the display settings and continue with Windows NT 
setup.

Result: Files are copied to the system. Windows NT Setup sets security on 
system files, and saves the system configuration. You are then prompted to 
insert a blank disk into the floppy drive in order to create an emergency 
repair disk.
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70 Insert a blank disk and click OK.

Result: The disk is formatted and the configuration files are copied to the 
disk.

71 Remove the CD from the CD-ROM drive, and the disk from the floppy disk 
drive.

72 Click Restart Computer to complete Setup.

Result: Windows NT Setup restarts the server and boots to Windows NT.

What’s next

Now that the basic setup of Windows NT Server 4.0 is complete, you are re
to format additional hard disks/partitions.
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Formattin g additional hard disks/ partitions

Introduction

Perform this procedure if you have more than one hard disk installed on yo
server. This general procedure can be applied to all unformatted disks.

Requirements
� a server powered up, with MS-DOS and Windows NT 4.0 Server instal

The server must be powered up and display the Windows NT logon pro

To format additional hard disks

1 At the logon prompt, press Ctrl + Alt + Delete.

Result: The Windows NT logon box appears.

2 Log on to Windows NT.

3 Click Start > Programs > Administrative Tools (Common) > Disk 
Administrator.

Result: Disk Administrator notifies you that this is the first time it has been 
run.

4 Click OK to acknowledge the message.

Result: The Disk Administrator program might prompt you to accept that it 
will write a signature to each hard disk.

5 Click Yes to each request.

Result: Disk Administrator writes a signature to all disks, and then displays 
the main program screen.

Each SCSI disk (or RAID System Pack) is represented on this screen. 
Each disk has a number (Disk 0, Disk 1, and so on). Note that Disk 0 has 1 
partition: a 600-Mbyte FAT partition for 4-Gbyte hard disks, or a 1-Gbyte 
FAT partition for 9-Gbyte hard disks. The remainder of Disk 0 is free space. 

6 Select the CD-ROM by pointing and clicking.

Result: Disk Administrator highlights the CD-ROM with a thick, black 
border. 
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7 Under the Tools menu, choose Assign Drive Letter... .

Result: An Assign Drive Letter window appears.

8 Ensure Assign Drive Letter is selected and, using the drop-down box, 
change the CD-ROM drive letter from D: to Z:. Click OK. 

Result: Setup prompts you to confirm your changes. 

9 Click Yes to confirm. 

10 Select the free space on Disk 0 by pointing and clicking.

Result: Disk Administrator highlights the free space with a thick, black 
border.

11 Under the Partition menu, choose Create Extended... .

Result: You are prompted for the size of the Extended partition.

12 Accept or enter the maximum size of the partition (the remainder of free 
space for the 4-Gbyte hard disk, or 4096 Mbytes for the 9-Gbyte hard disk), 
and click OK.

Result: The extended partition is created.

13 Click and select the free space on Disk 0.

Result: The free space is highlighted with a thick, black border.

14 Under the Partition menu, choose Create... .

Result: You are prompted for the size of the logical drive.

15 Accept (or enter) the maximum size for the logical drive, and click OK.

Result: The logical drive is created.

16 Under the Partition menu, choose Commit Changes Now... .

Result: Setup prompts you to confirm your changes.

17 Click Yes to commit the changes to disk.

Result: Setup prompts you to update your Emergency Repair Disk.

18 Click OK to continue.

Result: You are returned to the Disk Administrator program screen.

19 Select the newly created partition and, under the Tools menu, choose 
Format... .

Result: Setup prompts you to enter the formatting information.
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20 Ensure the File system is NTFS, and check the box labeled Quick Format. 
Click Start to continue.

Result: Setup prompts you to confirm the format.

21 Click Yes to proceed with the format.

Result: Windows NT formats the disk/partition. A message box appears 
when the format is complete with the format summary information.

22 Click Close after viewing the disk format summary information.

Result: You are returned to the Disk Administrator program screen.

23 Repeat steps 6 to 18 to format the remaining disks (or system packs) in the 
server.

24 After partitioning all the disks, choose Exit under the Partition menu.

What’s next

Install the Windows NT Service Pack 5.
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Installin g WinNT 4.0 Service Pack 5

Introduction

A service pack is an update Microsoft provides for Windows operating syste
Service packs provide new versions of files and fixes for problems that hav
been reported.

The current service pack is Service Pack 5.

Requirements
� CallPilot 1.07 PEP CD-ROM

� a server powered up, with Windows NT 4.0 Server installed

To install the service pack

1 Insert the 1.07 PEP CD in the CD-ROM drive.

2 Click Start > Programs > Windows NT Explorer.

3 Click the plus sign (+) next to the CD-ROM drive to display its 
subdirectories.

4 Select the directory named Service Pack 5.

5 Double-click the folder US-40bit and then double-click the file sp5i386.

Result: The Service Pack Install window appears. 

a. Review the license agreement, and then select the Accept the License 
Agreement check box.

. 

CAUTION

Risk of s ystem crash
Install the service pack only during the operating system 
installation and as part of an upgrade from a 1.0 CallPilot syste
Do not reapply the service pack on an installed CallPilot system
except where specifically instructed to do so in the documentati
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b. Uncheck the Backup files necessary to uninstall this Service Pack 
check box.

c. Click Install.

6 Click Finish to finish installing the service pack.

Result: The program examines the system, selects the files to copy, and 
then copies them. If messages appear, refer to the next step for the action 
to take in response.

7 As the files are installed, the following message might appear: The 
target file exists and is newer than the source. 
Overwrite the newer file? Click No.

When asked if you want to replace a file, always click No.

Result: The service pack is installed.

8 Click Restart.

Result: The computer restarts.

9 After the server is restarted, remove the CallPilot PEP CD.

What’s next

If this is a new installation, install the tape device drivers.

If you installed Service Pack 5 as part of a CallPilot upgrade, continue with 
“Upgrading from 1.0 or 1.06 to 1.07” on page 349.
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Installin g the ta pe device drivers

Introduction

Perform this procedure after installing the Windows NT Server and Service
Pack 5. 

Requirements
� a server powered up, with MS-DOS and Windows NT 4.0 Server instal

� Application Server Driver CD

� a blank disk

Before you be gin

The tape device drivers that you need to install are provided on the Applica
Server Driver CD. For the drivers to be functional, you must copy the driver
disk before starting the installation. 

It is important to review the help.txt file that is supplied on the Application 
Server CD for the directory location of the drivers on the CD.

To co py the drivers to disk

1 Ensure that all system and hidden files are displayed by clicking on the My 
Computer icon, selecting View from the menu bar, and then selecting 
Options.. .

2 In the View tab, select Show all files. 

3 Click OK. 

4 Insert the Application Server Driver CD into the CD-ROM drive. 

5 Insert a blank disk into the floppy drive. 

6 Use Windows Explorer to navigate to the directory on the CD-ROM 
containing the drivers you require. Highlight the contents of the directory.

Note: The directory information is provided in the help.txt file on the 
Application Server CD.
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7 Right-click the highlighted contents and select Send To.. 3 1/2 Floppy (A). 

Result: Driver files are copied onto disk and are ready for use. 

To install the ta pe device driver

1 At the logon prompt, press Ctrl + Alt + Delete to display the Windows NT 
logon box.

2 Log on to the system using the customer’s Administrator ID and password. 
Click OK.

3 Click Start > Settings > Control Panel, and double-click the Tape Devices 
icon.

Result: On the Tape Devices control panel, Windows NT attempts to detect 
the installed tape drive(s). The list of available tape drives appears.

4 If the tape driver is not listed, click Have disk... . 

5 When prompted, insert the driver disk you created in “Before you begin” on 
page 264, into the floppy drive and click OK. Enter the drive letter (for 
example: A:).

Result: You are prompted to select a device driver from the displayed list.

6 Select Seagate tandquic (Tandberg Tape QIC SCSI drives, all), and click 
OK.

Result: You are prompted to install the selected driver.

7 Type OK to install the selected driver.

Result: The driver files are copied to the system and you are prompted to 
restart the computer. Remove the floppy drive before restarting the 
computer.

8 When prompted, insert the MAS 2.0 Operating System CD-ROM and click 
OK.

Result: The files are copied to the system, and the Tape Devices control 
panel appears.

9 Click OK to close the control panel and save the changes.

What’s next

Install video card device drivers if required. 
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Installin g video card device drivers

Introduction

Install the video drivers after Service Pack 5 has been applied to the system
you install pcANYWHERE32.

Note: Currently, Windows NT 4.0 Service Pack 5 uses the default video car
device drivers that are supplied with Windows NT 4.0. Follow this procedur
only if a new video device driver has been issued by Microsoft.

Requirements
� a server powered up, with Windows NT 4.0 and Service Pack 5 installe

� Application Server Driver CD

� a blank disk

Before you be gin

The video card device drivers that you need to install are provided on the 
Application Server Driver CD. For the drivers to be functional, you must cop
the drivers to disk before starting the installation. 

It is important to review the help.txt file that is supplied on the Application 
Server CD for the directory location of the drivers on the CD.

To co py the drivers to disk

1 Ensure that all system and hidden files are displayed by clicking on the My 
Computer icon, selecting View from the menu bar, and then selecting 
Options.. .

2 In the View tab, select Show all files. 

3 Click OK. 

4 Insert the Application Server Driver CD into the CD-ROM drive. 

5 Insert a blank disk into the floppy drive. 
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6 Use Windows Explorer to navigate to the directory on the CD-ROM 
containing the drivers you require. Highlight the contents of the directory.

Note: The directory information is provided in the help.txt file on the 
Application Server CD.

7 Right-click the highlighted contents and select Send To.. 3 1/2 Floppy (A). 

Result: Driver files are copied onto disk and are ready for use. 

To install the video card device driver

1 Press Ctrl + Alt + Delete.

Result: The Windows NT logon box appears.

2 Log on to Windows NT as Administrator.

3 Click Start > Settings > Control Panel.

4 Double-click the Display icon, then click Settings.

5 Click Display Type, then click Change.

6 Select the appropriate device driver for the installed video card and click 
OK to continue.

Result: You are prompted to install the selected driver. If this is the correct 
driver, skip to Step 8.

If the video card driver is not listed, insert the driver disk you created in 
“Before you begin” on page 266 and click Have Disk... .

Result: You are prompted to insert the disk.

7 Insert the Video card device driver disk in the floppy drive, enter the drive 
letter (for example, a:\), and click OK.

Result: You are prompted to select a device driver from the displayed list.

8 Select the most appropriate driver and click OK to continue.

Result: You are prompted to install the selected driver.

9 Click OK to install the selected driver.

Result: You are prompted to insert the MAS 2.0 Operating System CD.
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10 Insert the MAS 2.0 Operating System CD in the CD-ROM drive, and click 
OK.

Result: The driver files are copied to the system. The Display Type control 
panel appears.

11 Click OK to close the control panel and save the changes.

Result: You are returned to the Windows NT Control Panel.

What’s next

Install the RAID Monitoring/Administration utility.
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Install RAID Monitorin g/Administration utilit y

Introduction

If a PCI RAID card was installed, install the monitoring and administration 
utilities for the RAID card under Windows NT.

Installin g the RAID utilit y

1 Insert the DAC960 driver disk in the floppy drive.  

2 Click Start > Programs > Command Prompt.

3 Type the following commands to complete the RAID card configuration. 

Note: Note the path Windows NT 4.00 (c:\winnt\). Make the appropriate 
changes as you execute the steps below:

copy a:\nt\*.* c:\winnt\system32\

Result: The system displays the following message: 7 files(s) 
copied

srvccfg dacmon dac960Monitor c:\winnt\system32\dacmon.exe

Result: The system displays the following message: Service 
Installed successfully

net start dacmon

Result: The system displays the following message: The 
dac960Monitor service is starting. The dac960Monitor 
service was started successfully.

4 After the execution of the last command, a window is launched minimized 
in the TaskBar (NT 4.0).

5 Close the Command Prompt window and remove the floppy disk.

What’s next

Install pcANYWHERE.
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Installin g pcANYWHERE32

Introduction

The process of installing pcANYWHERE32 involves the following procedur

1. Install the pcANYWHERE32 application on the server.

2. Start pcANYWHERE32 for the first time. This procedure allows you to 
the network device. 

3. Set the video mode. This procedure synchronizes the video card settin
with that of the administration client PC to ensure the remote user can 
the server graphical user interfaces properly. 

4. Set the pcANYWHERE32 service to Automatic. This procedure enable
the pcANYWHERE32 service to start automatically after reboot. 

To install pcANYWHERE on the server

1 Log on as administrator.

2 Insert the MAS 2.0 Operating System CD into the CD-ROM drive.

3 Ensure all other Windows applications are closed.

4 Navigate to the Installs\Pca32\Disk1 folder on the CD-ROM drive as 
follows:

a. Double-click Installs.

b. Double-click Pca32.

c. Double-click Disk1.
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d. Locate and double-click the Setup application file.

Result: The Welcome to pcANYWHERE setup program window appears.
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5 Click Next to start the installation.

Result: The User Information window appears.
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6 Enter the user name and company name, then click Next.

Note: Ensure that the name and company are the same as those entered 
during the Windows NT installation.

Result: The Online License Agreement window appears.
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7 Click Yes to accept the software license agreement.

Result: The Choose Destination Location window appears.
274 CallPilot



May  2000 Installing operating system software
8 Click Next to accept the default directory.

Result: The Setup Review screen appears.

9 Click Next to continue.

Result: Program and other files are copied to the system.
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When installation is complete, the Symantec Support Solutions screen 
appears.

10 Click Next to display the How To Reach Us screen.
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11 Click Next to continue.

Result: The Windows 95 Solutions screen appears.
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12 Click Next to continue.

Result: The Registration Wizard screen appears.

13 Click Skip.

Result: You are asked if you want to view the README file now.
278 CallPilot



May  2000 Installing operating system software
14 Click No.

Result: Setup prompts you to restart the computer.

15 Click No, I will restart my computer later, and then click Finish.

Result: pcANYWHERE32 setup terminates.
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To start pcANYWHERE32 for the first time

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

Result: The Smart Setup Wizard window appears, and you are prompted 
for the modem device.
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2 Ensure that the Sportster 28800-33600 External modem is selected, then 
click Next.

Result: The system prompts you to select the network device.

3 Ensure that only TCP/IP is selected, and then click Next.

Result: The system prompts you to select a port.
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4 Ensure that you select COM1, then click Finish.

Result: The pcANYWHERE32 window appears.

To set the video mode

1 From the File menu, select Application Options.

Result: The Application Options dialog box appears.
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2 Click the Host Operation tab.

3 In the Video mode selection drop-down list, select Default—Accelerator 
Enabled, and then click Apply.

4 Click OK to close the window.

Result: The pcANYWHERE32 window appears.

5 To finish the installation, on the pcANYWHERE32 window, click File > Exit.

6 If you performed the installation from the CD-ROM drive, remove the CD 
from the drive.

To perform the pcANYWHERE32 patch installation
Note: The pcANYWHERE32 patches are located on the CallPilot server 
CD in the following directory: platform\default\nortel\data\PCANYW_1

1 Install the 802up_a Patch. From the CallPilot server CD, run 
platform\default\nortel\data\PCANYW_1\802up_a\disk1\setup.exe.

2 Double-click the setup.exe icon. 

Result: The Welcome window appears.
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3 Click Next. 

Result: The Start Copying Files window shows the path for copying files.

4 Click Next. 

Result: Setup copies files to the directories, and then the Setup complete 
window appears.

5 Select No, I will restart my computer later, and then click Finish.

Note: Do not restart the computer.

6 Install the 802up_b Patch. The setup executable can be found on the 
CallPilot server CD in the following directory: 
platform\default\nortel\data\PCANYW_1\802up_b\setup.exe.

7 Double-click setup.exe. 

Result: The Welcome window appears.

8 Click Next. 

Result: The Start Copying Files window appears, showing the path for 
copying files.

9 Click Next. 

Result: Setup copies files to the directories, and then the Setup Complete 
window appears.

10 Select No, I will restart my computer later. 
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11 If you see the following screen, ensure the check box is unchecked, and 
then click Finish. 

12 Restart the computer by clicking Start > Shutdown. Select Restart the 
Computer, and then click OK.

To confi gure pcANYWHERE

1 Click Start > Programs > pcANYWHERE32 > PCAnywhere.

2 Select Be a Host PC.

3 Right-click the Network icon, and then click Properties.

Result: The Network Properties sheet appears.

4 Click the Connection Info tab.

5 Ensure that only TCP/IP is checked.
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6 Click the Settings tab and select the Launch with Window check box. 
Ensure that the settings are as shown in the following example:

7 Click the Callers tab.
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8 Click Specify individual caller privileges, as in the following example:

9 Double-click Add Caller.

Result: The New Caller Wizard window appears.

10 Enter CallPilotDist and click Next.

11 Type CallPilotDist for the logon name.

12 In the Password field, type the new CallPilotDist password.

13 In the Confirm Password field, retype the new CallPilotDist password.

14 Click Next.

15 Click Finish.

Result: The Network Properties sheet appears.

16 Click the Security Options tab and select the check boxes for the following 
entries:

� Log failed connection attempts

� Make passwords case-sensitive

� Deny lower encryption level
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17 Ensure that the settings are as shown in the following example:

18 If you want to assign a password to control who can modify the Network 
icon settings, click the Protect Item tab, then enter a password on this 
screen. 

19 Click OK to apply all pcANYWHERE32 settings.

What’s next

If necessary, make an emergency repair disk. Otherwise, refer to Chapter 8, 
“Installing CallPilot server software,” to install the CallPilot server software. 
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Makin g an emer gency repair disk

Introduction

An emergency repair disk enables you to start the server in the event that 
Windows NT on the server does not start.

It is important that the emergency repair disk be updated on a regular basis 
any maintenance activities are performed on the server or anytime the serv
configuration changes). 

Requirements
� a blank 3.5 inch disk (not supplied with CallPilot). Label this disk 

“Emergency Repair Disk.”

� a server with Windows NT 4.0 and the service pack installed (see “To 
install the service pack” on page 262)

To make an emer gency repair disk

1 Power up the server.

2 Press Ctrl + Alt + Delete to display the logon window.

3 Log on to Windows NT as Administrator.

4 Insert the blank disk in the floppy drive.

5 Click Start, and then click Run.

6 When prompted, type rdisk  and click OK.

7 Click Update Repair Info.

ATTENTION
An emergency repair disk should only be used by suppo
personnel or as requested by support personnel.
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8 Click Yes to continue.

Result: Setup prompts you to create the Repair disk. 

9 Click Yes.

10 Click OK at the prompt.

Result: The disk is formatted and configuration files are copied to the disk 
being created.

11 When complete, remove the disk from the floppy drive.

12 Click Exit on the Repair Disk Utility.

What’s next

Install the CallPilot server software.
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Installin g CallPilot server software

In this cha pter
Section A: Installing the CallPilot server software (for all switch types) 293

Installing the CallPilot server software 294

Section B: Installing Performance Enhancement Packages (PEPs) 301

Installing PEPs 302

Section C: Installing switch connectivity software 311

Installing software for the Lucent, Mitel, and Rolm switch 312

Installing software for the MSL-100/DMS-100 switch 325
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Section A: Installin g the CallPilot server 
software (for all switch t ypes)

In this section
 Installing the CallPilot server software 294
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Installin g the CallPilot server software 

Introduction

This section describes the steps required to install CallPilot software on a 
CallPilot server that is already loaded with the Windows NT 4.0 operating 
system and the device drivers required by CallPilot.

Requirements
� CallPilot 1.07 Server CD

� CallPilot 1.07 PEP CD

� CallPilot 1.07 Language CD

� a server powered up, with Windows NT 4.0, Service Pack 5, and all the
device drivers installed

� current password for the Administrator account (this password was set
during the installation of Windows NT)

Installation procedures

These procedures apply to all switch types.

ATTENTION
During an installation, there are stages during which th
setup program performs automatic installation steps 
between setup windows. Do not close or click on any 
windows that appear during these steps unless you are
prompted. Wait for the next wizard setup window before
you use the mouse or keyboard. 
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To select the platform t ype
This table provides information about each server that will assist you in 
selecting the platform type:

To install the CallPilot server software

1 Insert the CallPilot 1.07 Server CD into the CD-ROM drive and launch 
Windows NT Explorer.

2 Click on the CD-ROM drive, and then double-click Setup to start the 
CallPilot installation. 

Result: The Nortel System Operations window appears.

Prom pts 200i 702t 1001r p

machine class IPE TRP TRP

machine type IPE Tower Rack

platform series 200 702 1001

backplane type Active Active Passive
Part 5: 702t Server Maintenance and Diagnostics 295



Installing CallPilot server software Standard 1.0
3 Click Next. 

Result: You are asked to confirm the installation of CallPilot files onto your 
PC. 

4 Click Yes.

Result: You are prompted to start the platform setting procedure. 

5 If the server is a 200i, 702t, or a 1001rp, click Yes to perform the platform 
setup from CD.

Result: The Platform Type Information Test Application window appears.
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6 Type 1 to set the platform type and press Enter.

Result: The system prompts you to identify the machine class.

7 Type 1 for the 702t or the 1001rp.

Type 2 for the 200i.

Result: The system prompts you to identify the machine type.

8 Type 1 for the 702t.

Type 2 for the 1001rp.

Type 3 for the 200i.

Result: The system prompts you to identify the platform series.
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9 Type the number that identifies your server’s model number. Press Enter.

Result: The Select the backplane type prompt appears.

10 Type 1 for the 200i or the 702t.

Type 2 for the 1001rp.

Result: The Nortel System Operations window appears.

11 If the settings are correct, click Yes to initiate the installation. Otherwise, 
click No to rerun the platform setting procedure.

12 The installation setup process runs automatically (taking 15 to 30 minutes). 
A series of messages appear to indicate the items that are being installed 
(for example, backup/restore, MMFS). 

Result: When installation is complete, the following prompt window 
appears:

13 Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.
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What’s next

Install any required PEPs. 
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Section B: Installin g Performance 
Enhancement Packa ges 
(PEPs)

In this section
 Installing PEPs 302
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Installin g PEPs

Introduction

For an initial installation of CallPilot, the Performance Enhancement Packa
(PEPs) are provided on a CD.

If you are using this procedure for a CallPilot system that is up and running, 
PEPs are issued on the NIC web site: 

http://www.nortelnetworks.com/prd/nic

You require a password to access this site.

Identif ying the PEPs

PEPs are labeled on the CD in the following format:

NMxxyyzzPwwwQ

. 

CAUTION

Risk of s ystem problems
For specific PEP installation instructions, refer to the readm
files that are in the PEP CD root directory and in the folde
for each PEP package. In many cases, PEPs must be 
uninstalled and installed in a specific order. The readme fi
provide these instructions. When the readme files instruc
you to uninstall or install PEPs, refer to the procedures in
this section.

ATTENTION
If your CallPilot system is up and running, Nortel Network
recommends that you perform a system backup before yo
install a new PEP. 

See Monitoring and Security for the Administrator for more 
information on performing a backup.
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Readme files

Readme files are provided in the following locations on the PEP CD:

� Root directory on the PEP CD

This readme file provides a general description of the PEP packages a
general PEP install and uninstall instructions.

� In each PEP package folder

These readme files provide a list of all the PEPs in that package, and 
specific PEP install and uninstall instructions.

� In each PEP folder

These readme files describe the purpose of that PEP and might provid
some PEP installation instruction.

To install a PEP package

1 Ensure that you are logged on to the server where you are going to begin 
PEP installation. Use a logon account that has administrative privileges (for 
example, administrator).

2 Insert the CallPilot 1.07 PEP CD. 

3 Read the readme files that are in the PEP CD root directory and in the 
folder for each PEP package for specific uninstallation and installation 
instructions.

xxyyzz is the release level (for example, 
010707)

P can be “R” for a restricted PEP, “D” 
for a diagnostic PEP, or “G” for a 
general PEP

www PEP number for the release. Range is 
from 001 to 999

Q indicates platform type (for example, 
“S” denotes a PEP for the server)
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4 Double-click runme.exe.

Result: Setup examines the system, and the PEP’s to install window 
appears.

Note: The following example is for illustration purposes only, and might not 
reflect what appears on your system.

ATTENTION
It can take 5 to 20 minutes for the PEPs to install window 
to appear, depending on the number of PEPs and the 
system configuration. In the meantime, a gray box might 
appear while the window is loading. Do not use the 
mouse or keyboard during this time
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5 Select the PEPs to install, then click Next. If you are uncertain about which 
PEPs to install, refer to the Readme file located in the root directory of the 
CD.

Result: The Nortel System Operations window appears and lists all 
components in the order in which they will be installed. 
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6 Click Yes to continue.

Result: The system automatically shuts down all services and the PEPs 
are installed. A summary of the installation appears, showing the success 
or failure of each PEP operation.

Note: CallPilot automatically removes obsolete PEPs when you install new 
PEPs.

7 Click Yes to complete the procedure.

Result: The program ends.

8 Repeat this procedure for other PEP packages. A reboot is required after 
installing PEPs.

To uninstall a PEP package

CallPilot automatically removes obsolete PEPs when you install new PEPs
However, there can be times when you want to uninstall a PEP yourself. 

Use the DMI Viewer on the server to view or uninstall server PEPs. Access
DMI Viewer by clicking Start > Programs > CallPilot > System Utilities > PE
Maintenance Utility.

To uninstall PEPs on the server, follow these steps.
306 CallPilot



May  2000 Installing CallPilot server software
1 Log on to the server where you are going to begin the PEP uninstall. Use a 
logon account that has administrative privileges (for example, 
administrator).

2 Open the PEP Maintenance utility.

Result: The DMI Viewer window appears. The following example might not 
reflect exactly what appears on your system.

3 To view a list of all PEPs, click Show PEPs.

Result: A list of all PEPs appears.
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4 Select the PEP you want to uninstall. You can select multiple PEPs to 
uninstall in one operation by using the Ctrl key. The prefix PEP identifies 
PEPs.

5 Click Remove.

Result: The system prompts you to confirm this choice.

6 Click Yes.

Result: The system automatically shuts down all services and uninstalls 
the selected PEPs. When the uninstall is finished, the system automatically 
restarts all services.

Note: After you uninstall a PEP, the PEP is still visible in the list of 
components until you restart DMI Viewer.

7 When you are finished, close the DMI Viewer window.

What’s next

If you are installing software for recovery purposes, install switch connectiv
software. Go to the section for your switch as shown in the table below.
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ure 
If you are upgrading CallPilot server software, return to the upgrade proced
described in “Upgrading from 1.0 or 1.06 to 1.07” on page 349.

Switch Refer to

Meridian 1 Part 3, Chapter 6, “Configuring the 
server software—common dialog 
boxes for all switch types”

MSL-100 or DMS-100 “Installing software for the MSL-100/
DMS-100 switch” on page 325

Lucent, Mitel, or Rolm “Installing software for the Lucent, 
Mitel, and Rolm switch” on page 312

Matra Part 3, Chapter 6, “Configuring the 
server software—common dialog 
boxes for all switch types”
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Section C: Installin g switch connectivit y 
software

In this section
 Installing software for the Lucent, Mitel, and Rolm switch 312

 Installing software for the MSL-100/DMS-100 switch 325
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Installin g software for the Lucent, Mitel, and 
Rolm switch

Introduction

Follow these procedures to install and configure connectivity software for th
Lucent, Mitel, and Rolm switches.

Note: If you are working on a 702t platform, check your system to make sur
IRQ 5 is available for the VTG board. Otherwise you need to reconfigure yo
hardware to make IRQ available for the VTG board. 

To check the IRQ, click Start > Programs > Administrative Tools > Windows
NT Diagnostics. Select the Resources tab and confirm that IRQ 5 is not use
any device other than Dialogic.

To install VoiceBrid ge software

1 Insert the CallPilot 1.07 PEP CD into the CD-ROM drive and launch 
Windows NT Explorer.

2 Click the CD-ROM drive and navigate to the vtg directory. 
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3 Double-click setup to start the installation.

Result: The Welcome window appears.
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4 Click Next to display the Release Notes window. Review these notes for the 
most current information on the release.

5 Click Next to display the Choose Destination Location window.
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6 Change the VoiceBridge software destination folder:

a. Click Browse... to display the Choose Folder dialog box. 

b. Change the destination folder to d:\vbpc by typing the pathname in the 
Path field.

c. Click OK.

d. On the Setup window, click Yes to confirm the change.

Result: The Choose Destination Location window appears.
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7 Click Next to display the Select Program Folder window. Accept the default 
program folder name.

8 Click Next to display the Select Documentation Option window.

9 Select Install Documentation.
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10 Click Next to display the Select Components window.

11 Select Microsoft Telephony API (TAPI).

12 Click Next to display the PBX selection window.
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13 When Setup prompts you to select the switch type

� for Rolm, select Siemens Rolm

� for M1-DSE, select Nortel Meridian 1

� for Mitel, select Mitel

� for Lucent 2-wire, select Lucent-8400

Note: Lucent-7400 is not supported.

14 Click Next to display the Select the IRQ window.

Note: 

� Make sure the IRQ 5 is available for the VTG board and is not used by
other device. Otherwise, you must reconfigure your hardware to make 
5 available for the VTG board. 

To check the IRQ, click Start > Programs > Administrative Tools > 
Windows NT Diagnostics. Select the Resources tab and confirm that IR
is not used by any device other than Dialogic.

15 Select IRQ 5.
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16 Click Next to display the Select the Voice Bus window.

17 Select the SCbus: VoiceBridge 2000 with other SCbus compatible cards 
option.
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18 Click Next to display the Startup Mode selection window.

19 Select Automatic startup mode for VBPC load.

20 Click Next to display the Setup finish window. 
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21 Review the Current Settings list. Click Back to redisplay any window on 
which you want to make changes, or click Next to continue.
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22 The Setup process displays a pop-up window that asks about Dialogic 
Installation. Click No.

Result: The Setup Complete window appears.

23 Uncheck Launch Configuration Manager, and click Finish.

To run VTG confi guration
24 After VTG software installation is finished, from the d:\nortel\bin directory, 

double-click vtgconfiguration.exe.
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25 In the VTG Boards area, click VB1 to highlight it. Click Delete to remove it.

26 Click Add to display the Add Board dialog box.

27 Enter the serial number of the VTG board, and then click OK.

Note: If there are multiple VTG boards, it is important that you enter the 
serial numbers according to the location of the ISA slots. Refer to Chapter 
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6, “Performing hardware maintenance” for more information on the location 
of the ISA slots. 

28 Continue adding boards one by one. 

29 After all VTG boards are added, click OK to close the VTG configuration.

30 Restart the server.

What’s next

Run the Configuration Wizard by selecting Start > Programs > CallPilot > 
Configuration Wizard.

Refer to Part 3, Chapter 6, “Configuring the server software—common dialo
boxes for all switch types” for more information on running the Configuratio
Wizard.

ATTENTION
You can find the VTG board serial number on a sticker on 
the backplate of the switch.
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Installin g software for the MSL-100/DMS-100 
switch

Introduction

Follow these procedures to install and configure software for the MSL-100/
DMS-100 switch.

Requirements
� CallPilot 1.07 PEP CD

To install Dialo gic software

1 Insert the CallPilot 1.07 PEP CD into the CD-ROM drive and launch 
Windows NT Explorer. 

2 Click the CD-ROM drive and navigate to the dialogic\dna3.1 directory. 

3 Double-click Setup to start the Dialogic software installation.

Result: Dialogic setup initializes the system to install the Dialogic software.
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4 The system displays the Welcome to Dialogic Setup window.

5 Click Next to display the Registration Window.
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6 Enter the User name and Company name, and click Next to display the 
Setup Options window.

Note: Use the User name and Company name you entered during the 
installation of Windows NT. 

7 Select the Custom option, and click Next to display the Custom Component 
Selection panel.
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8 Select the Drivers, Firmware and Configuration Files option. Click Next to 
display the Destination Location panel.

9 Click Browse to create a directory where the setup process will copy files. 

Result: The Choose Directory dialog box appears.
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10 In the Path box, enter d:\Program Files\Dialogic. Click OK.

Result: You are asked if you want to create the directory.

11 Click Yes.

Result: The Destination Location panel redisplays, showing the new 
directory.
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12 Click Next to display the Program Group Folder panel.

13 Click Next to accept the default values and to display the Setup Options 
Summary panel.
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14 Click the Current Settings or Back to make changes.

15 Click Next to begin installation.

Result: The copying status window appears.

Once the files are copied, the Dialogic Setup Finish Options panel appears.

16 Deselect the View Release Notes item. Select the Run Dialogic Board 
Configuration (DCM) item.

17 Click Finish.
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Result: You are asked if you would like to install GammaLink fax.

18 Click No.

Result: The Reboot Windows dialog box appears.
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19 Click No, I will restart my computer later.

Result: An information window appears showing setup is complete.

To confi gure Dialo gic software
20 Click OK to configure the Dialogic software.

Result: The Dialogic Configuration Manager window appears.

21 From the Dialog Configuration Manager menu, select Action > Configure 
Device to configure the Dialogic board.
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Result: The Dialogic Configuration Manager - Properties for All devices 
window appears.

22 Select the Telephony Bus tab. Highlight the parameter 
SCbusClockMasterSource, and edit it to have the Independent value.
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23 Select the Misc tab. Highlight ParameterFile, and edit it to have the 
spandti.prm value.
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24 Click OK to apply these changes and close the window.

Click Cancel to exit the window without applying the changes.

Click Apply to apply the changes without closing the window. You might 
select another tab to make changes. 

Result: You are returned to the Dialogic Configuration Manager window.

25 Change the startup mode to automatic by selecting Service > Startup Mode 
> Automatic.
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Result: The Start Service menu option activates.
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26 Select the Start Service menu option.

Result: The Dialogic System Service pop-up window appears.

27 Click OK to close the pop-up window.

28 Click File > Exit to exit the Dialogic Configuration Manager.

29 Remove the PEP CD from the CD-ROM drive.

30 Start to configure CallPilot by running the Configuration Wizard.

What’s next

Run the Configuration Wizard by clicking Start > Programs > CallPilot > 
Configuration Wizard.

For more information on running the Configuration Wizard, refer to Part 3, 
Chapter 6, “Configuring the server software—common dialog boxes for all 
switch types”.
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Pre-upgrade checklist 340
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Pre-upgrade checklist

Introduction

This section provides an upgrade readiness checklist that should be perform
before attempting the upgrade at the customer site. This enables you to

� avoid significant lost time and costs 

� significantly reduce system downtime resulting from upgrade problems 
might have been prevented.

A summary of the upgrade readiness checks includes the following steps:

� Ensure dial-up networking can be established with the CallPilot server.

� Ensure a pcANYWHERE32 session can be established with the CallPi
server.

� Ensure the MMFS is less than 90 percent full.

� Check if the customer has recorded customized prompts.

� Check Meridian 1 for required software, feature packages, and patches

� Check system information, such as keycode and serial number.

� Check for “critical” PEPs that have been issued since the release of the
1.07 build.

If one of these readiness checks fails, the failure should be corrected befor
attempting the upgrade again. Details of the readiness checks follow.

To ensure a dial-u p networkin g session can be established with 
CallPilot 

If the PC is not on an IP network connected to the CallPilot server, establis
connection using Dial-Up Networking.

1 Click Start > Programs > Accessories > Dial-Up Networking.

2 Double-click the MAS icon.
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If the icon is unavailable, create a MAS connection profile. See “Creating 
the MAS connection profile” on page 470 of the CallPilot 1.0 Maintenance 
and Diagnostics Guide.

3 When prompted, enter the Windows NT logon ID and password.

4 Wait until the connection is established.

To ensure a pcANYWHERE32 session can be established with 
CallPilot 

If pcANYWHERE32 is not functioning prior to the upgrade, the upgrade will
not change this. If the upgrade is performed and a problem occurs, remote 
support access is not possible.

Do not attempt an upgrade to 1.07 until pcANYWHERE32 is functioning.

Given a dial-up networking session has been established, establish a 
pcANYWHERE32 connection to the CallPilot server:

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

2 Double-click the remote control icon for the server.

3 If the icon is unavailable, create a server connection profile. See “To create 
a remote control connection icon” on page 470 of the CallPilot 1.0 
Maintenance and Diagnostics Guide.

4 When prompted, enter the pcANYWHERE32 logon ID and password.

If a pcANYWHERE32 session can not be established, open a ticket with No
Networks CTS. You require pcANYWHERE32 access for remote support.

Ensure MMFS volume on Disk 1 is less than 90 percent full

Use the administrative client to check that the MMFS volume on Disk 1 (dri
D) is less than 90 percent full. Do not proceed with the upgrade if the MMF
volume on Disk 1 (drive D) is greater than 90 percent full. 

If the MMFS volume is greater than 90 percent full, then the upgrade of the
system to the latest release of the voice prompts might fail.

To find out how much space is used on each volume, perform the following
steps:
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1 On the Administrative client, select SMI > System Administration > System 
Performance Monitoring. Double-click “Reporter Download Schedule.”

Result: The system displays the “Select the drive for the local OM 
database” dialog box.

2 Click OK to continue.

3 From the Reporter Download Schedule window, press Download Now. 

Note: If Nortel Communicator is not running, you are prompted to start the 
Communicator. Click Yes to continue. 

4 Select an interval for the OM collection period and click OK. A smaller 
interval downloads more quickly. 

Result: The system downloads the Operational Measurements data from 
the server to the client PC.

5 When the OM download is complete, click Save.

6 To run the system reports, select Start > Programs > MAS Reporter > 
Reports. The default password for Reporter is “password.” You might need 
to change the password if you have not already done so. 

7 Select your system name > Reports. Double-click the System folder and 
double-click Multimedia File System Usage Monitor Report.

8 Specify an interval.

9 Click OK.

Result: A report appears that shows the amount of text and voice space 
used for each of the volumes on the system.

10 Exit Reporter.

Check if custom prom pts have been recorded

Use the administrative client to check if custom prompts have been recorde

View the prompts in the System Prompts Customization main window by 
selecting one of the following paths.

For 1.0 s ystems
Nortel SMI > Meridian Application Server > CallPilot > System Prompts 
Customization.
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For 1.06 s ystems
Nortel SMI > Meridian Application Server > Messaging > System Prompts 
Customization.

If one or more prompts are custom, then archive the custom prompts by 
selecting one of the following paths:

For 1.0 s ystems
Nortel SMI > Meridian Application Server > CallPilot > Archive & Restore >
Archive Manager

For 1.06 s ystems
Nortel SMI > Meridian Application Server > Messaging > Archive & Restore
Archive Manager

After the upgrade to 1.07, the custom prompts can be restored on the syste
from the archived copy.

Ensure the Meridian 1 switch has re quired patches 

Check the Meridian 1 patches against the requirements stated in Part 3, Ch
3. If the required patches are not present on the Meridian 1, do not proceed
an upgrade until the Meridian 1 switch is ready. Without the required patche
the Meridian 1, ring-no-answer and other issues can result.

Checkin g system information

To locate information about your system that you might need for the upgrad
click Start > Programs > CallPilot 1.0 (or 1.06) Server > CallPilot System 
Information. Ensure that the

� Security Device ID (Sec. Dev. ID) on the 1.07 keycode label matches t
CallPilot serial number that appears on the CallPilot System Informatio
dialog box. If these two items do not match, your Nortel Networks 
customer support representative must generate a new keycode so you
upgrade your system.

� Feature limits displayed on the 1.07 keycode label are greater than or e
to the feature limits displayed on the CallPilot System Information dialo
box. 
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Features cannot be reduced. For example, if you currently have three v
prompt languages installed on your system, you cannot reduce the num
of languages to two. 

Check for critical PEPs that have been issued since 1.07 was released

Check the NIC web site at http://www.nortelnetworks.com/prd/nic (Products
CallPilot) for any additional PEPs that might have been made available sinc
manufacture of the PEP CD. If critical PEPs are available, apply them 
immediately after installing the PEPs from the PEP CD.

Note: The NIC web site is a secure site and requires a user name and a pas
to log on. If you do not currently have an account, you must apply for one p
to entry. Be advised it might take three to five business days for your accou
request to be processed.
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Preparin g for the u pgrade

Introduction

Use the procedures in this section to upgrade to a new release of CallPilot 
software. To upgrade you must replace the CallPilot software with a higher 
numbered release. 

You can upgrade

� from a previous release (1.0 or 1.06)

� from a previous release (1.0 or 1.06) after performing an expansion

� from a previous release (1.0 or 1.06) at the same time as performing a
expansion

Note: You cannot downgrade to a previous version of CallPilot software.

Timin g

The upgrade process takes approximately 60 minutes.

Requirements
� a 1.07 keycode

� CallPilot 1.07 Server CD

� CallPilot 1.07 PEP CD

� CallPilot 1.07 Language CD

� a copy of the latest General Release Bulletin (GRB). It is important that 
review this document for special instructions before starting the upgrad

� a CallPilot mailbox, a phoneset, and the phone number of the custome
IVF Messaging application to check that CallPilot is operational after th
upgrade

� if the customer has the fax or speech recognition options, a fax machine
the phone numbers for Express Fax Messaging and/or Speech Activat
Messaging
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Upgrade checklist

Before you be gin

Check that all services starting with the prefix MAS and CallPilot (MCE) are
and running before starting the upgrade. 

To start services

1 Click Start > Settings > Control Panel > Services.

2 Select the MAS and CallPilot (MCE) services that have not been started.

3 Check that the startup states are set to Automatic.

4 Click OK to confirm.

5 Exit the Services application.

Step ✔

Review the pre-upgrade checklist on page 340.

Disable all DSP and DS30 channels. Refer to “To disable all 
DSP and DS30 channels from the Administrative PC” on page 
347 for more information on performing this step.

Have on hand a 1.07 keycode and serial number. Check that the 
keycode and serial number are valid by following the steps listed 
in “Checking system information” on page 343.

Obtain the current password for the Administrator or NGenSys 
account. 

If you are unfamiliar with these passwords, contact the 
company’s network administrator. 

Start services. See “To start services” below for more 
information.

Perform a full backup. 

See Monitoring and Security for the Administrator.
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To disable all DSP and DS30 channels from the Administrative PC
Before upgrading the server, disable the DSP and DS30 channels and then
down the Administrative PC. 

1 From the Administrative PC, click Start > Programs > CallPilot 
Administration Client.

Result: An Explorer window appears.

2 Click your server icon.

Result: The SMI Login screen appears.

3 Enter your user ID and password, and then click OK.

4 From the Administration Menu, select System Administration > 
Maintenance Administration.

5 Double-click the Channel Monitor option.

Result: The DS30 channels appear. 

6 Highlight the channel by clicking the DS30 channel entry.

7 From the File menu, select Courtesy Stop.

Result: The highlighted DS30 channel changes to off-duty status and 
becomes disabled.

8 Double-click the Multimedia Monitor option.

Result: The DSP channels appear.

9 Highlight the channel by clicking the DSP channel entry. 

10 From the File menu, select Courtesy Stop.

Result: The highlighted DSP channel changes to off-duty status and 
become disabled.

11 After disabling all DSP channels, dial in to CallPilot to test that the lines are 
disabled. You should receive a busy signal.

12 Shut down the Administrative PC.

If you u pgrade from a networked CD
If you perform an upgrade from a networked CD, the machine that serves th
CD must have Windows NT 4.0 (Server or Workstation) and be accessible 
the LAN.
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To reassi gn the drives
If the CD-ROM is mapped as drive E:, you need to reassign the drives. 

1 Click Start > Programs > Administrative Tools (Common) > Disk 
Administrator.

2 Select the CD-ROM drive. 

3 On the Tools menu, select Assign Drive Letter.

4 Click the option button for Assign Drive Letter and select Z: from the drop-
down list.

5 Click OK.

Result: Setup prompts you to confirm the change.

6 Click Yes to confirm. The new drive assignment occurs immediately. 

7 Select the second hard drive (currently drive F:) and change its drive to E:. 

To prepare a keycode file
You require a new keycode to upgrade your CallPilot system. This keycode
should be different than the keycode supplied with your initial CallPilot syste

You can either manually enter the keycode or read it from a file. 

1 Open a document in a text-editing application (such as Notepad). The 
keycode is supplied by Nortel Networks, and consists of 7 sets of 4 
alphanumeric characters.

2 Type the keycode into the file, placing a space between each set of 
characters.

3 Save the file as a *.kc document.
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Upgradin g from 1.0 or 1.06 to 1.07

To upgrade to a newer release

1 Log on to the server using an account with local administrative privileges 
(for example, Administrator or NGenSys).

2 Close all applications except for pcANYWHERE32, acdproxy, Sybase, and 
the MASTraceWindow.

3 Disable all DSP and DS30 channels using the administrative PC. Refer to 
“To disable all DSP and DS30 channels from the Administrative PC” on 
page 347 for instructions on how to stop these channels.

4 If you are upgrading from 1.0, install Service Pack 5 before starting the 
upgrade. Refer to “Installing WinNT 4.0 Service Pack 5” on page 262. 

5 Insert the 1.07 Server CD in the CD drive.

6 From the Windows taskbar, click Start > Run.

7 Click Browse.

Result: A Browse window appears.

8 Select the CD-ROM drive and double-click setup.exe.

9 Click OK from the Run window.

Result: The Nortel System Operation window appears. 
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10 Click Next to continue with upgrade.

Result: Setup examines the system and then prompts you to confirm the 
upgrade.

11 Click Yes to start the upgrade. 

Result: The Keycode and Serial Number window appears.
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12 Enter the new 1.07 keycode, and then click Next. 

Result: The Features Verification window appears.

13 Click Next. 

Result: Setup automatically uninstalls previous PEPs as part of the 
upgrade procedure. After all PEPs have been uninstalled, a dialog box 
appears showing the PEPs that have been uninstalled. 
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14 Click OK to continue. 

Result: You are prompted to confirm the platform settings for your system. 
If the settings are correct, click Yes. Otherwise, click No. 

15 The upgrade process runs automatically. A series of messages appear, to 
indicate the items that are being updated (for example, backup/restore, 
MMFS). 

16 After the upgrade is complete, setup prompts you to install PEPs.

17 Click Yes to continue. Remove the Server CD and insert the PEP CD.

Refer to “Installing PEPs” on page 302 for more information on installing 
PEPs.

18 After all the PEPs are installed, restart the server. 

19 After the server restart, run the Configuration Wizard by clicking Start > 
Programs > CallPilot > Configuration Wizard.

To run the Confi guration Wizard
20 Leave all current values in the Configuration Wizard dialog boxes as they 

are until you reach the Keycode and Serial Number dialog box shown here.
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21 Enter the serial number you received with the CallPilot keycode in the 
Serial Number box. This number should match the prefilled Serial Number 
from dongle box.

If the serial number contains letters, use lowercase.

Note: The Serial Number from dongle box is prefilled with data read from 
the software feature key.

22 The keycode is prefilled with the value entered in step 12. Verify that the 
keycode is correct.

23 Click Next through the remaining Configuration Wizard dialog boxes until 
the following dialog box.
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24 Remove the PEP CD and insert the CallPilot 1.07 Language CD.

25 Select Install Language.

26 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files 
on the CD. For example, if the CD-ROM is drive Z:, select Z:.
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27 Click Next.

Result: The following dialog box appears, which lists all currently installed 
languages:

28 Select the language you want to upgrade and click Next. 

Result: The Add Prompt Language dialog box appears.

29 To add a language, select the prompt language check box. Click Next.

Result: The Primary and Secondary Languages dialog box appears.

30 Click Next to accept the currently assigned primary and secondary 
languages.

Result: The Speech Recognition Languages dialog box appears.

31 Click Next to skip this dialog box.

Result: The language installation dialog boxes are completed.

32 Click Next through the remaining Configuration Wizard dialog boxes until 
the Ready to Configure dialog box appears.
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33 Select Apply the current configuration, and click Next.

Result: The configuration changes are applied to the server. This is 
followed by a prompt to restart to CallPilot. 

Note: The configuration changes take approximately 10 minutes, plus an 
additional 10 minutes for each language you are upgrading. 

34 Click Finish, and then click Cancel to bypass the restart. 

To enable the DSP channels
35 From the Administrative PC, click Start > Programs > CallPilot 

Administration Client.

Result: An Explorer window appears.

36 Click your server icon.

Result: The SMI Login screen appears.

37 Enter your user ID and password, and then click OK.

38 From the Administration Menu, double-click Multimedia Monitor.

Result: The DSP channels appear.

39 If the DSP channels are not enabled, skip to step 40. Otherwise, skip to 
step 42 to check the DS30 channels. 

40 Highlight the channel by clicking the DSP channel entry. 

41 From the File menu, select Start Channels.

Result: The highlighted DSP channel changes to online status and 
becomes enabled.

42 Double-click the Channel Monitor option.

Result: The DS30 channels appear. 

43 If the DS30 channels are not enabled, then skip to step 44. Otherwise, skip 
to step 46 to test the system. 

44 Highlight the channel by clicking the DS30 channel entry.

45 From the File menu, select Start Channels.

Result: The highlighted DS30 channel changes to online status and 
becomes enabled.
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46 After disabling all DSP channels, dial in to CallPilot to test that the lines are 
enabled. You should receive a prompt.

What’s next

Test that CallPilot can receive calls by following the procedures in Part 3, 
Chapter 11, “Verifying that CallPilot can receive calls”.
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Expandin g CallPilot features

In this cha pter 
 Expanding features 360
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Expandin g features 

Introduction

This chapter summarizes how you add features to CallPilot.

CallPilot supports feature reduction only for those channels that have been
previously allocated.

Expansions

The following types of features can be expanded:

� channels 

� languages

� number of networking sites

� number of MPUs

� availability of features such as AppBuilderFax and Networking

To add features 

1 If you are increasing system capacity, install any additional hardware that 
was shipped to you (for example, additional cards or boards). Refer to the 
hardware maintenance section of this Installation binder for installation 
instructions.

2 Install the software feature key adapter if a new one was shipped to you. 
Refer to Part 2 of this Installation binder for instructions.

3 Have your new keycode and serial number available. When you purchase 
additional features or system capacity, you receive a new keycode and 
serial number.

4 Run the Configuration Wizard (refer to Part 3, Chapter 6, “Configuring the 
server software—common dialog boxes for all switch types”). In the 
Configuration Wizard, ensure you do the following steps:

a. Enter the new keycode and serial number. 
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b. Allocate new channels (if you have added channels).

5 Configure additional channels on the switch and in the Configuration 
Wizard.

ATTENTION
New channels are not automatically allocated. They 
must be manually allocated using the Configuration 
Wizard. 
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Uninstallin g CallPilot server software

In this cha pter
 Uninstall procedures 364
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Uninstall procedures

Introduction

This section provides instructions to help you uninstall the CallPilot server 
software.

Uninstallation of CallPilot removes the software completely from the server.
also removes all CallPilot registry entries, linguistic information, and all links
CallPilot from the server database.

What is removed durin g uninstallation of CallPilot 

Uninstallation of CallPilot software removes the following items:

� CallPilot entries in the Windows NT Registry 

� all CallPilot entries in the server database

� CallPilot files

Before you be gin

Obtain the current password for the Administrator account.

Switch-related procedures

Note that the uninstall procedure varies depending upon the switch connec
installed at the customer site. 

ATTENTION
Once you start the uninstallation process, you cannot 
restore CallPilot if you decide to cancel the process. Yo
must perform a new installation to load CallPilot onto th
server. 
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To uninstall Meridian 1 

See “To uninstall CallPilot server software” on page 367 for instructions on how 
to uninstall Meridian 1 software.

To uninstall Lucent, Mitel, Rolm

1 Uninstall CallPilot by clicking Start > Programs > CallPilot > Uninstall.

Result: You are prompted to confirm the uninstallation.

2 Click Yes to uninstall CallPilot.

Result: The uninstall process runs automatically. During this process, the 
following window appears:

3 After the CallPilot uninstall is complete, the following window appears:
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4 Click No to bypass the server restart.

5 Shut down services by clicking Start > Settings > Control Panel. Double-
click Services, and stop the following services in the given order:

� Notification Service

� CallPilot SLEE Service

� EMCI

� Remote Access Server

� Telephony Service

� vbpcload

6 To uninstall the VTG software, click Start > Programs > VoiceBridge 2000 > 
Uninstall.

7 Click Yes to confirm uninstall.

8 Click No to All to keep shared files.

9 When the uninstall is complete, shut down Windows NT and restart the 
server. 
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To uninstall DMS-100/MSL-100 

1 Uninstall CallPilot from the server by following the procedure described in 
“To uninstall CallPilot server software” below. When prompted to restart the 
server, select No. 

2 After CallPilot is uninstalled, remove the Dialogic software by clicking Start 
> Programs > Dialogic > Uninstall.

3 Click Yes to confirm uninstall.

4 Restart the server.

To uninstall CallPilot server software

1 To uninstall CallPilot, click Start > Programs > CallPilot > Uninstall.

Result: You are prompted to confirm the uninstallation.

2 Click Yes to uninstall CallPilot.

Result: The uninstall process runs automatically. 

3 After the CallPilot uninstall is complete, you are prompted to restart the 
server.

4 Click Yes to restart the server.

Result: You are asked to confirm the restart.

5 Click OK to restart. 
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Reinstallin g CallPilot server software

In this cha pter
 Reinstalling the software (hard drive is functioning) 370

Reinstalling languages 376
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Reinstallin g the software (hard drive is 
functionin g)

Introduction

If the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct
problem. If it does not correct the problem, then you need to rebuild the har
drive (see “Recovering from a hard drive failure or corrupted software” on pa
377).

The reinstallation procedure copies CallPilot program files from the CallPilo
Server CD-ROM to a CallPilot system running the same version of CallPilo
software. This process does not affect system or user data. It recovers mos
CallPilot program files, but does not recover the operating system, service p
or, in the case of non-Meridian 1 systems, switch drivers.

Requirements
� CallPilot Server CD-ROM that has the same version of CallPilot that is

running on the CallPilot server

� CallPilot Language CD

� CallPilot PEP CD

To reinstall the CallPilot server software

Note: During the reinstall, the following message might appear. If this mess
appears, click OK and continue with the reinstall. 
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1 Log on to the CallPilot server.

2 Insert the CallPilot Server CD-ROM.

3 Run setup.exe from the root directory of the CallPilot Server CD-ROM.

Result: The following window appears:

4 Click Next.

Result: Setup examines the system and the displays the following window:

5 Click Yes to reinstall the software.

Result: You are asked to confirm the platform setting for the server.
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6 Click Yes to begin the reinstallation of CallPilot software. 

Result: Files are copied to the server as part of the reinstall procedure. 
This can take up to ten minutes. A series of messages appears to indicate 
the items that are being reinstalled (for example, backup/restore, MMFS).

After the reinstall is complete, you are prompted to reinstall PEPs (if any 
were present on CallPilot).

7 Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.

Refer to “Installing PEPs” on page 302 for more information on reinstalling 
PEPs.

8 After all PEPs are reinstalled, restart the server when prompted.

9 After CallPilot has restarted, run the Configuration Wizard (see Part 3, 
Chapter 6, “Configuring the server software—common dialog boxes for all 
switch types”).
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10 Leave all current values in the Configuration Wizard dialog boxes as they 
are until you reach the Language Source Directory dialog box shown here:

11 Insert the CallPilot Language CD.

12 Select Install Language.

13 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files 
on the CD. For example, if the CD-ROM is drive Z:, select Z:.
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14 Click Next.

Result: The following dialog box appears which lists all currently installed 
languages:

15 Select all the languages listed and click Next. 

Result: The Add Prompt Language dialog box appears.

16 Click Next to skip this dialog box.

Result: The Primary and Secondary Languages dialog box appears.

17 Click Next to accept the currently assigned primary and secondary 
languages.

Result: The Speech Recognition Languages dialog box appears.

18 Click Next to skip this dialog box.
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Result: The language installation dialog boxes are completed.

19 Click Next through the remaining Configuration Wizard dialog boxes until 
the following dialog box:

20 Select Apply the current configuration, and click Next.

Result: The configuration changes are applied to the server. This is 
followed by a prompt to restart to CallPilot. 

Note: The configuration changes take approximately 10 minutes, plus an 
additional 10 minutes for each language you are reinstalling. 

21 Click Finish, then click OK to restart CallPilot.

Result: The CallPilot software reinstallation is done. 

22 Test your CallPilot channels as described in Part 4 of this Installation 
binder.
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Reinstalling languages

Introduction

If the language prompts are not functioning, then you can reinstall them to t
and fix the problem.

Requirements
� a CallPilot Language CD

To reinstall languages

1 Log on to the CallPilot server.

2 Run the Configuration Wizard as described in Part 3, Chapter 6, 
“Configuring the server software—common dialog boxes for all switch 
types.”
376 CallPilot



C h a p t e r  1 3

Recovering from a hard drive failure 
or corrupted software

In this chapter
 Overview 378

 Recovering from a hard drive failure in a RAID system 380

 Recovering from a hard drive failure in a non-RAID system 381
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Overview

Introduction

If the CallPilot server hard drive crashes or if software becomes corrupt, the
you must either reinstall the software or rebuild the hard drive. 

Reinstalling languages

If only the language prompts are not functioning, then you can reinstall 
languages to try to fix the problem. See “Reinstalling languages” on page 376.

Recovering from corrupted software (hard drive is functioning)

If the hard drive is functioning but the CallPilot software appears to be 
corrupted, you can reinstall the CallPilot server software. This might correct
problem. See “Reinstalling the software (hard drive is functioning)” on page 
370. If it does not correct the problem, then you need to rebuild the hard driv

Recovering from a hard drive failure in a RAID system

For the 702t server, RAID is an option, so the server might have RAID.

In a RAID system the hard drives are mirrored. When one hard drive fails, it
secondary hard drive takes over and there is no system down time. Howeve
need to replace the faulty hard drive as soon as possible to maintain hard d
redundancy. See “Recovering from a hard drive failure in a RAID system” on 
page 380.

Note: If both the hard drives in a mirrored pair fail, then you need to restore
primary hard drive as described in “Recovering from a hard drive failure in a 
non-RAID system” on page 381.

ATTENTION Contact your distributor if a hard drive recovery is required.
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Recovering a CallPilot system from a hard drive failure in a non-RAID 
system or if the mirrored pair fails

If this is a CallPilot system that is already in operation and backup tapes ar
available, then contact your distributor to perform the recovery procedure. 
Distributors should refer to the latest General Release Bulletin on the Norte
Networks web site at http://www.nortelnetworks.com/nic for the latest 
procedure.

If this is a new CallPilot system and no backup tapes are available (for exam
the system failure occurs during CallPilot installation), then see Part 1, Cha
3, “Installing server software for recovery purposes.” This procedure erases
existing data on the server. 
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Recovering from a hard drive failure in a RAID 
system

Introduction

For the 702t server, RAID is an option, so the server might have RAID.

In a RAID system the hard drives are mirrored. When one hard drive fails, it
secondary hard drive takes over and there is no system down time. Howeve
need to replace the faulty hard drive as soon as possible to maintain hard d
redundancy.

Note: If both the hard drives in a mirrored pair fail, then you need to restore
primary hard drive as described in “Recovering from a hard drive failure in a 
non-RAID system” on page 381.

To recover from a hard drive failure in a RAID system

Follow the instructions in the hardware maintenance chapter to replace the f
hard drive and rebuild the new hard drive. 
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Recovering from a hard drive failure in a non-
RAID system

Introduction

Contact your distributor if a hard drive fails. Your distributor has access to a
utility that is required to restore data from a backup tape. If this is a RAID 
system and both drives in a mirrored pair fail, then you need to restore from
backup tape. If only one drive in a mirrored pair fails, see “Recovering from a 
hard drive failure in a RAID system” on page 380.

Requirements
� all software media that came with the CallPilot system

� a complete set of server backups, including

� a system backup

� one secondary disk backup for each additional disk drive on your se
(for example E:, F:)

ATTENTION The recovery procedure requires access to a utility that is n
available to customers. Distributors should refer to the lates
General Release Bulletin on the Nortel Networks web site a
http://www.nortelnetworks.com/nic for the latest procedure.
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